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Abstrakt 
Diplomová práce se zabývá návrhem čtyř laboratorních úloh s využitím simulačního nástroje 
OMNeT++ a rozšířením Inet Framework. Témata navržených úloh j sou zaměřena na směrovací 
protokoly, zajištění kvality síťových služeb, technologie použité v lokálních počítačových 
sítích a srovnání vlastností aktivních síťových prvků. První úloha obsahuje srovnání vlastností 
a směrovacích technik protokolů RIPv2 a OSPFv2, včetně vlivu rozdělení OSPF sítě na menší 
oblasti. Druhá úloha se zaobírá technikami pro řízení kvality služeb, konkrétně frontou FIFO, 
PQ a WFQ. Cílem je srovnání dosažených hodnot parametrů definujících kvalitu síťových 
služeb pro jednotlivé techniky. Třetí úloha srovnává technologie Ethernet a W L A N , parametry 
přenosu. Čtvrtá úloha nabízí srovnání vlastností síťových prvků pro tvorbu počítačových sítí, 
rozbočovač, přepínač a směrovač. V práci je také popsána potřebná teorie síťových technologií 
a programových prostředků používaných k provedení simulací. 

K l í č o v á slova 

OMNeT++, Inet Framework, QoS, DiffServ, FIFO, PQ, WFQ, RIPv2, OSPFv2, Ethernet, 
802.3, W L A N , 802,11, rozbočovač, přepínač, směrovač, laboratorní úlohy, modelování sítí, 
simulování sítí. 

Abstract 
Diploma thesis deals with creating four laboratory tasks using simulation tool OMNeT++ and 
Inet Framework extension. Subject matter of these designed tasks is focused on routing 
protocols, providing quality of service, computer networking technologies used in local area 
networks and comparison of active networking devices. First task contains the comparison of 
behaviour and routing techniques between protocols RIPv2 and OSPFv2, including the effect 
of dividing OSPF network into smaller areas. Second task is focused on various techniques for 
controlling quality of service, namely FIFO queue, PQ and WFQ. Main goal is the comparison 
of results, that define quality of network services. Third task compares networking 
technologies, Ethernet and W L A N , parameters of transmission. Fourth task offers comparison 
of networking devices, hub, switch and router. This paper also contains required theory of 
network technologies and software tools used for executing simulations. 

Keywords 
OMNeT++, Inet Framework, QoS, DiffServ, FIFO, PQ, WFQ, RIPv2, OSPFv2, Ethernet, 
802.3, W L A N , 802.11, hub, switch, router, laboratory tasks, network modeling, network 
simulating. 
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ÚVOD 

Cílem této práce je prouzkoumání možností síťového simulátoru OMNeT++ a následná 
aplikace těchto poznatků při vytváření praktických úloh, jež by vhodným způsobem posloužili 
studentům k rozšíření, či názornému ověření jejich teoretických znalostí o počítačových sítích 
a v nich používaných technologiích. Praktickým výstupem této práce jsou čtyři kompletní 
laboratorní úlohy, včetně srozumitelně popsaného postupu k vytvoření, nastavení a následné 
analýze výsledků. Tak aby studenti mohli využít co možná nejvíce času simulováním a 
testováním parametrů sítě, namísto zdlouhavého navrhování sítě a vytváření programového 
kódu. Začlenění těchto úloh spadá do předmětové stavby bakalářského studia a dle toho byly 
vybrána témata a jejich náročnost. 

Téma první laboratorní úlohy je zaměřeno na srovnání vlastností směrovacích protokolů 
uvnitř autonomních sítí, konkrétně protokoly RTP (Router Information Protocol) a OSPF (Open 
Shortest Path First). Druhá úloha se zabývá metodami zajištění kvality služeb a vliv jejich 
použití v závislosti s nastavenými parametry k docílení požadované kvality přenosu dat. Třetí 
úloha srovnává vlastnosti a parametry síťových technologií. Těmi jsou kabelové sítě dle 
standardu IEEE 802.3 - Ethernet a bezdrátové sítě dle standardu IEEE 802.11 - W L A N . 
Čtvrtá úloha porovnává funkce a vlastnosti aktivních síťových prvků pro tvorbu sítí, jmenovitě 
se jedná o rozbočovač, přepínač a směrovač. 

Pro návrh projektů je využito grafické prostředí programu OMNeT++ s využitím 
nástavby FNET Framework, která zahrnuje popis důležitých síťových prvků a technologií. 
Jedná se o tzv „open source" kód a používání těchto programů je pro nekomerční účely zcela 
bezplatné. K zobrazení výsledků jsou využity integrované nástroje obsažené v programu 
OMNeT++. 

V kapitole 1 jsou popsány jednotlivé části síťového simulátoru OMNeT++ a nástroje 
použité k vytváření projektů, provádění simulací a zobrazení výsledků. 

V následujících čtyřech kapitoláchje teoreticky popsána problematika témat, z nichžjsou 
sestaveny laboratorní úlohy. Kapitola 2 popisuje problematiku zajištění kvality služeb, kapitola 
3 obsahuje teorii směrovacích protokolů, kapitola 4 popisuje síťové technologie pro tvorbu 
lokálních sítí a v kapitole 5 jsou uvedeny charakteristiky aktivních síťových prvků. 

Kapitola 6 obsahuje praktickou část, stručný popis čtyř vytvořených laboratorních úloh. 
V této kapitole je pouze nastíněno zadání úloh včetně topologie simulované sítě a vypracování, 
které bude po studentech požadováno. Kompletní návody jsou k nalezení v příloze. 
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1 SÍŤOVÝ SIMULÁTOR OMNET++ 

OMNeT++je simulační nástroj zaměřený na síťové technologie, jeho základ je postaven 
na platformě Eclipse, kterou rozšiřuje dalšími funkcemi. Programové prostředí je založeno na 
objektově orientovaném programování v jazyce C++. Jádro programuje distribuováno jako 
otevřený kód a lze tak nalézt nová rozšíření či vylepšení, ovšem tento způsob vývoje nevylučuje 
výskyt chybných implementací. Pro tuto práci je použita v současnosti aktuální verze 
OMNeT++ 4.6 a dále rozšíření s názvem Inet Framework ve verzi 3.1, které obsahuje 
implementaci většiny z nej důležitějších protokolů linkové, síťové a transportní vrstvy, včetně 
podpory bezdrátových a mobilních technologií. Rozšíření Inet je podrobněji popsáno v 
kapitole 1.4. 

Model OMNeT++ se skládá z modulů, které mezi sebou komunikují předáváním zpráv. 
Jednoduché moduly jsou popsány v jazyce C++ a využívají knihovnu tříd. Spojováním modulů 
vznikají moduly složené, jejichž hierarchie není nijak omezena. Zprávy mezi nimi jsou typicky 
přenášeny jejich naprogramovanými vstupními a výstupními branami. Vlastnosti těchto bran 
jsou závislé na programové definici, mohou fungovat jako virtuální spojení pro účel převodu 
informací do požadovaných částí složených modulů, či mohou simulovat spoje z reálných 
podmínek přiřazováním typických parametrů, jako je chybovost, zpoždění nebo přenosová 
rychlost. [1] 

OMIS leT++4 
LT 9 

1—' ~ THE OPEN SIMULATOR 

B 1 Academie Edition - not for commeretal use. 

Obr. 1: Úvodní obrazovka OMNeT++ 4.6 
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1.1 Vývojové prostředí 

Vývojové prostředí programu OMNeT++ je založeno na platformě Eclipse a nabízí 
pokročilé možností editování a formátování kódu přizpůsobené potřebám konfiguračních 
souborů, které slouží k návrhu topologií a popisu funkčních částí pro potřeby simulací a 
následné analýzy výsledků. 

Pracovní plocha nabízí bohaté možnosti zobrazení potřebných částí a doplňků, Project 
Explorer nabízí stromovou struktura pracovního adresáře, ve kterém jsou všechny aktuální 
projekty, editovací část pro zobrazení a psaní kódu a informační část s konzolí, debuggerem 
pro zobrazování chyb a problému. Ukázku pracovního prostředí lze vidět na Obr. 2. 

Simulation - Qos/Networ<,ned - OM MeT+ +• IDE 

File Edit Source View Navigate Search Project Run Window Help 

[EJ Simulation 1 
3 Project Explorer 23 

LJ aloha 
•Q cqn 
•Q dyna 
LJ embedding 
LJ embedding2 
Lc!? Ethernet-copy 

& f ifo 

LJ google-earth 
LJ histograms 
LJ hypercube 

inet 
LJ nedderno 

OSPF-RIP 
••£$ Qos 

is JJR Binaries 
Includes 
out 

results 
Qos.exe - [x86/le] 

U controller_cfg.xml 
U filters,xml 
§ General.anf 
L® Makefile 
S Nerwork.ned 
L±J omnetpp.ini 
S package.ned 
*i PQ.anf 
S TrafficConditioner.ned 
§ TrafficConditioner2.ned 
^ WFQ.anf 

1 § WFQueue.ned 
LJ queueinglib 
LJ queueinglibext 
LJ queuenet 
LJ resultfiles 

Outline 

Property Value 

Networtned S3 

tit package qos 

1̂ DiffservNetwork 

— P P P 

— • ethernetline 

configurator 

outer2\ . 

Xg:/ 
Design Source 

B omnetpp.ini K 

1 [General] 
2 d e s c r i p t i o n = Without QoS 
: network = Dif t seivNetwoiJc 
4 s i m - t i m e - l i m i t = 400a 
z tkenv-plugin-patti = ../../../../ e t c / p l u g i n e 
•i crr.denv-expr ess-mode = f a l s e 

r e c o r d - e v e n t i n g = f a l s e 
B 
9 #frT"T"P setup 

ID # C o n t r o l l e r 
11 ** . c o n t r o l l e r , c o n f i g = smldoc ( " c o n t r o l l e r of g. xml1", ' " / / c o n t r o l l e r - p r o f i l e [ 8 i d = l u n i f o r m 1 ] •) 
12 
13 # d e f a u l t route*- qjueue 
14 ** . r o u t e r * .ppp[0 J .gueuelype = "Dzcp-s.-~-Z~j,e" 
15 **.router*.ppp[Q].queue.frameCapacitv = 50 
16 
17 #VOIP setup 
IE ** .VOIP c l i e n t * . nuraTJdpApps = 1 

- - .VC_E_'il^5~-. u device ; ; . typ e nam e = " SurpleVc IFSender " 
•"•*.VOIP_clieiit.udpApp[0] .destPart = 2DDC 

Writable 

Obr. 2: Pracovní prostředí programu OMNeT++ IDE 

Forma zápisu se liší podle typu konfiguračního modelu, základním prvkem pro tvorbu 
prvků jsou tzv. moduly napsané v jazyce C++, které definují základní funkčnost. Spojováním 
těchto bloků vznikají ekvivalenty reálných technologií a síťových zařízení. Ty jsou popsány ve 
specifickém j azyce NED (Network Description) a pro j eho tvorbu lze využít NED editor, který 
nabízí dva módy. 
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NED editor 

Grafický mód, ve kterém lze propojovat moduly z knihovny prvků předdefinovanými 
kanály. Tento mód názorně prezentuje hierarchii modulů a jejich vzájemných propojení, ze 
kterých se vytváří síťová zařízení a technologie. Na Obr. 3 je zobrazena vnitřní struktura prvku 
StandardHost, který představuje implementaci osobního počítače v jazyce NED. Prvek je 
tvořen jednotlivými moduly, které definují například vstupní a výstupní rozhraní, aplikace, 
směrovací tabulky a další. 

status 7—' tunApplnumŤunlnterfaces 
tcpApp[nunTcpApps] 1 

energyStorage 

energyGenerator tep 

O 
mobility 

routingTable 

interfaceTable 

order[nurnPcapRecorde, 
— t f l 

lo0i1[ni.imE Hln(>fT#3npajî Sadia-5j; eth[sizeof[ethg]] 

gApp[numPingApps] 

ppp[sizeof(pppg)] 

Obr. 3: Vnitřní struktura prvku StandardHost 

Textový mód umožňuje uživateli přímý přístup ke zdrojovému kódu N E D prvků, kde 
jsou zapsány implementace všech modulů, vstupní a výstupní brány, jejich propojení a také 
definice všech parametrů, které lze nastavovat. Syntaxe vychází z jazyka C++. [2] 

Pomocí N E D editoru se dají vytvářet topologie sítí, ale není vhodné v nich definovat 
konkrétní parametry, jelikož N E D soubory jsou statické a jejich zadání je tak pevně dané a 
nelze ho měnit. Pro definici parametrů a síťových aplikací je vhodné použít INI File Editor, 
který slouží k vytváření konfiguračních souborů INI popisujících chování simulované sítě i 
simulace samotné. 

11 



INI File Editor 

Umožňuje konfiguraci simulačního modelu, nastavení parametrů simulace, filtrování 
požadovaných výsledků, vytváření aplikací a datových přenosů na síťových zařízeních, 
adresování a spoustu dalších možností. Parametry mohou být nastavovány jednoznačně nebo 
rozsahem, případně měnící se v čase. Každý konfigurační soubor obsahuje povinnou sekci 
General, parametry v ní zapsané jsou společné pro všechny části simulace. Je možné také 
vytvářet scénáře a k nim přiřadit jejich vlastní parametry. 

Podkladem konfiguračního souboru je topologie sítě vytvořená v souboru NED, 
parametry pak lze nastavovat podle částí, jež jsou obsaženy v topologii. Například aplikace 
TCP (Transmission Control Protocol) j e možné definovat pro j akýkoliv prvek, který má v NED 
kódu definován modul tcpApp. Na obrázku Obr. 4 je zobrazena názorná ukázka kódu 
konfiguračního souboru. 

[General] 
2 d e s c r i p t i o n = Without QoS 
3 network = DiffservNetwork 
4 3 im-time-limit = 400s 
5 tfcenv-plugin-path = ../../../../ etc/plugins 
6 crr.derrv-express-ir.ode = f a l s e 

record-eventlog = f a l s e 
8 
9 #ffrTP setup 

10 # C o n t r o l l e r 
11 **. c o n t r o l l e r , c o n f i g = xmldoc ( " c o n t r o l l e r c f g . ami", " / / c o n t r o l l e r - p r o f i l e [ @id=1 uniform' ] ") 
12 
13 t default router gueue 
14 « . router* .ppp[0] . queueType = "DropTailQueue" 
15 **. router* .ppp[0]. queue . frair.eCapacity = 5C 
16 
17 tVOIP setup 
IB ** . V O I P c l i e n t * . numUdpApps = 1 
19 
20 ** . VOIP_client .udpApp[G] . typenair.e = "SimpleVoIFSender " 
21 **.VOIP_client.udpApp[G].destPort = 200C 
22 **.VOIPclient.udpApp[*].destAddress = "VOIP_client2" 
2 3 **.VOIP_client.udpApp[*].startTime = 0s 
24 **.VOIPclient.udpApp[*].stapTime = 703 
25 
26 ** .VOI P_client2 .udpApp[0] . type naic.e = "SirrpleVoIFEeceiver " 
27 **.VOIP_client2.udpApp[0].localPort = 2000 

Obr. 4: Ukázka konfiguračního souboru 

Vytvořením těchto dvou souborů, N E D a INI, je projekt zkompletován a připraven 
k simulaci. Nejprve je nutné projekt zkompilovat, aby se sestavily a vytvořili všechny potřebné 
části a poté lze zahájit simulaci spuštěním konfiguračního souboru. Program OMNeT++ 
poskytuje vlastní simulační prostředí, které je popsáno v následující kapitole. 
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1.2 Simulační prostředí 

Síťový simulátor OMNeT++ nabízí integrované nástroje pro simulování vytvořených 
projektů. Spuštěním vytvořených scénářů v konfiguračním souboru se spustí nástroj Tkenv, 
který nabízí spoustu možností pro sledování událostí simulace. Příklad zobrazení simulačního 
okna je zachycen na Obr. 5. 

V grafické části okna lze sledovat průběh simulace v animovaném režimu, který 
vyobrazuje všechny přenášené zprávy přímo v síťové topologii, případně lze vhodným filtrem 
zobrazit pouze vyžadovaný typ zpráv. Po vybrání síťového prvku z topologie lze v okně 
s obsahem, v levém dolním rohu, zkoumat všechny části, jež prvek obsahuje. Tedy aktivní 
rozhraní, směrovací tabulky a podobně. V části s textovým výstupem událostí, v pravém 
dolním rohu, jsou vypsány všechny zprávy přenášené v rámci topologie. Projejich popis slouží 
zdroj a cíl zprávy, typ segmentu, čas a pořadí v rámci simulace nebo informace o obsahu. Po 
otevření konkrétního rámce jej lze zkoumat do detailů, jako velikost zprávy, velikost hlaviček, 
typ zapouzdření a další. V levém horním rohuje výpis naplánovaných událostí, které se dají 
zobrazit i na časové ose. 

File Simulate Inspect View Help 

jeneral =0: Diff:ervNetwijrk 
Nett: VoIP tjnet::PPPFrame, id=18514J 

Event#11553 
][ln: DifteervNet 

t=6.82749&62850fc 

k.router2.ppp[G].ppp <PPP, icl=113] 
Msg stats; S scheduled /14274 existing / IE 

vert + 0.0009051054085 

B - @ DifhervNetwork (• iff 5erv Network) fid=l] 
B-S scheduled-events(cMessageHeapJ 

& • VoIP [inetPPPFrame] (id=18514) 

£=>-• VoIP 0"ret::IPv4Datagram)(id=17l>15: 
* VoIP [inet::U[>PPat:ket] [id=18608) 
L • VoIP (inet::SimpleVoIPPacket] tjd=18609) 

- • selfSenderCcMessage] [id =13] 
E3- • VoIP [inet::PPPFrame] [id=lS553) 

£=>-• VoIP [iret::IPv4Datagram) (id=17DE2] 
VoIP [iret::UDPPat:ket] [id =18610) 

VoIP (metuSimpleVoIPPacket] [id =18612) 
- • PppEndTxEvent[t:Message)(id=25] 

EH • tcpseg(l=536}(met::PPPFr3me] [id=186G4] 

E3- * tcpseg[l=53&) (i net: :IPv4Data gram) [id=17127] 

L • tcpseg[l=536) [inet:tcp::TCPSegment) (id=18&ll) 
- • selfSourte [cMessage] [id=12> 
- • selfTalkspurtFinished [̂ Message) (id=73] 

REXMIT(cMe;:3ge)(id=8a) 

L • 

D iff serv Network 

_ * 10.0.0.17/30 10.0.0.18/30 

1 0 Ä 3 Ä O U t e l 1 '"^Ul 
ethjK' 

ioms/30 

er] DiffservNetwfork.rc 

3 01] 

IN am Ľ 
• cPar n u in Tu nlnterf a c es 0 
• cPar mobilit- T- |;e 
• cPar n etwo rkLay e rTy pe "IPviNetworkLayer" 
• cPar routingTableType "IPv4RoutingTable" 
• cPar forwarding true 
• cPar mu Iti castForwardir g fake 
• cPar energy Sto ra g eTy p 6 
• cPar e n ergy G e n er atc rTy p 
• cPar hasOŠpF false 
• cPar harPJP fake 
• cPar harBGP fdie 
• cPar ha-PIM false 
• cPar tcpType 'TCP' 
• cPar udpType "UDP" 
• c&ate pppgSi[0j •: — router2.pppgSo[C 
• cGate pppgSo[0] --> rüüter2.pppgSi[0^ 
• cGate ethgii[0] VQIP_c entethgi 
• cGate ethgii[l] <- n?_d\ ntethgSc 
• c Gat e ethgSo[0] -> VOIP_c entethgi 
• c Gat e ethg$o[l] -> FTP_cli nt.ethg$i 
S IPv4Netuuorkl_ayer r etwo rkLay e r id=74 
• [P--4 Rc.it i n :jT able routi no. Table id=75 
• InterfateTable interfaceTable icl=75 
P°l Loopbacldnterfate IcO id=77 
1"| Ethernetlnterface eth[0j id=73 
!•] Ethernetlnterface 
IřŤSI DDDTnt-.rf,™ 

eth[l| id=79 

Event* me iSrc/Dest LName Inf= 

- : : J . Í I s 72559152309S router-2 Veil L^z 
#11324 73027S02303S routerl — > tcpstg(l=536; T : E : 
#1132? = 73C976S477SS VOIP_cl ient —> routerl VoIP inet 
#1133? Ě 731154128506 router2 --S FTP server tcpaeg(l=536| T"E: 
#11347 č 731665528506 FIP_server -> router2 &CK T ; F : 
#11354 6 73172352E506 routerl i;:-: I C P : 
#113=0 5 735S7162S506 ioaZ£i2 --> VQIP_ClieEt2 veil inST 
#11371 = 736765646196 routerl —> FI£_c l i ent T : E : 
#•11379 e 73*823346196 III client -> routerl tcpaeg(l=536] T"E: 
#11391 1 750976847788 VOIP_Glien-t; —> routerl VoIP rnet 
#•11339 6 766716523093 routerl —> router2 VoIP inet 
#11404 5 770976S477SS VOIP_cl ieEt —> routerl veil ins-T 
#•11412 = 77140402309S router1 --> router2 7=11 inet 
#11416 Ě 772309128506 Eouter-2 --S FTP server tcpaeg(l=536| T"E: 
#11424 č 772790828506 FIP_seEvec -> router2 &CK T ; F : 
#11431 6 772E4S52E506 router2 ~s routerl i;:-: I C P : 
#11435 S 77609152309S routerl --> router2 tcpaeg(l=536; I C P : 
#1143? = 776996622506 rt>uter2 --> VOIP_clierit2 VoIP inet 
#11450 E 777890646196 routerl FTP client T " F : 
#1145= č 77794S346196 FTP client -> routerl tcpaeg(l=536| T ; F : 
#11469 6 7E163412E506 router2 ~s VOIP_client2 VoIP inet 
»114B1 S 790376S477EE VOIP_cl ient —> routerl veil inet 
#11432 = S1C976S477SS TOIE_client —> routerl 7 ; IP inet 
#115.00 E S1252902309S routerl route r2 VoIP inet 
#11502 č S17216523098 rou"nerl —> route r2 VoIP inet 
#11506 5 515121628506 router? --> FTP_server tcpaeg(l=536; T : F : 
#11514 6 E1E60332E506 FIE_serT7er -> router2 fiCK I C P : 
#11521 = S1S66102S506 rt>uter2 --> routerl T : E : 
#11525 E S2190402309S routerl : ~ " 3 = r2 VoIP inet 
#1152? č S22809128506 Eou"Cer-2 --> V O I P clien-t2 VoIP inet 
#11540 5 523703146196 routerl --> FTP_client T : F : 
#1154; 6 523760346196 FIP_client -> routerl tcpaeg(l=536; I C P : 

ľSíJupleVoI 
10.0.0.5.1 
:Si2SJleVc-I 
10.0.0.5.1 
10.0.0 

PPac)ret:40 bytes 
025 > 10.0.0.1.20: 
PPac)ret:4C 
025 > 10. 

0.0.0. 

\m f 3> [ B * 5 

. . 2 D : 
: =i::.!ľ_ss,":: 
10,0,0,1.2 
10.0.0.5.1 
:Sixplevol 
:SiiriMeVoI 
iSiipleVoI 
:5iaeileVoI 
10.0.0.5.1 
10.0.0 

FFůCl-eE:40 
0.0.0 

025 > 10.0 
PPac}ret:40 
PPacret:40 
FFůcl-eE:40 
PPac}Let:40 
025 > 10.0 

0.0.0 

.0.1.20: 
1025: 

.5.1025: 

,5 . i : 25: 
.0.1.20: 

, : . L . I : : 

A šĚ-B35 : 
A act ?73ŕ 
A acŕ 373í 

1.0.1.20 > 10.0.0.5.1025: 
1.0.5.1025 > 10.0.0.1.20: 

5 i:;.!.: _=;,"=: 
0,0,0,1.2 
0,0,0,5.1 
SiirpleVoI 
SiirpleVoI 
SiaeileVoI 
SiipleVoI 
SiipleVo-I 
0.0.0.5.1 

PEactet:40 
0,0,0, 
• 1 0 . 0 . 

PPacŕet:40 
PPacŕet:40 
PPac}Let:40 
PPac):et:40 
PPaclret:40 

10.0. 
. . 2 0 : 

10.0.0.1.2 
:5inipleV[>I 
iSinipleVDl 
10.0.0 

0,0, 0 
PPac):et:40 
PPacl:et:40 

0.0. 0 

,5. i : i5: 
.0.1.20: 

.0.1.20: 

.5.1025: 

.5.1025: 
tv7.es 

.5.1:25: 

.0.1.20: 

_-. :"3;? 
A act 87 
A act B' 
A 57305 

A 5-305:3.! 
A act BB4' 
A act S24' 

10 ,0 
10.0 

57905 [536) 

0.?.1025 ; 
act 2282 i 

]4 IPv4: 
14 IPv4: 
0.9.1025 í 
3i IPv4: 
act 2282 i 
0.9.1025 ; 
0.9.1025 ; 
0.9.1025 í 
0.9.1025 ; 
act 2282 i 

]4 IPv4: 
104 IPv4: 

act 22B2 i 
.0.9.1025 í 

iC4 IPv4: 
act 2282 i 

.0.9.1025 5 

.0.9.1025 5 

.0.9.1025 í 

.0.9.1025 ; 

.0.9.1025 ; 
act 2282 i 

104 IPv4: 
iC4 IPv4: 
.0.9.1025 
.0.9.1025 

1:95945 (536) act 22B2 v 1 

Obr. 5: Simulační prostředí OMNeT++/Tkenv 
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Simulaci je možné provádět skokově, libovolnou rychlostí nebo krokovat po jednotlivých 
událostech. Simulace je dokončena dosažením časového limitu nastaveného v konfiguračním 
souboru nebo při úspěšném provedení všech naplánovaných událostí. Po dokončení simulace 
se vytvoří soubory s výsledky, ty jsou popsány v následující kapitole. 

1.3 Analýza výsledků 

OMNeT++ obsahuje integrovanou podporu pro analýzu výsledků provedených simulací. 
Výsledky se ukládají jako výstupní vektor hodnot v čase simulace nebo jako skalární hodnoty, 
volitelně i jako histogram. Pokud není manuálně zakázáno, provádí se nahrávání hodnot na 
všech modulech a kanálech. Otevřením souboru s příponou .anf se dostaneme do prohlížeče 
všech naměřených hodnot, k vyhledání požadované statistiky vybereme patřičnou záložku 
(Vektors/Scalars), kde je pro zjednodušení hledání možnost využití dvou filtrovacích polí. 
Z kontextové nabídky nebo zapsáním filtrovací podmínky lze vybrat statistiky pro požadovaný 
modul (např. koncová stanice, rozhraní ethernet, typ protokolu) nebo konkrétní statistiku (např. 
zpoždění, délka fronty, odeslané pakety). Na řádku příslušného modulu jsou vypsány naměřené 
parametry, počítadlo, střední hodnota, odchylka, minimální, maximální hodnota a další). Okno 
s výpisem naměřených statistik je ilustrováno na Obr. 7. Požadovanou statistiku je také možné 
vykreslit do grafu, na ose X je vždy čas a na ose Y je parametr vybrané statistiky. Ukázka 
grafického průběhu zpoždění VOIP (Voice over Internet Protocol) hovoru je zachycena na Obr. 
6. 

Chart: endToEndDelay :vec tor Di f fservNetwork .VOIP_cl ient2 .udpApp[0] 

Obr. 6: Ukázka grafického zobrazení průběhu zpoždění 
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B r o w s e Data 

Here you can see all data that come from the files specified in the Inputs page. 

All (594 / 594) Vectors (117 / 117) Scalars (473 / 473) | Histograms (4 / 4)| 

runID filter t module filter - L -JE ? 
d e ca p P k:ve cto rŕp a cketByte s) * i v i u u u i e name L O U N I 
d ro p P k: ve cto r [p a cketByte s] 
e n ca p P k:ve cto r(p a cketB vte s] DiffservNetwo reroute rl.ppp[0]. queue queueLengthivertor 6675 
d ro p P k: ve cto r [p a cketByte s] 
e n ca p P k:ve cto r(p a cketB vte s] 53 

DiffservNetwori;.routerl.ppp[Q].ppp txStateivector 9001 e n dTo En d D e 1 ay:ve cto r 103 

DiffservNetworii,router2,ppp[Q], queue queueLengthivertor 1 m a rkP k:ve cto r(p a cketByte s) 

DiffservNetwork.router2.ppp[Q].ppp txState:vector 4067 measured RTT 
MOSivector 
numActiveSessionsivertor i 

39 

D iff s e rvN e two rk. FTP_cl i e nt.tcp Ap p [0] nu m ActiveS essions:vector 1 

measured RTT 
MOSivector 
numActiveSessionsivertor i 

E 

D iff s e rvN etwo rk. FTP_cl i e rit.tcp tcpRcvQueueBytes 2296 numRTOs 

DiffservNetwork.FTP_client.tcp advertised window 2297 p a cket Lo ssRate :ve cto r 52 

D iff s e rvN etwo rk, FTP_cl i e nt.tcp receive window 2296 passedUpPk:vector(count) 

D iff s e rvN e two rk. FTP_cl i e nt.tcp sent ack 2296 pass edUp Pkivectorfp a cket Byte s) 
pkCIassivector 

925 

D iff s e rvN e two rk. FTP_cl i e nt. n etwo rkLaye r.... sentReqivector 1 playoutDelayivector — 

D iff s e rvN e two rk. FTP_cl i e nt et h [Q ]. e n ca p encapPk:vector(packetBytes) 2298 p 1 ayo utLo ssRate :ve cto r 347 

DiffservNetwork.FTP_client.eth[Q].rnac rxP kFr o m H Live cto r (p a cket Byte s) 2298 queueingTime:vector 35 

D iff s e rvN etwo rk. FTP_cl i e nt. et h [Q ]. m a c txP k:ve cto r(p a cketByte s) 2293 queueLengthivertor 
rcvd ack 
rcvd dupAcks 

35 

DiffservNetwork,routerl,etri[l].rnac rxP kO k:ve ct o r(p a cketByte s) 2298 

queueLengthivertor 
rcvd ack 
rcvd dupAcks 

35 

DiffservNetwork.routerl.eth[l].rnac passedUpPk:vector(packetBytes) 2298 rcvd naseg - 35 

DiffservNetwork.routerl.eth[l].encap decapPk:vector(packetBytes) 2298 574.6614447345518 24.522080567357047 

DiffservNetwork.routerl.networkLayer.arp sentReplyivector 2 1.0 0.0 

Diffser\'Network.routerl.eth[l].encap encapPkivector(packetBytes) 2035 39.99017199017199 0.38647452237138924 

DiffservNetwork,routerl,etri[l].rnac rxP kFr o m H Live cto r (p a cket Byte s) 2035 64.0 0,0 

Obr. 7: Nabídka pro analýzu výsledků 

Výsledky ve skalární podobě nabízí jedinou výslednou hodnotu, která je sumarizací 
daného parametru za celou dobu simulace (např. zahozené pakety, přijaté pakety a další). 

Volitelnou možností výstupu je tzv. EventLog, který lze povolit zadáním příkazu 
„record-eventlog = true" do konfiguračního souboru. Výstupem je výpis předávání zpráv mezi 
moduly v síti na časové ose, ukázka je vykreslena na Obr. 8. 

Os 900rns 15 Is ls 5U5 93Qns ls7us ls 12us ls!3Lis64Qns 1 

RIP2.Hl.ro Litin QTable 

Position: 740rns 
Range: 260tns 14us 130ns 

raP2.Hl.interfateTable 

PTD? U I nHpAppfPl 
^IklTillIdl 

PIP2,Hl,ijdp 
^TlUMblaíicAppĽata-l ^ ^ # S Í 

RlP2.Hl.retworkLayer.ip ^^•^UL^IdasicA.ppLlata-l ^-^"#81 
1TMD-Brrr>r-* -type 

RlP2.Hl.retworkLayer.ar A * y*'#SD 

RIP2.Hl.eth[0].mac \ U U P tí a s i cAp p D a y ^ ^ 1 ^ • , /^MD-arrnr-ii-J-'rnaq-f-r Hen 

RlP2.Hl.eth[0].enrap í L ^ ^ i ipp V&8 "#69 
íVíirAppPritfl "1 #76 Č •^^LMM-^rňr^í-^Ki -L-ádŕ Í J 

PIP2.Rl.routingTable #67 / 
FaP2.Rl.ínterfafceTable \ UDPBasicArjQData-1 

FQP2.Rl.np / 
RIP2.Rl.udp '• / 
RJP2.Rl.netijVorkLayer.ip / 
RIP2.Rl.networkLayer.ar } f #72 y - * \?3 

/ ICMP-error-í2-typ eB-codeQ 

RIP2. R l . n etwo rjkLa ye r. icrfip —— • • S • • •• ? ? • 1  

RIP2.Rl.eth[0].rnac / UDPBasicAppData-i, 

R]P2,Pl.eth[0].encap ^gUUľUaíicAppUata-l \ »75 ; *77 

#71 #74 

ms SOOms 15 Is Dus 93Qns 1S7LJS ls 12us lsl3Lis64Qns 1 

Obr. 8: Ukázka souboru EventLog 
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1.4 Rozšíření Inet Framework 

Rozšíření Inet je zdarma ke stažení a instalaci lze provést automaticky ve vývojovém 
prostředí program OMNeT++. Nebo manuálně, stažením aktuální verze zdrojových souborů 
z webových stránek http://inet.omnetpp.org, následným rozbalením do složky nastavené jako 
pracovní adresář. 

Inet Framework rozšiřuje prostředí OMNeT++ o implementace protokolů (IPv4 - Internet 
Protocol version 4, IPv6 - Internet Protocol version 6, TCP - Transmission Control Protocol, 
SCTP - Stream Control Transmission Protocol, UDP - User Datagram Protocol) a řady 
aplikačních modelů. Podporuje automatickou konfiguraci adresování pro statické směrování a 
směrovací protokoly (RIP OSPF, BGP - Border Gateway Protocol). Dále nabízí podporu 
standardů spojové vrstvy (PPP - Point-to-Point Protocol, Ethernet, standard bezdrátových sítí 
802.11), multiprotokolové přepojování podle návěští MPLS (Multiprotocol Label Switching), 
mechanizmy pro řízené přepojování paketů a simulování bezdrátových a mobilních 
komunikačních sítí. [3] 

Vychází z principů zavedených programem OMNeT++, jednotlivé moduly komunikují 
předáváním zpráv. Pro sestavení modelů reprezentujících protokoly a technologie využívá 
jednoduché moduly z databáze OMNeT++. 

Moduly jsou organizovány do hierarchické struktury, která zhruba odpovídá vrstvám 
referenčního modelu ISO/OSI {inet.applications, inet.transportlayer, inet.networklayer, 
inet.linklayer, inet.physicallayer). Další části j sou inet.power, inet.environment, and inet.node. 
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2 ZAJIŠTĚNÍ KVALITY SLUŽEB 

V počátcích komunikačních sítí bylo poskytováno malé množství síťových služeb, a tak 
nedocházelo k výraznému vytížení komunikačních linek. Pro všechny typy služeb byly 
zavedeny jednotné požadavky a úroveň kvality poskytované služby nebyla nijak řešena. 
Z dnešního pohledu se takovýto způsob přenosu nazývá „Best-Effort". 

V současné době je zavedeno velké množství síťových služeb s odlišnými požadavky na 
parametry přenosu. Hrozí riziko vysokého vytížení komunikačních linek a bez řízení úrovně 
kvality by bylo velmi omezeno využití určitých služeb, zejména těch pracujících v reálném 
čase, jejichž hlavním požadavkem je nízké časové zpoždění a jeho kolísání (jitter). Naopak pro 
většinu datových služeb je hlavním požadavkem co nej nižší ztrátovost či chybovost paketů a 
propustnost. Proto bylo nutné zavedení mechanizmů rozlišování typů služeb podle jejich 
typických požadavků a zajištění odlišných úrovní kvality služeb. 

Pro zajištění kvality služeb je základním požadavkem rozlišení toku dat do tříd, podle 
typu dat zdrojových aplikací. Poté je pro každou třídu definováno odlišné zacházení, 
mechanizmus pro zajištění kvality služeb je označován pojmem QoS - Quality of Service. Ten 
také zajišťuje dohled nad síťovým provozem, aktivní správu front jednotlivých tříd, plánuje 
odesílání paketů a upravuje provoz pro lepší využití dostupné kapacity komunikační linky. [4] 

Třídění datových jednotek tvoří dva základní úkony: [4] 

- klasifikace paketů - podle informací obsažených v hlavičce 
- značkování paketů - přidělením identifikátoru označí příslušnost dat do vybrané třídy 

Značkování paketů je obvykle provedeno nastavením hodnoty příslušného pole 
v hlavičce IP datagramu. Pro značení paketů jsou využita osmibitová pole v hlavičce, ToS 
(Type of Service) a DSCP (DiffServ Code Point). [5] 

Do pole ToS musí nastavit požadovaný charakter přenosu vysílací stanice. Skládá se ze 
tří bitů určujících prioritu při zpracování paketu, dokáže tak rozlišit sedm úrovní priority, dvě 
nejvyšší jsou vyhrazeny pro použití při řízení sítě (např. směrovací protokoly), následující tři 
bity slouží k nastavení požadavků pro přenos (zpoždění, propustnost a spolehlivost přenosu). 
Zbylé dva bity jsou nevyužity. [6] Tento způsob značkování má velmi omezené možnosti a 
v současné době už se nepoužívá, byl nahrazen architekturou DiffServ (Differentiated services). 

DiffServ využívá stejné pole v hlavičce IP datagramu, ale mění způsob zápisu. Využívá 
šest bitů k označení třídy, zbylé dva bity jsou označeny jako „dočasně nevyužité" [4]. 
Přiřazením k jednotlivým třídám se rozlišuje pouze relativní priorita, jelikož způsob zacházení 
s třídami je určena konfigurací směrovače. 
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2.1 Řízené odesílání paketů 
Podle označení paketů v hlavičce jsou datové toky přiřazovány do příslušných front, 

s odlišným způsobem odesílání. Pro definované třídy musí mechanizmus řízení zajistit 
požadované síťové prostředky. Plánované odesílání paketů je prováděno zvlášť každým 
výstupním portem směrovače, názorná ukázka je zobrazen na Obr. 9. Nejprve jsou pakety 
zařazeny na vstup příslušného portu, přeneseny na odpovídající výstupní port dle údajů ve 
směrovací tabulce. Každý výstupní port provádí klasifikaci paketů a řadí je do odpovídající 
fronty, ze které jsou posílány na výstup v pořadí závislém na použité metodě řízeného odesílání, 
případně nastavení jejich parametrů. 
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Obr. 9: Řízení odesílání paketů [7] 

Existují různé metody pro řízené odesílání paketů [4], mezi nejběžnější patří: 

- FIFO (First-In-First-Out) 
- PQ (Priority Queueing) - prioritní systém front 
- FQ (Fair Queueing) - systém se spravedlivou obsluhou 
- WRR (Weighted Round Robin) - systém front s váženou cyklickou obsluhou 
- WFQ (Weighted Fair Queuing) - systém front s váženou spravedlivou obsluhou 
- CB WFQ (Class-Based Weighted Fair Queuing) - systém front založený na třídách 
s váženou spravedlivou obsluhou 
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2.1.1 FIFO 
Je základním typem fronty a používá se vždy, když není definován žádný specifický 

algoritmus pro řízení odesílání. Fronta FIFO představuje zásobník pro příchozí pakety, které 
jsou na výstup posílány ve stejném pořadí, v jakém byly přijaty. Použití je vhodné především 
pro sítě s garantovaným způsobem přenosu „Best-Effort", jelikož nedokáže rozlišovat mezi 
třídami služeb a zajistit tak požadované parametry, výhodou je velmi jednoduchá 
implementace. Princip fungování fronty lze vidět na Obr. 10. Velikost fronty je teoreticky 
neomezena, v praktickém řešení je ve většině případů kapacita fronty omezena maximálním 
počtem paketů a po dosáhnutí této hranice jsou nově příchozí datové jednotky zahazovány. 

m D 
Výstupní port 

• 

|~|~|~| 

Klasifikace 
paketů 

Řízení odesílání 

Fronta FIFO P a k e t ů 

Obr. 10: Schéma fronty FIFO [7] 

2.1.2 PQ 
Jednoduchý prioritní systém front obsluhy, umožňuje diferencování mezi jednotlivými 

třídami datového provozu. Jak lze vidět na Obr. 11, systém se skládá z několika front odlišených 
prioritou, realizovány jsou frontou typu FIFO a pro přístup k výstupnímu portu mají přednostně 
pakety v zásobníku s nejvyšší prioritou. 

m a m 

• 

Výstupní port Fronty 
Priorita 1 

Klasifikace 
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Řizení odesílání 
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Priorita M 

Obr. 11: Schéma modelu techniky PQ [7] 
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Pakety z fronty s nižší prioritou jsou odeslány až v případě volných front vyšších priorit. 
Hrozí tedy riziko monopolizace kapacity kanálu jedinou frontou v případě neustálého 
doplňování paketů a všechny kanály s nižší prioritou nikdy nezískají přístup k výstupnímu 
kanálu. Při velkém zpoždění těchto paketů mohou být považovány za ztracené a budou znovu 
poslány, čímž se ještě více zatíží komunikační síť. Efektivně se dají prioritní fronty využít 
v případě, kdy provoz s vysokou prioritou představuje malou část celkového provozu v síti. 

Pro lepší využití komunikačního kanálu je možné použít prioritní frontu s řízenou 
rychlostí, kdy se šířka pásma pro pakety s nejvyšší prioritou omezí maximální hranicí, kterou 
tento tok nemůže překročit a i pro fronty nižších priorit zůstane vyhrazena stanovená část šířky 
pásma. [7] 

2.1.3 WFQ 
Systém front sváženou spravedlivou obsluhou. Příchozí provoz je dělen do určeného 

počtu front a každá má přiřazenou váhovou hodnotu, která určuje procento celkové šířky pásma 
vyhrazené pro frontu. Součet všech váhových koeficientů front odpovídá kompletní šířce 
pásma. Schéma modelu WFQ je zobrazeno na Obr. 12. Systém obsluhy probíhá cyklicky, a 
pokud nejsou ve frontě s nejvyšší prioritou připraveny žádné pakety, rozdělí si zbývající fronty 
kompletní šířku pásma v poměru jejich vah. 

Mechanismus WFQ navíc vypočítává teoretickou dobu odesílání, dle které se snaží 
pakety odesílat. Pro tento výpočet zohledňuje délku paketu, tak aby bylo přidělování šířky 
pásma opravdu spravedlivé podle přidělených vah. Tím je způsobeno složitější řízení odesílání 
paketů. 
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Obr. 12: Schéma modelu techniky WFQ [7] 
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3 SMĚROVACÍ PROTOKOLY 

Směrovací protokoly slouží pro dynamické vytváření směrovacích tabulek popisujících 
topologii sítě bez nutnosti ručně zapisovat adresy, vyhledávání nejvhodnějších cest podle 
různých metrik a pravidelné aktualizace všech směrovačů v síti, tak aby byla zaručena 
konvergence v síti při nastalých změnách nebo výpadcích v co možná nej kratším čase. 

V důsledku stále se rozšiřující globální sítě není možné zajistit konvergenci nasazením 
jednoho směrovacího protokolu, který by spravoval kompletní síť. Naopak vzniká velké 
množství sítí s různou směrovací politikou a spravované jednou organizací. Takovým sítím se 
říká autonomní systémy. Z pohledu směrování je základním rozdělením protokolů na EGP 
(Exterior Gateway Protocol), v současnosti je jediným zástupcem tohoto typu BGP, který slouží 
na globální úrovni k propojování autonomních systémů, uvnitř kterých jsou nasazeny protokoly 
IGP (Interior Gateway Protocol). Mezi zástupce patří RTP, RTPv2, RIPng (RIP next generation), 
OSPF, IS-IS (Intermediate System to Intermediate System), IGRP (Interior Gateway Routing 
Protocol) a EIGRP (Enhanced Interior Gateway Routing Protocol). [8] 

Směrovací tabulku si vytváří každý směrovač v síti a může se lišit dle typu použitého 
protokolu, nej důležitějšími položkami jsou: [9] 

- původce informace - směrovací protokol, případně manuální 
- síťová adresa a maska - definují okruh platných cílových adres pro daný záznam 
- identifikace cílové sítě - vypočítaná z masky podsítě cílové adresy 
- ohodnocení cesty - závislý na použité metrice 
- další skok - síťová adresa sousedního směrovače, který je na cestě k cílové síti 
- typ záznamu - statický nebo dynamicky (navíc platnost záznamu) 

Protokoly zajišťující směrování uvnitř autonomních systémů se dále dělí dle využívané 
technologie směrování na dvě hlavní skupiny, Distánce-Vector (zástupci j sou RIP, RIP2, IGRP 
a EIGRP) a Link-State (OSPF, IS-IS). 

3.1 RIP 

RIP je jedním z nejstarších směrovacích protokolů, a hlavní výhodou je jednoduchost 
jeho implementace. Má však řadu omezení, kvůli kterým j e v současnosti j eho využití omezené. 
K výběru nejlepší cesty využívá metodu Distance-Vector, která podporuje jediný způsob 
metriky a tím je počet přeskoků, který odpovídá počtu průchodů aktivním směrovacím prvkem 
(směrovač). Nedokáže nijak zohlednit parametry spoje, např. propustnost, zpoždění ani 
neumožňuje manuální ohodnocení jednotlivých cest. Protokol RIP využívá záplavové šíření 
zpráv obsahujících kompletní směrovací tabulku, a tak navíc nevylučuje možnost vytváření 
smyček, takové situace mohou nastat například při změně topologie sítě. Pro zamezení tohoto 
stavuje omezen maximální počet přeskoků na 15, tedy pokud počítadlo přeskoků dosáhne čísla 
16, jsou pakety zahazovány a cílová síť je považována za nedostupnou. 
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Není tak možné použít na rozsáhlejší sítě s větším počtem směrovačů, jelikož by mohlo dojít i 
k zahazování správně posílaných dat. 

Protokol RIP existuje ve dvou verzích: 

RIPvl - 1988, nepodporuje masky sítě, pouze třídní adresování. 

RIPv2 - 1998, vylepšená verze, která odstranila nedostatky předchozí verze. 

Sestavování směrovacích tabulek probíhá postupným rozesíláním jim známých informací 
o aktivních rozhraních. Po sestavení kompletní směrovací tabulky j i směrovače rozesílají na 
všechna rozhraní v pravidelných intervalech (běžně 30 sekund, lze nastavit jiný čas) a 
porovnávají, zda se přijaté liší od těch vytvořených v paměti. Z toho vyplývá další nevýhoda 
protokolu RIP, zbytečné vytížení sítě přeposíláním kompletní tabulky i v případě neměnného 
stavu sítě. 

Další nevýhodou je rychlost konvergence, tedy čas potřebný pro aktualizace všech prvků 
v síti o nastalých změnách. V každém rozhraní směrovače j sou nastaveny tři časovače. Jeden 
měří pravidelné rozesílání směrovacích tabulek, druhý měří neaktivitu směrovače, pokud 
směrovač přestane dostávat aktualizace od některého směrovače, běží tento časovač. Pokud 
dosáhne hodnoty 180 sekund (tedy šesti pravidelných aktualizací) je toto spojení označeno jako 
nedostupné. Poté se spouští třetí časovač, který obstará vymazání všech záznamů obsahujících 
cestu nově nedostupnou sítí a ty nejsou dále součástí směrovacích tabulek. K tomu dojde, až 
napočítá časovač hodnotu 240 sekund. [10] 

3.2 OSPF 

Protokol je typu Link-State, využívá k vypočtení nej vhodnější cesty pokročilý systém 
metrik, do kterých lze započítat parametry dané linky (šířka pásma, zpoždění, spolehlivost, 
cena) a umožňuje více možností nastavení metriky pro tento výpočet než protokol RIP. Rozsah 
čísla pro ohodnocení cesty může nabývat hodnot od 0 až do 65535. [11] K optimalizaci zvolené 
trasy slouží algoritmus SPF (Shortest-Path-First) a Dijsktrův algoritmus, který vybírá nejlepší 
cestu výpočtem minimalizace celkového součtu metrik. Nevýhodou j e složitější implementace 
protokolu, první verze protokolu vznikla v roce 1991 a v roce 1999 přibyla verze OSPFv3 
s podporou pro sítě s adresací IPv6. [12] 

Protokol OSPF je vhodný i pro směrování v rámci rozsáhlejších sítí, ale s rostoucí 
velikostí sítě se zvětšují nároky na výpočty cest a také časy konvergence i vytížení sítě 
rozesíláním aktualizací. Jelikož pro výpočet nejkratší cesty musí každý směrovač znát 
kompletní topologii sítě. Vhodným řešením je rozdělení sítě do menších oblastí a routery uvnitř 
oblastí poté pracují pouze s informacemi o zařízeních ve stejné oblasti. O směrování do 
sousedních oblastí se starají hraniční routery, které propojují dvě, 
anebo více oblastí a musí tak mít znalost topologie všech připojených oblastí. 
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Tyto informace však nepřeposílají mezi jednotlivými oblastmi, atak dochází ke snížení provozu 
v síti i výpočetních nároků směrovačů. Oproti protokolu RIP také nabízí rychlejší konvergenci 

K šíření informací mezi směrovací je využíváno záplavové šíření zpráv multicastovým 
přenosem, protokol OSPF používá pro sestavení směrovacích tabulek několik definovaných 
typů zpráv: [4] 

- Hello - jsou vysílány všemi aktivními porty do sousedních směrovačů, slouží 
k objevování sousedů a k ověřování platnosti spojení mezi sousedními směrovací. 
Odesílány jsou v pravidelných intervalech, typicky po 10 sekundách. Pokud se router 
nehlásí (nedorazí od něj žádná hello zpráva), je po uplynutí časového intervalu (tzv. dead-
interval) označen jako nedostupný, typická hodnota je 40 sekund. 

- DBD (The Database Description) - zkrácený výpis databáze vysílajícího směrovače, 
slouží pro rychlejší sestavení směrovací tabulky nově připojeného routeru do sítě, který 
si z databáze vybere položky, které mu chybí a následně zažádá o jejich kompletní 
informace. 

- LSR (Link-State Request) - žádost o informace z databáze DBD. 

- L S U (Link-State Update) - jsou odpovědí na přijaté žádosti LSR. Obsahují zprávy L S A 
(Link-State Advertisement), které popisují stav rozhraní nebo seznam směrovačů 
připojených k dané síti. Tyto zprávy si ukládají do vlastní databáze a přeposílají je dále 
na přímo připojené směrovače. Po sestavení kompletní topologie sítě provádí každý 
směrovač samostatně výpočet nej lepších cest pomocí Dijkstrova alogritmu. Poté již 
routery neposílají tento typ zpráv až do doby, než dojde ke změně topologie. V takovém 
případě rozesílá směrovač, na kterém došlo ke změně novou zprávu L S A a probíhá znovu 
výpočet nej kratších cest. 

- LSAck (Link-State Acknowledgement) - potvrzení o přijetí LSU. 
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4 PŘENOSOVÉ TECHNOLOGIE LOKÁLNÍCH SÍTÍ 

Pod pojmem lokální síť se v oblasti komunikačních technologiích rozumí propojení 
skupiny uživatelů, umožňující jejich vzájemnou komunikaci a přenos dat, v prostorově 
omezeném rozsahu, maximálně v řádu kilometrů. Typicky se jedná o síť provozovanou v rámci 
jediné budovy a k jejich souhrnnému pojmenování se užívá zkratka L A N (Local Area 
Network). Přenosové rychlosti mohou dosahovat až 100 Gbit/s, jednotlivé technologie jsou 
definovány komplexní skupinou standardů IEEE 802, z nichž v současnosti nej používanějšími 
jsou standard IEEE 802.3, popisující kabelové spoje a standard IEEE 802.11 popisující 
bezdrátové spojení s přenosem dat radiovým signálem. 

4.1 IEEE 802.3 - Ethernet 

Síť Ethernet popsaná standardem IEEE 802.3 je v současnosti nej využívanějším typem 
pro realizaci lokálních počítačových sítí. Ethernet byl navržen v roce 1973 společností Xerox a 
původní přenosová rychlost byla 2,94 Mbit/s po koaxiálním kabelu [11]. Během let prošel 
rozsáhlým vývojem a bylo navrženo mnoho různých verzí s postupným vylepšováním 
technických parametrů, z nichž nej podstatnějším je přenosová rychlost. Přehled jednotlivých 
fází vývoje zobrazuje Tabulka 1. Standardizovaná síť Ethernet zajišťuje kompatibilitu s širokou 
škálou výrobců a použitelnost s mnoha typy síťových zařízení. Kromě běžných síťových prvků 
(rozbočovač, přepínač, směrovač, most, klientské stanice) lze do sítě Ethernet připojit například 
IP telefony, telefonní servery nebo tiskárny. 

Z technologického hlediska se Ethernet dělí na dva typy podle způsobu přenosu 
informace, jimiž je využití elektrických jevů v metalických vodičích nebo optických jevů 
v optických vláknech. 

V metalických vodičích jsou přenášené bity zakódovány pomocí napěťových úrovní, 
které jsou na přijímací straně převedeny zpět na bity s hodnotou jedna nebo nula. Zvolený typ 
kódování a z něj určené hodnoty napěťových úrovní se liší dle použitého standardu. Fyzická 
vrstva dále zajišťuje synchronizaci sériového toku bitů, detekci obsazení kanálu, detekci kolize 
a detekci nosné. V současnosti se k přenosu nejčastěji používá nestíněná kroucená dvoulinka 
s označením UTP (Unshielded Twisted Pair), která umožňuje komunikaci v plně duplexním 
módu, tedy současné komunikaci obou stran, jelikož je pro vysílací i přijímací stranu vyhrazen 
samostatný pár vodičů a nehrozí tak vznik kolizí. Původní standard byl realizován koaxiálním 
kabelem, který neumožňuje oddělení vysílací a přijímací strany, komunikace mohla probíhat 
pouze v poloduplexní komunikaci a bylo nutné použití přístupové metody C S M A / C D (Carrier 
Sense Multiple Access with Collision Detection) pro řízení přístupu k médiu. Nutnost použití 
se s postupným vývojem omezila a v současnosti již není užívána, prakticky všechny sítě jsou 
realizovány j ako plně duplexní a přenosová rychlost odpovídá maximální teoretické rychlosti. 
K zapojení kabelů se používá osmi-pinový konektor s označením RJ-45, podle druhu 
propojovaných zařízení se užívá přímý nebo překřížený kabel. 
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V optických vodičích se k přenosu informace využívá světla produkovaného zdrojem 
záření na koncích vedení, využívá se záření v oblasti vlnových délek 850 nm, 1300 nm 
a 1550 nm. Oproti metalickým vodičům mají optická vlákna nižší hmotnost a vysokou odolnost 
vůči vnějšímu rušení, díky nízkému útlumu signálu je možné realizovat velmi dlouhá vedení, 
řádově až desítky km bez regenerátoru signálu. Vlákna mohou být jednovidová, ta mají 
obrovskou přenosovou kapacitu a dosah signálu, ale náklady na výrobu jsou výrazně vyšší než 
pro vlákna mnohovidová, ta j sou nejčastěji používána v běžných aplikacích pro komunikaci na 
kratší vzdálenosti. 

Standard IEEE 802.3 kromě fyzické vrstvy popisuj e také vrstvu spojovou, která je druhou 
vrstvou referenčního modelu ISO/OSI. Datová jednotka na této vrstvě se nazývá rámec a má 
pevně definovanou strukturu. Minimální velikost rámce je 64B a maximální velikost 1518B a 
musí obsahovat povinná pole, jimiž jsou cílová a zdrojová fyzická adresa, každá má 6B, dále 
pole, o velikosti 2B, definující velikost datového pole nebo určující typ požadovaného 
protokolu vyšších vrstev. Část obsahující přenášená data může mít velikost v rozsahu od 46B-
1500B, při menší velikost dat musí být použita výplň k doplnění do 46B, aby byla splněna 
podmínka minimální velikosti rámce. Konečným polem je kontrolní součet o velikosti 4B, který 
detekuje chyby vzniklé přenosem. Na fyzické vrstvě se před každý rámec přidá pole o velikost 
8B, z nichž prvních 7 oktetů obsahuje střídající se jedničky a nuly, které slouží k synchronizaci 
a další oktet upozorňuje na začátek nadcházejícího rámce. [13] 

Tabulka 1: Přehled standardů a typů sítí Ethernet [11] 

Rychlost sítě 
Standard 

IEEE 
Označení typů Rok vývoje 

10 Mbit/s 802.3 
10Base-2, 10Base-5, 10Base-T, 10Base-FL, 

10Base-FB, 10Broad-36 
1979-1993 

100 Mbit/s 
802.3u 100Base-TX, 100Base-T4, 100Base-FX 1995 

100 Mbit/s 
802.3xy 100Base-T2 1997 

1 Gbit/s 
802.3z 1000Base-LX, 1000Base-SX, 1000Base-CX 1998 

1 Gbit/s 
802.3ab 1000Base-T 2000 

10 Gbit/s 

802.3ae 
10GBase-SR, 10GBase-SW, 10GBase-LX4, 
10GBase-LR, 10GBase-LW, 10GBase-ER, 

10GBase-EW 
2002 

10 Gbit/s 802.3ak 10GBase-CX4 2003 10 Gbit/s 

802.3an 10GBase-T 2006 

10 Gbit/s 

802.3ap 10GBase-KR, 10GBase-KX4 2007 

40 Gbit/s 
100 Gbit/s 

802.3ba 
40GBase-KR4, 40GBase-CR4, 40GBase-SR4, 
40GBase-LR4, 100GBase-CR10, lOOGBase-

SR10, 100GBase-LR4, 100GBase-ER4 
2010 
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4.1.1 Vývoj standardu IEEE 802.3 

Ethernet 

Někdy také označovaný jako štandartní Ethernet, podporuje přenosovou rychlost 
10 Mbit/s, pracuje jako sdílené médium a je tedy nutná implementace přístupové metody 
C S M A / C D pro minimalizace kolizí. Jako přenosové médium lze použít koaxiální kabel, 
nestíněnou kroucenou dvoulinku s jedním párem vodičů či optický kabel, poslední jmenovaný 
umožňuje maximální délku linky až 2000 m [10]. 

Fast Ethernet 

Zpětně kompatibilní s předchozí generací, maximální přenosová rychlost se zvýšila na 
100 Mbit/s. Kvůli požadavku zpětné kompatibility zůstává stejný formát rámce, a také 
implementace metody CSMA/CD, která je použita v poloduplexním módu. Tato generace již 
umožňuje plně duplexní mód, pro který odpadá nutnost použití přístupové metody. Nově je 
implementována funkce pro automatické dohodnutí parametrů přenosu mezi komunikujícími 
zařízeními, ty si sami dohodnou přenosovou rychlost a duplexní mód. Praktická realizace je 
možná pomocí stíněné kroucené dvoulinky, optického vlákna, pro obě technologie s použitím 
jednoho páru vodičů/vláken. Dva páry vodičů lze použít pouze s nestíněnou kroucenou 
dvoulinkou. 

Gigabit Ethernet 

Přebírá funkce z předchozích generací a opět je zajištěna zpětná kompatibilita, 
přenosový rychlost vzrostla na 1 Gbit/s. Při použití optických vláken s dlouhou vlnovou délkou 
lze realizovat linku o délce až 5000 m. 

Ten-Gigabit Ethernet 

Opět je zajištěna podpora zpětné kompatibility, formát rámce je zachován a přebrány 
jsou i funkce předchozích generací, ovšem již není implementována přístupová metoda 
C S M A / C D a je možné pouze použití plně duplexního módu. Nově je umožněno propojení 
lokálních sítí s M A N (Metropolitan Area Network) a W A N (Wide Area Network) sítěmi. 
Umožněna je také kompatibilita s technologiemi A T M (Asynchronous Transfer Mode) a Frame 
Relay. Lze realizovat linky o velmi dlouhé délce, až 40 km, pomocí dvojice jednovidových 
optických vláken. [10] 

40G/100G Ethernet 

Zajištěna zpětná kompatibilita, stejně jako předchozí generace podporuje pouze plně duplexní 
mód, nově je podporována volitelná funkce FEC (Forward Error Correction) pro dopřednou 
opravu chyb. Technologický standard s přenosovou rychlostí 40 Gbit/s slouží k propojení 
datových center a verze s rychlostí 100 Gbit/s je používána k propojení přepojovacích prvků. 
[11] 
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4.2 IEEE 802.11 - WLAN 

Bezdrátové sítě jsou v principu totožné se sítěmi kabelovými, jenom se změnou 
přenosového média, kterým je volně šířený radiový signál. Ovšem tento rozdíl je velmi 
podstatný a ovlivňuje způsob, jakým jsou sítě budovány, a jaké podmínky jsou kladeny na 
standardy definující potřebné technologie. Nej rozšířenějším standardem popisujícím 
technologie bezdrátových lokálních sítí se stal IEEE 802.11, jeho původní verze byla vyvinuta 
v roce 1997 a během let prochází neustálým vývojem a jsou vyvíjeny nové modifikace tohoto 
standardu, nej používanější standardy zobrazuje Tabulka 2. 

Bezdrátové sítě mají řadu výhod, podstatnou z nich je dynamická topologie, která 
umožňuje přesun, přidávání a odebírání komunikujících stanic bez nutnosti zásahu do topologie 
a nastavení sítě. Je možné provozování bezdrátové sítě v oblastech, kam není vhodné či je úplně 
nemožná instalace kabelového vedení. 

Pro bezdrátové sítě nelze pevně definovat a ani vysledovat hranice, kde daná síť a její 
signál končí, topologie bezdrátových sítí jsou dynamické a přenášený signál je podstatně více 
náchylný k okolnímu rušení. To vše vyplývá ze základního faktu, že každá stanice nebo síťový 
prvek vysílá signál všesměrově a to do vzdáleností definovanými okolním prostředím a 
výkonem použitého vysílače/přijímače. V praxi to znamená, že jednotlivé sítě nacházející se ve 
vzájemném dosahu se mohou překrývat a vzniká tak možnost kolizí, přeslechů a celkově 
degradace signálu, případně parametrů přenosu. Bezdrátové sítě tedy lze obecně brát jako méně 
spolehlivé a tyto faktory j e nutné brát v potaz při návrhu sítě. Vzhledem ke sdílení přenosového 
kanálu jsou kladeny vysoké nároky na zabezpečení přenosu a zavedení přístupových metod. 
Bezdrátové sítě j sou vhodné pouze pro realizaci koncových sítí, jelikož dosah signálu j e obecně 
v řádech desítek metrů až stovky metrů a s rostoucí vzdáleností navíc dochází ke zhoršování 
parametrů přenosu (vyšší chybovost, snížená přenosových rychlost). 

4.2.1 Vývoj standardu IEEE 802.11 
Původní standard 802. l i j e považován za zastaralý a praktický se nepoužívá, vylepšením 

byl standard s označením 802.11b, který zvýšil maximální přenosovou rychlost na 11 Mbit/s, 
podporovány byly také rychlosti 1 Mbit/s, 2Mbit/s a 5,5 Mbit/s. Pro každou rychlost je užíváno 
jiné kódování a s rostoucí rychlostí se také snižuje odolnost proti rušení a tím vznik chyb, výběr 
rychlost je prováděn automaticky podle změřené chybovosti. [14] 

Standard 802.1 la se liší využitím pásma 5Ghz, které je v Evropě rozděleno na 19 kanálů 
o šířce 16,6 M H z a s dostupem 20 MHz. Oproti pásmu 2,4 GHz se vyznačuje menší intenzitou 
rušení, vzhledem k menší obsazenosti v oblasti tohoto kmitočtu, ale nevýhodou je menší dosah 
signálu. Přenosová rychlost dosahuje až 54 Mbits/s. 

Standard 802.1 l g přebírá způsob modulace a přenosové rychlosti od standardu 802.11b, 
se kterým je zpětně kompatibilní a navíc umožňuje rychlosti až do 54 Mbit/s, pro které je 
použita modulace O F D M (Orthogonal Frequency Division Multiplexing). 

Výraznou inovací přispěl standard 802.1 ln, který zavádí koncept MPMO (Multiple Input 
Multiple Output), ten umožňuje použití několika antén ve vysílací i přijímací části, každá z nich 
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může vysílat různém, prostorově odděleném kanále a každým kanálem (maximálně čtyři) lze 
přenášet samostatný datový tok. Přenosová rychlost jednoho kanálu j e až 150Mbit/s, s použitím 
technologie MIMO tedy teoretická hodnota dosahuje až 600 Mbit/s. 

Standard 802.11 ac vychází z předchozí verze, kterou vylepšuj e možností vysílání až osmi 
kanály s technologií MIMO, každý kanál má maximální přenosovou rychlost 866,7 Mbit/s. [14] 

Tabulka 2: Nej používanější standardy IEEE 802.11 [14] 

Označení Vznik Max. přenosová 
rychlost [Mbit/s] 

Použité frekvenční 
pásmo [GHz] 

802.11 1997 2 2,4 

802.11b 1999 11 2,4 

802.11a 1999 54 5 

802. l i g 2003 54 2,4 

802.1 ln 2009 150 2,4 nebo 5 

802.1 lac 2014 866,7 5 

Základním prvkem pro realizaci bezdrátových sítí je přístupový bod, který je obdobou 
přepínače v sítích Ethernet. Přístupový bod zajišťuje přenos komunikace mezi všemi stanicemi 
v dané síti, a také dokáže spojovat bezdrátovou sít se síti Ethernet a jejími stanicemi. Přístupový 
bod také zajišťuje možnost připojení stanic v dosahu jeho signálu, k tomu jsou určeny rámce 
správy, které jsou rozesílány přístupovým bodem v pravidelných intervalech (typicky každých 
100 ms) a nazývají se „beacon" rámce. V nich sděluje informace o propagované síti, parametry 
a požadavky, podle kterých se mohou stanice do sítě připojit. Důležité části beacon rámce jsou 
časové značky, které slouží k synchronizaci stanic, podporované přenosové rychlosti, způsob 
zabezpečení a název sítě SSID (Service Set Identifier). Stanice po vstupu do oblasti sítě 
naslouchá těmto rámcům a poté na něj odpovídá se žádosti o autentizaci, pokud se stanice 
dohodne s přístupovým bodem na parametrech (společná přenosová rychlost, typ zabezpečení, 
heslo) dochází k připojení do sítě. Pokud stanice obdrží vícero beacon rámců vybírá si mezi 
podle parametrů propagovaných přístupovým bodem nebo dle síly signálu. 

Křížení přístupu ke sdílenému médiu je implementována metoda C S M A / C A (Carrier 
Sense Multiple Acces with Collision Avoidance). Stanice před zahájením vysílání naslouchá, 
po dobu náhodně zvolenou z daného intervalu, pokud je během této doby stanice neaktivní, tak 
po uplynutí další čekací doby DIFS (Distributed Interframe Space) odešle rámec s žádostí 
k odesílání RTS (Request To Send). Po úspěšném uplynutí dalšího intervalu s názvem SIFS 
(Short Interframe Space) odešle cílová stanice odpověď s povolením k přenosu CTS (Clear To 
Send). Po uplynutí dalšího intervalu SIFS může začít stanice vysílat data. 

Jsou definovány tři typy rámců, řídící, datové a rámce správy. Poslední jmenované slouží 
k navázání vzájemné komunikace, řídící rámce obstarávají přístup ke kanálu a datové rámce 
obsahují data a kontrolní informace. Všechny mají pevně definovaný formát, každý rámec na 
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linkové vrstvě se skládá z devíti částí. První pole FC (Frame Control) o velikosti 2B definuje 
typ rámce a další řídící informace, druhé pole D o velikost 2B definuje délku trvání přenosu, 
s výjimkou řídících rámců, pro které určuje jejich identifikační číslo. Čtyři pole s M A C (Media 
Access Control) adresami stanic, které se podílejí na přenosu, každé pole má velikost 6B. Další 
poleje pořadové číslo rámce SC (Sequence Control) o velikosti 2B. Další částí jsou samotná 
data s velikosti od OB do 2312B (velikost a obsah tohoto pole se liší dle typu rámce), posledním 
polem je pole FCS o velikosti 4B a obsahuje kontrolní součet pro detekci chyb. [13][15] 

4.2.2 Zajištění kvality služeb 
Se stále rostoucí oblibou bezdrátových sítí, se také zvyšovaly požadavky na zajištění 

kvality služeb. Zpočátku nebylo při vývoji standardů věnováno příliš pozornosti, což bylo 
napraveno vývojem standardu IEEE 802.1 le, který rozšiřuje přístupové mechanismy 
původních W L A N sítí a nově umožňuje podporu mechanismů pro zajištění kvality služeb, Qos. 
Návrh byl propracován tak, aby byla zachována kompatibilita se zařízeními, které tento 
standard nepodporují. Nej důležitějšími metodami, které standard IEEE 802.1 le zavádí, jsou 
nové koordinační funkce, těmi jsou distribuovaná koordinační funkce EDCF (Enhanced 
Distributed Coordination Function) a hybridní koordinační funkce HCF (Hybrid Coordination 
Function), kterých využívají nově definované metody přístupu ke kanálu H C C A 
(HCF Controlled Channel Access) a E D C A (Enhanced Distributed Channel Access). [7] 

Metoda přístupu ke kanálu EDCA 

Tento mechanizmus pro zajištění kvality služeb nabízí rozdělení datového provozu do 
čtyř kategorií, a pro každou kategorii navíc může být definováno několik priorit, kterých může 
být celkově až osm. Jednotlivé kategorie jsou označeny jako Background (data pozadí), Best 
Effort (základní přenos), Video (obrazový signál) a Voice (přenos hlasu). Při současném 
vysílání dat v různých kategorií, dochází k soutěžení o přenosový kanál, princip vychází 
z původních přístupových metod, které aplikují stanice při žádosti o vysílání a využívají čekací 
rámce SIFS. Navíc se zavádí nový čekací rámec AIFS (Arbitration Interframe Space), jehož 
délka se liší podle kategorie provozu a další možností diferenciace je nastavení minimální a 
maximální hodnoty parametru CW (Contention Window), při nižší hodnotě je pravděpodobnost 
přístupu ke kanálu vyšší. Pokud komunikuje stanice s podporou mechanismu E D C A se stanicí, 
která jej nepodporuje, je provoz řazen automaticky do kategorie Best Effort, stejně tak je tomu 
v případě, že se jedná o datový tok nepřiřazený žádné z definovaných kategorií. [15] 
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5 AKTIVNÍ SÍŤOVÉ PRVKY 

Způsob funkce a principy, které jsou aplikovány při zpracování a přenosu zpráv v rámci 
počítačových sítí vychází z rozdělení jednotlivých úkonů do skupin definovaných 
v referenčním modelu ISO/OSI, případně ve zjednodušeném modelu TCP/IP. Složení obou 
modelu zobrazuje Tabulka 3. Pro úspěšné provedení a zpracování přenosu informace, dochází 
k postupnému zpracování datové jednotky danou vrstvou a předání její sousední vrstvě. Pro 
samotný přenos dat jsou nej důležitější tři nej nižší vrstvy, fyzická, spojová a síťová. Zbylé čtyři 
vrstvy, respektive aplikační vrstva modelu TCP/IP mají za úkol především práci s datovým 
obsahem zpráv a jsou obvykle záležitostí uživatelských aplikací. 

Na třech nej nižších vrstvách operují aktivní síťové prvky, které zprostředkovávají přenos 
informace skrze komunikační síť. Podle typu zařízení mohou vykonávat i mnoho dalších 
funkcí, jako řízení přístupu ke sdílenému médiu, zajištění kvality služeb nebo směrování 
datového toků sítí s nalezením nejlepší cesty. Množina operací, které jsou schopny dané prvky 
provádět, vychází právě z principu rozdělení komunikačního modelu na jednotlivé vrstvy. 

Síťová vrstva a na ní operující síťové prvky tedy mohou poskytnout nej rozsáhlejší 
možnosti při zpracování přijatých nebo odesílaných zpráv, jelikož prvky na této vrstvě musí 
také zvládat operace obou nižších vrstev. Nevýhodou jsou vyšší výpočetní nároky, které 
vyplývají z vyšší složitosti prováděných operací, a také riziko nefunkčnosti, či znehodnocení 
parametrů komunikační sítě vzniklé nevhodným nastavením. Vzhledem k vyšším možnostem 
režie datového toku, také vzniká možnost nárůstu časového zpoždění přenášených dat. Stejný 
princip platí i pro aktivní síťové prvky druhé vrstvy, tedy zpracování datových jednotek probíhá 
na fyzické a spojové vrstvě. Tyto prvky tedy nabízí menší možnosti nastavení a řízení provozu, 
ale výhodou jsou nižší výpočetní nároky. Síťové prvky nej nižší vrstvy pracují pouze s vrstvou 
fyzickou a jejich možnosti jsou tedy velmi omezené, výhodou je však jednoduchost nastavení, 
minimální výpočetní nároky a minimální zpoždění přenášených dat. 

Tabulka 3: Referenční model ISO/OSI a TCP/IP 

7. Aplikační vrstva 

4. Aplikační vrstva 
6. Prezentační vrstva 

4. Aplikační vrstva 
5. Relační vrstva 

4. Aplikační vrstva 

4. Transportní vrstva 

4. Aplikační vrstva 

3. Síťová vrstva 3. Síťová vrstva 

2. Spojová vrstva 2. Spojová vrstva 

1. Fyzická vrstva 1. Fyzická vrstva 
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5.1 Fyzická vrstva 

Nejnižší vrstva referenčního modelu ISO/OSI, na které se operuje se signálem 
reprezentovaným ve fyzické podobě, v kabelových sítích se jedná o signál elektrický. Tato 
vrstva zajišťuje přijímání a vysílání signálu komunikační sítí a kromě fyzických parametrů 
signálu definuje také kódování, přenosovou rychlost a fyzické propojení jednotlivých prvků 
sítě, tedy kabeláž, zapojení konektorů. 

Jelikož se jedná pouze o fyzickou vrstvu, nijak se nepracuje s adresami, ať už fyzickými 
či logickými ani s obsahem přenášených dat. Jediné operace, které mohou aktivní prvky 
provádět, se týkají modifikace fyzického signálu, napěťové úrovně, tvar nebo časování. 

Základním prvkem fyzické vrstvy jsou opakovače, které mají jeden vstupní a jeden 
výstupní port. Dokáží zpracovávat signál pouze pro jeden směr komunikace a pro použití 
v obousměrné komunikaci musí být použit opakovač pro každý směr. Jejich hlavní funkcí je 
obnova, případně zesílení přenášeného signálu, tak aby bylo možné přenášet data na delší 
vzdálenosti, proto je oblast využití především v geograficky rozsáhlých sítích. 

Rozbočovač vychází z principu funkce opakovače, ovšem obsahuje několik portů a 
všechny jsou obousměrné. Na všech portech musí být data přenášena stejnou rychlostí. Pracuje 
pouze se signálem a jednotlivými bity, které z příchozího portu posílá na všechny ostatní porty, 
vzniká tak hvězdicová topologie, kdy rozbočovač působí j ako centrální prvek [16]. Rozbočovač 
se již v dnešní době příliš nepoužívá a obzvlášť v sítích s větším počtem stanic propojených 
rozbočovači dochází k vysokému zatížení sítě vlivem všesměrového rozesílání signálu. Navíc 
vzniká riziko kolizí při současném vysílání dvou a více stanic, při nich vznikají neplatné rámce, 
které jsou dále rozesílány na všechny stanice v síti a dochází ke zbytečnému zahlcování sítě. 
Vzhledem k absenci jakéhokoliv filtrování datového provozu, také existuje riziko vzniku 
smyček obzvláště při rozsáhlejší a složitější topologii sítě. 

5.2 Spojová vrstva 

Druhá vrstva referenčního modelu ISO/OSI, která již překládá fyzický signál na datové 
jednotky, které se nazývají rámce. Ty neobsahují pouhá data, ale také směrovací informace, 
zdrojovou a cílovou fyzickou adresu, kontrolní součet a další položky. Podrobný popis rámce 
linkové vrstvy sítě Ethernet je uveden v kapitole 4.1. Z adres obsažených v každém rámci lze 
identifikovat jednotlivá spojení, a provádět filtrování přijatých dat. 

Hlavním aktivním síťovým prvkem operujícím na spojové vrstvě je přepínač. Jehož 
základní funkcí je přepínání příchozích datových jednotek na odpovídající výstupní porty. 
Volba výstupního portu je určena tabulkou fyzických adres, kterou si každý přepínač vytváří 
dynamicky, čtením pole zdrojové adresy v příchozích rámcích. Přepínač navíc rozděluje kolizní 
doménu, díky čtení a kontrole obsahu jednotlivých polí přijatých rámců, nejsou přepínači dál 
přeposílány chybné rámce. 

Databáze adres stanic připojených k portům přepínače obsahuje kromě dvojice adresa, 
port, také časovač pořízení záznamu. Ten slouží k odstranění záznamu z tabulky po určitém 
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čase, pokud stanice s danou adresou byla odpojena nebo vypnuta a tedy již dále nekomunikuje. 
Pokud není v tabulce uložena cílová adresa přijatého rámce, tak přepínač rozesílá data na 
všechny porty, kromě toho, ze kterého je přijal. [16] 

5.3 Síťová vrstva 

Třetí vrstva referenčního modelu ISO/OSI zajišťuje cestu datových jednotek od zdroje až 
k cíli, to je umožněno směrováním datových jednotek sítí, které jsou posílány cestou vybranou 
jako nejvhodnější. Určení cestu se může lišit a je závislé především na použitém směrovacím 
protokolu a topologii sítě. Přehled směrovacích protokolu je uveden v kapitole 3. Datová 
jednotka, se kterou se pracuje na síťové vrstvě, se nazývá paket, nebo také IP datagram. 

Aktivním prvkem na síťové vrstvě je směrovač, který určuje optimální cestu mezí 
zdrojem a cílem přijaté zprávy. To je rozhodováno na základě směrovací tabulky, kterou si 
uchovává každý směrovač. Vytváření směrovacích tabulek může probíhat dvojím způsobem. 
Statické vytváření tabulek provádí uživatel/správce sítě ručním zadáním jednotlivých záznamů, 
tento způsob je vhodný pouze pro jednoduché sítě se stálou topologií, protože každá změna 
v síti musí být pro správnou funkčnost komunikace reflektována do směrovacích tabulek 
každého směrovače, což je nutno provést manuální úpravou. Ve většině případů je vhodnější 
dynamický způsob vytváření směrovacích tabulek, v takovém případě si informace o síti 
vyměňují směrovače mezi sebou a postupně tak vytvářejí mapování kompletní sítě. Dynamické 
směrování tak dokáže reagovat na změny v topologii, pokud například dojde k poruše 
směrovače v síti, ostatní směrovače dokáží poměrně rychle reagovat a nalézt náhradní cestu. 
Rychlost, s j akou jsou všechny směrovače v síti schopny aktualizovat obsah směrovacích 
tabulek po změně topologie, se nazývá konvergence. Rychlost konvergence je závislá na typu 
a nastavení použitého směrovacího protokolu, může se pohybovat řádově v jednotkách sekund. 
Nevýhodou je vzájemné rozesílání informací mezi směrovací, které tak snižuje kapacitu 
přenosových linek. 

Každý platný záznam směrovací tabulky musí obsahovat IP adresu cílové sítě a masku 
této sítě, IP adresu dalšího skoku (směrovače na cestě k cílové síti) a číslo rozhraní, kterému 
jsou tyto údaje přiřazeny. Pro dynamické směrování je v tabulce navíc pole určující metriku, 
neboli cenu daného spoje a pole se stářím zápisu daného záznamu, které hlídá jeho platnost. 
Po vypršení nastavených časových úseků je záznam považován za neplatný a poté může dojít 
k jeho vymazání. 

Směrovače také umožňují překlad logických adres na adresy fyzické, dokáží spojovat 
rozhraní s různými přenosovými rychlostmi a podporují mechanismy pro řízení kvality služeb. 
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6 PRAKTICKÁ REALIZACE ZADÁNÍ 

Tato kapitola obsahuje stručné shrnutí jednotlivých laboratorních úloh a cílů, kterých má 
být dosaženo při vypracování dané úlohy. Každá úloha také poskytuj e zobrazení topologie sítě, 
pro kterou jsou simulace prováděny. 

6.1 Laboratorní úloha č.l - Směrovací protokoly 

Cílem této laboratorní úlohy je srovnání vlastností směrovacích protokolů RIP a OSPF. 
Simulace bude prováděna v jednoduché síti s pěti směrovací a dvěma koncovými zařízeními 
propojenými technologií ethernet. Topologie zadání je na Obr. 13. 

První část úlohy zahrnuje vytvoření dvou sítí se zavedeným směrovacím protokolem RIP 
respektive OSPF. Úkolem je sledování procesu vytváření směrovacích tabulek v simulačním 
nástroji OMNeT++/Tkenv a srovnání záznamů ve výsledných tabulkách obou protokolů. Po 
dokončení simulace lze tento proces dále analyzovat ve výsledcích. 

Dalším úkolem je rozdělení sítě s protokolem OSPF na dvě menší oblasti a porovnání 
s nerozdělenou sítí. 

Pro další část úlohy se nastaví generování síťového provozu z koncové stanice 
H l ke stanici H2 a vytvoří se scénář s výpadkem linky a následným obnovením, který umožní 
porovnání reakce na změnu topologie obou protokolů a volbu náhradní cesty k cílové síti. 
Kompletní návod k laboratorní úloze je k nalezení v příloze A. 

configurator icenarioManager 

Obr. 13: Topologie sítě pro směrovací protokoly 
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6.2 Laboratorní úloha č.2 - Zajištění kvality služeb 

Cílem této laboratorní úlohy je srovnání různých mechanizmů řízeného odesílání paketů 
a jejich vlivu na parametry definující kvalitu síťového přenosu (zpoždění, proměnlivost 
zpoždění, ztrátovost paketů). K simulaci poslouží jednoduchá síť slinkou poskytující 
nedostatečnou šířku pásma pro definovaný provoz a koncové stanice současně generující 
FTP (File Transfer Protocol) datový přenos a VOIP hovor. Zapojení topologie sítě lze vidět na 
Obr. 14. 

První částí úlohy je vytvoření sítě a všech souborů potřebných pro realizování 
mechanizmů pro řízení odesílání paketů. V úloze j sou tři různé scénáře, bez zavedených technik 
QoS (fronta FIFO), mechanizmus prioritních front s řízenou rychlostí PQ a mechanizmus 
spravedlivých váhových front WFQ. 

Po vytvoření sítí následuje simulování všech vytvořených scénářů a porovnání získaných 
výsledků. Ze získaných hodnot jsou důležité hlavně parametry přenosu VOIP hovoru, průměrné 
zpoždění a kolísání zpoždění (jitter). A také počet a druh zahozených paketů a obousměrné 
zpoždění (RTT - Round-Trip Time) přenosu FTP paketů. 

Následně se vyzkouší vliv nastavení parametrů jednotlivých mechanizmů pro řízení 
provozu a jejich změn na výslednou kvalitu služeb. Kompletní návod k laboratorní úloze je 
k nalezení v příloze B. 

VOIP_client configurator VOIP_client2 

Obr. 14: Zapojení topologie sítě 
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6.3 Laboratorní úloha č.3 - WLAN vs. Ethernet 

Cílem laboratorní úlohy je srovnání v současnosti nejvyužívanějších technologií 
k realizaci počítačových sítí, kabelové spojení technologií Ethernet dle standardu IEEE 802.3 
a spojení bezdrátové, využívající k přenosu radiový signál, dle standardu IEEE 802.11. 

Úloha srovnává parametry přenosu dat v obou technologiích a zaměřuje se také na přenos 
řídících dat potřebných k navázání a udržení spojení. Dále se blíže sledují možnosti bezdrátové 
sítě, například podpora pro řízení kvality služeb a vliv vzdálenosti na chybovost přenášených 
dat. K simulaci je využito jednoduché zapojení dvou navzájem komunikujících klientů pomocí 
přístupového bodu, respektive přepínače. Topologii bezdrátové sítě lze vidět na Obr. 15. 
Zapojení sítě Ethernet lze vidět na Obr. 16. Kompletní návod je uveden v příloze C. 

r % í d-jT ^ / 
wirelessHostl accessPoint wirelessHost2 

radioMediurn configurator 

Obr. 15: Topologie bezdrátové sítě 

hosti clients witch host2 

configurator 

Obr. 16: Topologie kabelové sítě Ethernet 
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6.4 Laboratorní úloha č.4 - Aktivní síťové prvky 

Cílem laboratorní úlohy je srovnání nej používanějších aktivních síťových prvků, které 
slouží k vytváření počítačových sítí a umožňují komunikaci mezi koncovými stanicemi. 

V úloze jsou k propojení sítě použity rozbočovače, přepínače a směrovače, každý z těchto 
prvků pracuje na jiné vrstvě referenčního modelu ISO/OSI. Tím jsou dány hlavní rozdíly 
v jejich funkci při zpracování a přeposílání příchozích dat, které lze sledovat ve vytvořené 
simulaci. 

Ke srovnání síťových prvků je sledován parametr zpoždění přenosu souborů službou FTP 
a množství rozesílaných dat na jednotlivých linkách. Pro simulaci poslouží jednoduchá síť se 
čtyřmi klienty. Topologii sítě propojené přepínači lze vidět na Obr. 17, ostatní sítě jsou 
obdobné, pouze je k propojení koncových stanic využito rozbočovaču, respektive směrovačů. 
Kompletní návod je uveden v příloze D. 

configurator 

Obr. 17: Topologie sítě propojené přepínači 
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ZÁVĚR 

Cílem diplomové práce je návrh čtyř laboratorní úloh, určených k výuce studentů a 
k rozšíření či ověření jejich znalostí problematiky síťových technologií. K vytvoření těchto 
úloh bylo využito prostředí síťového simulátoru OMNeT++ s využitím nástavby Inet 
Framework. 

V kapitole 1 je popsána struktura použitých programových prostředků a principy práce 
s nimi, při vytváření projektů, provádění simulací a následné analýze výsledků. 

Další čtyři kapitoly nabízí teoretické podklady pro témata navržených laboratorních úloh. 
Kapitola 2 je zaměřena na způsoby zajištění kvality síťových služeb, jejich diferenciaci a popis 
používaných technik pro řízení odesílání paketů. Kapitola 3 popisuje teorii směrovacích 
protokolů a jejich rozdělení, s bližším zaměřením na protokoly RLPv2 a OSPFv2. Kapitola 4 
popisuje technologie pro realizaci lokálních počítačových sítí, z nichž v současnosti 
nejvyužívanějšími jsou kabelová síť Ethernet popsaná standardem IEEE 802.3 a dalšími 
modifikacemi tohoto standardu a standard IEEE 802.11 včetně jeho dalších modifikací, které 
definují sítě bezdrátové s přenosem dat radiovým signálem. K oběma technologiím je uveden 
stručný technologický popis a definice typických parametrů. Kapitola 5 obsahuje popis 
základních aktivních síťových prvků, jež se používají k realizaci, zejména lokálních, 
počítačových sítí, umožňují komunikaci mezi koncovými zařízeními. Popsány jsou zde 
rozbočovač, přepínač a směrovač, stručné principy jejich funkce a způsobu, jakým zpracovává 
přijatá data a odesílaná data. 

Kapitola 6 obsahuje praktickou část řešení, tedy čtyři vytvořené laboratorní úlohy, Úloha 
č. 1 - Směrovací protokoly, Úloha č. 2 - Zajištění kvality služeb, Úloha č. 3 - W L A N vs. 
Ethernet, Úloha č. 4 - Aktivní síťové prvky. Je zde popsán úvod k laboratorní úloze, 
požadované řešení v rámci vypracování a zapojení topologie sítě určené k simulaci. Všechny 
úlohy jsou vytvořeny formou kompletního návodu, včetně zdrojového kódu, jehož 
zkopírováním lze vytvořit testovanou síť i bez znalosti práce s programem OMNeT++. Návod 
je také průvodcem k vhodnému provedení simulace, následnému zobrazení a analýze získaných 
výsledků. Kompletní návody ke všem laboratorním úlohám jsou uvedeny v příloze. 
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A. Laboratorní úloha č.l - Směrovací protokoly 

Cílem této laboratorní úlohy je srovnání vlastností směrovacích protokolů RIP a OSPF. 
Vytvoříte jednoduchou síť s pěti směrovací a dvěma koncovými zařízeními propojenými 
technologií ethernet. Z výsledků lze sledovat rozdíly ve vytváření směrovacích tabulek, 
množství dat generovaných směrovací, a to jak při běžném chování sítě, tak i při výpadku spoje 
mezi směrovací. Pro směrovací protokol OSPF navíc porovnáte vlastnosti sítě s jednou oblastí 
a sítě rozdělené na dvě menší oblasti. Zapojení topologie sítě lze vidět na obrázku 1. 

configurator icenarioManager 

Obrázek 1: Zapojení topologie sítě 

1. Teoretický úvod 

Směrovací protokoly slouží pro vytváření směrovacích tabulek popisujících topologii sítě 
bez nutnosti ručně zapisovat adresy, vyhledávání nej vhodnějších cest podle různých metrik a 
pravidelně aktualizovat informace všech směrovačů v síti, tak aby byla zaručena konvergence 
v síti v co možná nejkratším čase. V důsledku stále se rozšiřující globální sítě není možné 
zajistit konvergenci nasazením jednoho směrovacího protokolu, který by spravoval kompletní 
síť. Z tohoto důvodu se sítě rozdělí na menší části s různou směrovací politikou. Z pohledu 
směrování je základním rozdělením protokolů na EGP (Exterior Gateway Protocol), který 
slouží na globální úrovni k propojování menších lokálních sítí, ve kterých jsou použity 
protokoly IGP (Interior Gateway Protocol), do této skupiny patří protokoly RIP (router 
Information Protocol) a OSPF (Open Shortest Path First), na které se tato úloha zaměřuje. 
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2. Vypracování 

Založení nového projektu 
Spustíme program omnetpp.exe. Pokud se objeví nabídka pro vybrání pracovního 

adresáře, tento formulář potvrdíme beze změny (vybraná cesta musí být: omnetpp-4.6\samples), 
jinak vytvořený projekt nebude fungovat. 

K vytvoření nového projektu klikneme na File » New » OMNeT++ Project... Projekt 
pojmenujeme V U T loginem, dále stiskneme Next » Empty project » Finish. V okně Project 
Explorer se vytvořila námi poj menovaná složka, ve které budou uloženy všechny části proj ektu. 
Nejprve je zapotřebí přiřadit k projektu odkazy na zdrojové soubory, se kterými se bude dále 
pracovat. To provedeme kliknutím pravým tlačítkem na vytvořenou složku » Properties » 
Project References » vybereme položku inet» OK. 

Pro vytvoření projektu jsou zapotřebí dva základní soubory. Network Description File, 
s příponou .ned, který definuje topologii sítě, použité technologie a síťové prvky. Druhým je 
Initialization File, přípona .ini, který určuje průběh a parametry simulace. 

Klikněte pravým tlačítkem myši na vaši složku a vyberte New » Network Description 
File (NED), pojmenujte j i Network.ned » Next » Empty NED File » Finish. 

V souboru NED lze pracovat ve dvou režimech, v grafickém nebo kódovém. Mezi nimi 
se lze přepínat v levém dolním rohu volbou Design/Source. Jsou navzájem propojené, pokud 
tedy přidáme prvky sítě z palety, vytvoří se k nim patřičný kód a naopak vložením kódu lze 
vytvářet celou síť. 

Vypracování 1. část - RIP 
Nejprve musíme importovat do projektu prvky, se kterými se bude pracovat. Do souboru 

Network.ned v režimu Source vložíme následující kód: 

import i n e t . c o m m o n . l i f e c y c l e . L i f e c y c l e C o n t r o l l e r ; 
import i n e t . c o m m o n . m i s e . T h r u p u t M e t e r i n g C h a n n e l ; 
import inet.common.scenário.ScenarioManager; 
import i n e t . n e t w o r k l a y e r . c o n f i g u r a t o r . i p v 4 . I P v 4 N e t w o r k C o n f i g u r a t o r ; 
import i n e t . n e t w o r k l a y e r . i p v 4 . I P v 4 R o u t i n g T a b l e ; 
import i n e t . n e t w o r k l a y e r . i p v 4 . R o u t i n g T a b l e R e c o r d e r ; 
import i n e t . n o d e . i n e t . S t a n d a r d H o s t ; 
import i n e t . n o d e . o s p f v 2 . O S P F R o u t e r ; 
import i n e t . n o d e . r i p . R I P R o u t e r ; 

Dále vytvoříme síť pojmenovanou RIP, ta bude obsahovat 5 routerů nastavených pro 
směrovací protokol RIP a 2 koncová zařízení. Prvky sítě se definují v sekci submodules, kde se 
zapíše jméno a požadovaný prvek, v tomto případě použijeme StandardHost pro koncová 
zařízení a RIPRouter pro směrovače. Prvkům lze přiřazovat různé parametry, zatím nám stačí 
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pouze nadefinovat polohu zobrazení v grafické topologii a počet, respektive typ aktivních 
rozhraní. 

Vytvoříme 2 přenosové kanály a definujeme jejich parametry. Všechny prvky v síti jsou 
propojeny technologií ethernet s přenosovou rychlostí lOOMbit/s respektive lOMbit/s a oba se 
zpožděním 0,1 us. Zvolíme typ ThruputMeteringChannel. 

network RIP 
{ parameters: 

Sdisplay ("p=10,10;b=712,152;bgb=661, 348") ; 
types: 

channel LAN10 0 extends T h r u p u t M e t e r i n g C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 100Mbps; 
} 

channel LAN10 extends T h r u p u t M e t e r i n g C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 10Mbps; 
} 

submodules: 
HI: S t a n d a r d H o s t { 

parameters: 
gates: 

} 

H2: S t a n d a r d H o s t { 
parameters: 
gates: 

} 

R l : R I P R o u t e r { 
parameters: 
gates: 

} 

R2: R I P R o u t e r { 
parameters: 
gates: 

} 

R3: R I P R o u t e r { 
parameters: 
gates: 

} 

R4: R I P R o u t e r { 
parameters: 
gates: 

} 

R5: R I P R o u t e r { 
parameters: 
gates: 

} 

Sdisplay("p=42,154"); 
e t h g [ l ] ; 

Sdisplay("p=607, 154"); 
e t h g [ l ] ; 

Sdisplay("p=216,154"); 
e t h g [ 4 ] ; 

Sdisplay("p=4 31,154"); 
e t h g [ 4 ] ; 

Sdisplay("p=323,2 8 5 " ) ; 
e t h g [ 2 ] ; 

Sdisplay("p=216,36"); 
e t h g [ 2 ] ; 

Sdisplay("p=4 31, 3 6") ; 
e t h g [ 2 ] ; 

s c e n a r i o M a n a g e r : ScenarioManager {Sdisplay("p=599,297"); 
} 

46 



Dále nakonfigurujeme síťovou adresaci, k tomu využijeme prvek 
IPv4NetworkConfigurator s následujícími parametry. Pro připojení koncových zařízení 
k nejbližšími směrovací nastavíme privátní IP adresy z rozsahu třídy C a pro spoje mezi všemi 
routery zvolíme adresy z rozsahu třídy A privátních adres. Také nastavíme výchozí brány pro 
obě koncová zařízení a povolíme multicastovou komunikaci na všech aktivních rozhraní 
směrovačů, ten je využíván pro rozesílání směrovacích informací. 

c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 
parameters: 

Sdisplay("p=502 , 297") ; 
c o n f i g = xml ("<config>" 

+ " < i n t e r f a c e among= •Hl R ľ 
address= 192.168 . 1 x' netmask='255.255.255.x , 

+ " < i n t e r f a c e among= 'H2 R2' 
address= 192.168.2 x' netmask='255.255.255.x , 

+ " < i n t e r f a c e among= 'R*' address='10.1.0 .x' 
netmask= 255.255.255.x' />" 

+ "<route hosts='Hľ d e s t i n a t i o n = ' * ' 
gateway= R l ' / > " 

+ "<route hosts='H2' d e s t i n a t i o n = ' * ' 
gateway= R2'/>" 

+ "<route hosts='R*' d e s t i n a t i o n = ' 2 2 4 . 0 . 0.0' 
netmask= 240.0.0.0 i n t e r f a c e = ' e t h O ' />" 

+ "<route hosts='R*' d e s t i n a t i o n = ' 2 2 4 . 0 . 0.0' 
netmask= 240.0.0.0 i n t e r f a c e = ' e t h l ' />" 

+ "<route h o s t s = ' R l R2' d e s t i n a t i o n = ' 2 2 4 .0.0 0 ' 
netmask= 240.0.0. 0 i n t e r f a c e = ' e t h 2 ' / > " 

+ "<route h o s t s = ' R l R2' d e s t i n a t i o n = ' 2 2 4 .0.0 0 ' 
netmask= 240.0.0. 0 i n t e r f a c e = ' e t h 3 ' / > " 

+ " < / c o n f i g > " ) ; } 

K dokončení návrhu už zbývá pouze propojit prvky sítě. Jedná se o plně duplexní spojení 
s parametry kanálů LAN100 a LAN10, které jsme nadefinovali již v předchozích krocích. 
Věnujte pozornost přenosovým rychlostem přiřazených jednotlivým linkám, z tohoto nastavení 
lze následně pozorovat metodiku směrování v síti. 

connections: 
H l e t h g [ 0 ] <- -> LAN100 <--> R l .ethg[0] 
H2 et h g [ 0 ] <- -> LAN100 <--> R2 .ethg[0] 
R5 e t h g [ l ] <- -> LAN100 <--> R2 . e t h g [ l ] 
R4 et h g [ 0 ] <- -> LAN100 <--> R5 .ethg[0] 
R l e t h g [ 2 ] <- -> LAN100 <--> R4 . e t h g [ l ] 
R l e t h g [ 3 ] <- -> LAN100 <--> R2 .ethg[3] 
R l e t h g [ l ] <- -> LAN10 < — > R3. e t h g [ l ] ; 
R2 et h g [ 2 ] <- -> LAN10 < — > R3. e t h g [ 0 ] ; 

} 
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Tímto je vytvořená síť kompletně zprovozněna k provádění simulací, nyní je zapotřebí 
určit parametry a průběh simulace. Jelikož soubor N E D je statický, je vhodné v něm definovat 
pouze základní parametry, které nechceme dále měnit ani nijak upravovat. 
Pro nastavení průběhu simulace a síťového provozu slouží konfigurační soubor s příponou .ini. 
Spuštěním tohoto souboru zahájíme simulaci. 

Do složky s projektem vytvoříme nový soubor, New »Initialization File (ini) » můžete 
ponechat název omnetpp.ini » Next » Empty Ini File » Finish. 

Pro potřeby simulace j e možné v j ednom souboru vytvářet několik různých konfigurací, 
k vybrání požadované budeme vyzvání po spuštění simulace. Pro vytvoření nové konfigurace 
se používá syntaxe [Config nazevkonfigurace] zapsaná v hranatých závorkách. Hlavní částí je 
sekce [General], která obsahuje nastavení společná pro všechny vytvořené konfigurace, jejím 
nastavením začneme. 

Vložíme následujícíkód, který povolí výpis problému při chybně nastavené simulaci, 
nastaví se cesta k potřebným doplňkům a omezí se maximální trvání simulace na 10 minut. 

d e b u g - o n - e r r o r s = true 
t k e n v - p l u g i n - p a t h = . . / i n e t / e t c / p l u g i n s 
s i m - t i m e - l i m i t = 600s 

Dále zakážeme vytváření statických směrovacích tabulek: 

* . c o n f i g u r a t o r . a d d S t a t i c R o u t e s = f a l s e 
* . c o n f i g u r a t o r . a d d S u b n e t R o u t e s = f a l s e 
* . c o n f i g u r a t o r . a d d D e f a u l t R o u t e s = f a l s e 

Dále vytvoříme novou konfiguraci, [Config RIP], kterou vložíme na konec kódu souboru 
omnetpp.ini a do ní zapíšeme kód, kterým specifikujeme použitou síť a cestu k souboru 
s konfigurací metriky v síti: 

network = RIP 
* * . r i p . r i p C o n f i g = xmldoc("RIP.xml") 

Při pojmenovávání konfigurací se snažíme volit výstižné názvy, jelikož budeme vytvářet 
vícero konfigurací, usnadní se tímto orientace v jednotlivých simulacích a v souborech 
z výsledky, které se pojmenují dle názvu zvolené konfigurace. 

Tento soubor nyní musíme vytvořit, New » File » RIP.xml » Finish, a vložením 
následujícího kódu nastavíme metriku pro všechny spoje v síti na hodnotu 1. 

<?xml v e r s i o n = " l . 0 " ? > 
<RIPConfig> 

< i n t e r f a c e among="R? R?" m e t r i c = " l " / > 
</RIPConfig> 
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Tato hodnota odpovídá počtu přeskoků při průchodu dat směrovací, což je jediná metoda 
metriky implementovaná směrovacím protokolem RTP. Z toho také vyplývá hlavní výhoda při 
použití RIP a to jednoduchost implementace. Tímto krokem je konfigurace směrování 
kompletně dokončena. Vytvoření tohoto souboru navíc není povinné, pokud nepotřebujeme 
měnit počet přeskoků při průchodu rozhraním, jelikož hodnota metriky je defaultně nastavena 
na 1, ale pro účely dalšího testování lze tento zápis rozšířit. Syntaxe je patrná z výše uvedeného 
kódu, kdy se definuje nastavovaný spoj a následně jeho metrika, otazník nahrazuje libovolný 
znak. 

Před prvním spuštěním simulace je potřeba sestavit projekt, klikneme pravým tlačítkem 
myši na složku s projektem » Build Configurations » Build Selected... » zaškrtneme gcc-
debug » OK. 

Po dokončení operace můžeme spustit simulaci, klikneme pravým tlačítkem myši na 
soubor RIP.ini » Run As » OMNeT++ Simulation » vybereme konfiguraci pojmenovanou 
RIP » OK. 

Pro zobrazení směrovací tabulky klikneme myší na jeden ze směrovačů a v okně 
s obsahem (obvykle v levém dolním rohu) vybereme routingTable » routes. 

fgg [std::vector<inet::IPv4Route*>) RIP.Rl.routingTable.routes 

Fields Contents (0) 

B ro utes (std:: vecto r< i n et: :IP v4 Ro ute *>) 
rputes[12] [inet::IPv4Route*] 

[0] = destlO.1.0.0 gw:* m a sk:255.255.255.252 metric:20 if:ethl[10.1.0.1) DIRECT IFACENETMASK 
-[1]= dest:10.1.0.4 gw:* mask:255.255.255.252 metric:200 if:eth2[10.1.0.5) DIRECT IFACENETMASK 
-[2] = destilO.l.O.a gw:10.1.0.6" rnask:255.255.255.252 metrics if:eth2[10.1.0.5] REMOTE RIP 

[3]= dest:10.1.0.12 gw:10.1.0.6" rnask:255.255.255.252 metric:2 if:eth2[10.1.0.5) REMOTE RIP 
-[4] = dest:10.1.0.16 gw:10.1.0.2 rnask:255.255.255.252 metric:2 if:ethl[10.1.0.1) REMOTE RIP 

[5] = dest:10.1.0.20 gw:10.1.0.6" rnask:255.255.255.252 metric:2 if:eth2[10.1.0.5) REMOTE RIP 
[&] = dest:192.16a.l.O gw:* rnask:255.255.255.252 metric:2D if:eth0a92.168.1.2) DIRECT IFACENETMASK 

-[7]= dest:192.168.2.0 gw:10.1.0.6 mask:255.255.255.252 metrics if:eth2[10.1.0.5) REMOTE RIP 
[8] = dest:127.0.0.0 gw:* rnask:255.0.0.0 metric! if:loO[127.0.0.1) DIRECT IFACENETMASK 

-[9] = dest:224.0.0.0 gw:* mask:240.0.0.0 metri c:0 if:eth0(192.16a.l.2) DIRECT MANUAL 
[10] = dest:224.0.0.0 gw:* mask:240.0.0.0 metricO if:ethl[10.1.0.1) DIRECT MANUAL 
[11] = dest:224.0.0.0 gw:* mask:240.0.0.0 metri c :0 if:eth2(10.1.0.5) DIRECT MANUAL 

Obrázek 2: Zobrazení směrovací tabulky protokolu RIP směrovače R l 

Stisknutím ikony Run (nebo klávesou F5) spustíme simulaci, můžeme sledovat výpis 
poslaných zpráv, které můžeme vidět také v animaci. Také se zaměříme na proces vytváření 
záznamů ve směrovací tabulce. Pro rychlejší dokončení můžeme stisknout ikonu Express (F7). 

Po dokončení simulace se vytvoří soubory s výsledky ve složce results. Dvojklikem 
otevřeme jeden z nich a potvrdíme vytvoření souboru RIP.anf. V souborech s příponou .anf 
můžeme prohlížet výsledky provedených simulací, v záložce Browse Data máme na výběr 
z výsledků zobrazených vektorově v grafu a skalárně. 
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Pro zobrazení provozu směrovačů si otevřeme záložku Vectors » v poli statistic name 
filter vybereme txPk:vector(packetBytes). Zobrazí se nám přenos dat všech aktivních rozhraní 
na směrovacích. Dvoj klikem vykreslíme graf, na kterém můžeme vidět postupné budování a 
rozšiřování směrovací tabulky a následné rozesílání v pravidelných intervalech. 

Browse Data 
Here you can see all data that come from the files specified in the Inputs page. 

All 1835 / 835}] Vectors [IS / 149) [ scalars 1685 / 685) | Histograms 11 /~1)| 

runID filter • module filter ~ brPkvector(packetBytes) - S B 
Module Name CDJM Mean icauev variance Min Max rviin rime Max rime 
RIP2.Hl.etri[0].mac rxPkvector[packetBytes) 605 77.88429752066116 1.2685059434442505 1.6091073285533881 64.0 78,0 0.00000576 599.00000688 

RIP2.Rl.eth[0].mac txPkjvector(packetBytes) 14 70 42857142857143 4.972451580988421 24.725274725274247 64.0 74,0 0.00001162 484.00001162 

RIP2.Rl.eth[l].mac txPkjvector(packetBytes) 25 18176 52.82777047475443 2790.773333333336 64.0 210,0 2.744073751521 572.744084951521 

RIP2.Rl.eth[2].mac txPkjvector(packetBytes) 520 82.09354838709677 22.967511443251255 527.5065818958778 64.0 210,0 2.744129911521 599.00007578 

Rr?2.R2.er.h[l].mac txPkjvector(packetBytes) 24 187.25 47.22494734961504 2230.195652173913 64.0 210,0 2.964229321944 572.964240521944 

RIP2.R2.er.h[2].mac txPkjvector(packetBytes) 28 169.64285714285714 61.8769473532479 3828.756613756612 64.0 210,0 2.964285481944 572.964397481944 

Rr?2,R5.erh[Q].mac 

RIP2,R5.eth[l].mac 

RIP2,R3.erh[0].mac 

RIP2,R3.eth[l].mac 

RIP2,R4.eth[0].mac 

RIP2,R4.eth[2].mac 

RIP2,R4.eth[l].mac 

txPkjvector(packetBytes) 

txPkjvector(packetBytes) 

txPkjvector(packetBytes) 

txPkjvector(packetBytes) 

tiPkjvector(packetBytes) 

tiPkjvector(packetBytes) 

tiPkjvector(packetBytes) 

24 188,08333333333334 

23 190,6086956521739 

24 188,08333333333334 

23 190,6086956521739 

22 197,0 

22 197,0 

26 176,53846153846155 

45.96209843723005 

45.26059808630938 

45.96209843723005 

45.26059808630938 

42.0872110424691 

42.0872110424691 

62.31162380758874 

2112.514492753625 

204E.5217391304323 

2112.514492753625 

204E.5217391304323 

1771.3333333333333 

1771.3333333333333 

3882.73846153846 

64.0 210,0 

64.0 210,0 

64.0 210,0 

64.0 210,0 

64.0 210,0 

64.0 210,0 

64.0 210,0 

3.013823091889 

3.013823091889 

3.575953064857 

3.575953064857 

4.22133496045 

4.22133496045 

4.22139112045 

573.013834291889 

573.013834291889 

573.575964264857 

573.575964264857 

574.22134616045 

574.22134616045 

574.22150312045 

RIP2,R4.eth[3].mac tiPkjvector(packetBytes) 617 82,15235008103728 23.455044008393717 550.139089435686 64.0 210,0 4.22139112045 599.00014468 

RIP2,R2.eth[0].mac tiPkjvector(packetBytes) 596 77,88255033557047 1.2779832612163975 1.633241215949299 64.0 78,0 9.00015054 599.00015166 

RIP2.H2.eth[p].rnac b:Pkvector[packetBytes) 5 64,0 0.0 0.0 64.0 64,0 9.0001564 493.0001564 

Inputs[Browse Data] Datasets 

Obrázek 3: Zobrazení výsledků ve vektorové podobě 

Vypracování 2. část - OSPF 
Vytvoříme síť se stejnou topologií, ale nyní pro směrování použijeme protokol OSPF. 

Porovnáme směrovací tabulky a síťový provoz z výsledky předchozí simulace. 

Pro vytvoření sítě se směrovacím protokolem otevřeme soubor Network.ned a 
zkopírujeme celý kód popisující síť RIP. Ve zkopírované části změníme název sítě na network 
OSPF a přejmenujeme také všechny směrovače na OSPFRouter. 

Upravíme nastavení prvku LPv4NetworkConfigurator přidáním tohoto řádku: 

+ " < m u l t i c a s t - g r o u p hosts='R*' address='224.0.0.5 224.0.0.6' />" 

V souboru omnetpp.ini vytvoříme novou konfiguraci [Config OSPF] a do ní vložíme 
následující kód: 

network = OSPF 
. o s p f . o s p f C o n f i g = xmldoc("OSPF.xml") 
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Vytvoříme nový soubor s názvem OSPF.xml, ve kterém lze rozdělit síť na více OSPF 
oblastí a nastavit metriku jednotlivým linkám. 

<?xml v e r s i o n = " l . 0 " ? > 
<OSPFASConfig xmlns:xsi="http://www.w3.org/2 0 01/XMLSch 
xsi:schemaLocation="OSPF.xsd"> 

s r n a - i n s t a n c e " 

<!— A r e a s — > 
<Area id="0.0.0.0"> 

</Area> 

<!-- R o u t e r s --> 
<Router name="Rl" RFC1583Compatible="true"> 

< B r o a d c a s t I n t e r f a c e ifName="ethO" areaID="0. 0. 0. 0" 
i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 

< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 0" 
i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 

< P o i n t T o P o i n t I n t e r f a c e ifName="eth2" areaID= "0 . 0 . 0 . 0" 
i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 

< P o i n t T o P o i n t I n t e r f a c e ifName="eth3" areaID= "0 . 0 . 0 . 0" 
i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 

</Router> 

<Router name="R2" RFC1583Compatible="true"> 
< B r o a d c a s t I n t e r f a c e ifName="ethO" areaID="0. 0. 0. 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e ifName="eth2" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e ifName="eth3" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
</Router> 

<Router name="R3" RFC1583Compatible="true"> 
< P o i n t T o P o i n t I n t e r f a c e ifName="ethO" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 
</Router> 

<Router name="R4" RFC1583Compatible="true"> 
< P o i n t T o P o i n t I n t e r f a c e ifName="ethO" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
</Router> 

<Router name="R5" RFC1583Compatible="true"> 
< P o i n t T o P o i n t I n t e r f a c e ifName="ethO" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
</Router> 

</OSPFASConfig> 
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Nyní můžete spustit simulaci, porovnejte výsledky s poznatky, které jste získali 
sledováním protokolu RIP. Dále zobrazte graf přenášených dat na vybraném rozhraní, můžete 
na něm vidět periodické rozesílání hello paketů a vyšší aktivitu při inicializaci sítě, kdy 
směrovače shromažďují a navzájem si vyměňují informace o kompletní topologii sítě. Můžete 
vidět výrazně menší velikost hello zpráv oproti protokolu RIP, který rozesílá kompletní 
směrovací tabulku na všechna aktivní rozhraní směrovače. 

Vypracování 3. část - OSPF s rozdělením na oblasti 
Upravíme stávající síť rozdělením směrovačů do dvou oblastí, viz Obrázek 4. 
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Obrázek 4: Topologie s rozdělením na oblasti 

V souboru omnetpp.ini vytvoříme novou konfiguraci vložením kódu: [Config 
OSPF_areas], a do ní zapíšeme cestu k novému konfigurační souboru s názvem 
OSPF_areas.xml: 

extends = OSPF 
. o s p f . o s p f C o n f i g = xmldoc("OSPF_areas.xml") 

Tento soubor nyní vytvoříme a vložíme do něj následující kód. V něm jsou specifikovány 
dvě oblasti a nastavení jednotlivých rozhraní všech směrovačů. Kromě přiřazení rozhraní do 
požadované oblasti, lze nastavit i metriku linek. 

52 



<?xml v e r s i o n = " l . 0 " ? > 
<OSPFASConfig xmlns:xsi="http://www.w3.org/2 0 01/XMLSch s m a - i n s t a n c e " 
xsi:schemaLocation="OSPF.xsd"> 

<!— A r e a s — > 
<Area id="0.0.0.0"> 
</Area> 
<Area id="0.0.0.1"> 
</Area> 

<!-- R o u t e r s --> 
<Router name="Rl" RFC1583Compatible="true"> 

< B r o a d c a s t I n t e r f a c e ifName="ethO" areaID="0. 0. 0. 1" 
i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 

< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 1" 
i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 

< P o i n t T o P o i n t I n t e r f a c e ifName="eth2" areaID= "0 . 0 . 0 . 0" 
i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 

< P o i n t T o P o i n t I n t e r f a c e ifName="eth3" areaID= "0 . 0 . 0 . 1" 
i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 

</Router> 

<Router name="R2" RFC1583Compatible="true"> 
< B r o a d c a s t I n t e r f a c e ifName="ethO" areaID="0. 0. 0. 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e ifName="eth2" areaID= "0 . 0 . 0 . 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e ifName="eth3" areaID= "0 . 0 . 0 . 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
</Router> 

<Router name="R3" RFC1583Compatible="true"> 
< P o i n t T o P o i n t I n t e r f a c e ifName="ethO" areaID= "0 . 0 . 0 . 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 0 " /> 
</Router> 

<Router name="R4" RFC1583Compatible="true"> 
< P o i n t T o P o i n t I n t e r f a c e ifName="ethO" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
</Router> 

<Router name="R5" RFC1583Compatible="true"> 
< P o i n t T o P o i n t I n t e r f a c e ifName="ethO" areaID= "0 . 0 . 0 . 0" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
< P o i n t T o P o i n t I n t e r f a c e i f N a m e = " e t h l " areaID= "0 . 0 . 0 . 1" 

i n t e r f a c e O u t p u t C o s t = " 1 0 " /> 
</Router> 

</OSPFASConfig> 

Spusťte simulaci a porovnejte, jak se změní výsledné směrovací tabulky oproti OSPF síti 
bez rozdělení do oblastí. 
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Vypracování 4. část - Cesta sítí RIP vs. OSPF 
V obou vytvořených sítích nastavíme jednosměrný datový tok mezi koncovými 

stanicemi, na kterém lze sledovat zvolenou cestu v závislosti na typu a zvoleném nastavení 
použitého směrovacího protokolu. 

Do sekce General v konfiguračním souboru vložíme následující kód: 

n umU dpAp p s = 1 
H l udpApp[0] .typename = "UDPBasicApp" 
H l udpApp[0 ] . d e s t P o r t = 1234 
H l udpApp[0] .messageLength = 32 b y t e s 
H l udpApp[0 ] . s e n d l n t e r v a l = l s 
H l udpApp[0] . s t a r t T i m e = Os 
H l udpApp[0 ] .stopTime = t h i s . s t a r t T i m e + 600s 
H l udpApp[0] . d e s t A d d r e s s e s = "H2" 

H2 udpApp[0 ] .typename = "UDPSink" 
H2 udpApp[0] . l o c a l P o r t = 1234 

Tím zprovozníme j ednoduchý datový tok, který vysílá pakety s intervalem j edné sekundy 
od stanice H l ke stanici H2, pro lepší přehlednost jsou data přenášena pouze v tomto směru a 
bez potvrzování přijatých paketů (protokol UDP). 

Dále vytvoříme novou konfiguraci [Config RIP_vypadek_linky] a vložíme do ní odkaz 
na soubor se scénářem výpadku linky, Vypadek_linky.xml: 

extends = RIP 
* . s c e n a r i o M a n a g e r . s c r i p t = xmldoc("Výpadek l i n k y . x m l " ) 

Vytvoříme obdobnou konfiguraci [Config OSPF_vypadek_linky], s následujícím 
kódem: 

extends = OSPF 
* . s c e n a r i o M a n a g e r . s c r i p t = xmldoc("Výpadek l i n k y . x m l " ) 
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Vytvoříme soubor s názvem Vypadek_linky.xml a nastavíme v něm výpadek linky mezi 
směrovací R l a R2 v čase 200 sekund a opětovné obnovení spoje v čase 500 sekund. 

<scenario> 
<at t="200"> 

< d i s c o n n e c t src-module="R2" s r c - g a t e = " e t h g $ o [ 3 ] " /> 
<d i s c o n n e c t s r c - m o d u l e = " R l " s r c - g a t e = " e t h g $ o [ 3 ] " /> 

</at> 
<at t="500"> 

<connect s r c - m o d u l e = " R l " s r c - g a t e = " e t h g [ 3 ] " 
dest-module="R2" d e s t - g a t e = " e t h g [ 3 ] " 
channel-type="inet.common.mise.ThruputMeteringChannel"> 

<param name="delay" v a l u e = " 0 . l u s " /> 
<param name="datarate" value="100Mbps" /> 

</connect> 
</at> 

</scenario> 

Spustíme oba nově vytvořené scénáře s výpadkem linky a porovnáme je mezi sebou. 
Koncová stanice H l se snaží vysílat data ihned v čase 0, ale nejprve musí směrovače shromáždit 
informace o topologii sítě. V okně s výpisem zpráv spuštěné simulace lze vidět, v jakém čase 
se začnou doručovat první UDP pakety, neboli jak dlouho trvá sestavení směrovacích tabulek. 

Dále porovnáme volbu cesty sítí pro oba protokoly. V otevřené simulaci klikneme 
pravým tlačítkem myši na grafické zobrazení topologie » Animation Filter... » záložka 
Filtering » a zadáme následující podmínku: 

not UDPBasicAppData-* and className(inet::EthernetIIFrame) 

Tímto vyfiltrujeme všechna nechtěná data a v animaci se budou zobrazovat pouze pakety 
typu UDP pro snazší viditelnost směrování. 

Pro urychlení simulace můžete stisknout ikonu UNTIL (Ctrl+F5) » Simulation time to 
stop at: 200s » OK » EXPRESS (F7). Tím se v simulaci okamžitě posunete do času výpadku 
linky, po opětovném spuštění simulace normálním rychlostí můžete pozorovat, jak protokoly 
reagují na změněnou topologii. Pozorujte, jakou cestu volí protokol RIP a jakou OSPF po 
výpadku linky a co způsobuje odlišné chování v simulované síti. 

Potom se můžete přesunout na čas 500s, opět pozorujte jakým způsobem a v jakém čase 
se jednotlivé směrovací protokoly reagují na změnu. 
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Vypracování 5. část - Cesta sítí OSPF s rozdělením na oblasti 

Do scénáře [Config OSPF_oblasti] přidáme naplánovaný výpadek linky: 

* . s c e n a r i o M a n a g e r . s c r i p t = xmldoc("Výpadek l i n k y . x m l " ) 

Spustíme tento scénář a po proběhnutí simulace do času výpadku linky (200s) můžeme 
vidět, že pakety jsou směrovány jinou trasou než v případě sítě s jedinou oblastí, jelikož 
směrovače preferují cestu bez přecházení do jiných oblastí 

Otázky: 
1. Jak často posílají směrovače s protokolem RTP aktualizace a co je jejich obsahem? 

2. Jak se změní obsah směrovací tabulky směrovačů s OSPF při rozdělení sítě na 
menší oblasti? 

3. Co je rozhodujícím faktorem pro volbu cesty sítí pro RTP vs. OSPF? 
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B. Laboratorní úloha č.2 - Zajištění kvality služeb 

Cílem této laboratorní úlohy je srovnání různých mechanizmů řízeného odesílání paketů 
a jejich vlivu na parametry definující kvalitu síťového přenosu (zpoždění, proměnlivost 
zpoždění, ztrátovost paketů). K simulaci poslouží jednoduchá síť slinkou poskytující 
nedostatečnou šířku pásma pro definovaný provoz a koncové stanice současně generující FTP 
datový přenos a VOIP hovor. Zapojení topologie sítě lze vidět na obrázku 1. 

FTP client 
.1/30 

1 pppo pppO I 
1 10.0.0.17/30 10.0.0.18/30 1 

routei 

VOIP client VOIP client? 

Obrázek 1: Zapojení topologie sítě 

1. Teoretický úvod 

Vzhledem ke stále se zvětšujícímu množství síťových služeb s odlišnými požadavky na 
parametry přenosu, hrozí riziko vysokého vytížení komunikačních linek a bez řízení úrovně 
kvality by bylo velmi omezeno využití určitých služeb, zejména těch pracujících v reálném 
čase, jejichž hlavním požadavkem je nízké časové zpoždění a jeho kolísání (jitter). Naopak pro 
většinu datových služeb je hlavním požadavkem co nej nižší ztrátovost či chybovost paketů a 
propustnost. Proto bylo nutné zavedení mechanizmů rozlišování typů služeb podle jejich 
typických požadavků a zajištění odlišných úrovní kvality služeb. 

Pro zajištění kvality služeb je základním požadavkem rozlišení toku dat do tříd, podle 
typu dat zdrojových aplikací. Poté je pro každou třídu definováno odlišné zacházení, 
mechanizmus pro zajištění kvality služeb je označován pojmem QoS - Quality of Service. Ten 
také zajišťuje dohled nad síťovým provozem, aktivní správu front jednotlivých tříd, plánuje 
odesílání paketů a upravuje provoz pro lepší využití dostupné kapacity komunikační linky. 
Základním mechanizmem je fronta FIFO, která neposkytuje řízení odesílání, tzv. služba „Best-
Effort", zástupci pokročilejších systému jsou PQ (prioritní systém front) nebo WFQ (systém 
front s váženou spravedlivou obsluhou). Tyto tři mechanizmy porovnáte v laboratorní úloze. 
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2. Vypracování 

Založení nového projektu 
Spustíme program omnetpp.exe. Pokud se objeví nabídka pro vybrání pracovního 

adresáře, tento formulář potvrdíme beze změny (vybraná cesta musí být: omnetpp-4.6\samples), 
jinak vytvořený projekt nebude fungovat. 

K vytvoření nového projektu klikneme na File » New » OMNeT++ Project... Projekt 
pojmenujeme V U T loginem, dále stiskneme Next » Empty project » Finish. V okně Project 
Explorer se vytvořila námi poj menovaná složka, ve které budou uloženy všechny části proj ektu. 
Nejprve je zapotřebí přiřadit k projektu odkazy na zdrojové soubory, se kterými se bude dále 
pracovat. To provedeme kliknutím pravým tlačítkem na vytvořenou složku » Properties » 
Project References » vybereme položku inet» OK. 

Pro vytvoření projektu jsou zapotřebí dva základní soubory. Network Description File, 
s příponou .ned, který definuje topologii sítě, použité technologie a síťové prvky. Druhým je 
Initialization File, přípona .ini, který určuje průběh a parametry simulace. 

Klikněte pravým tlačítkem myši na vaši složku a vyberte New » Network Description 
File (NED), pojmenujte j i Network.ned » Next » Empty NED File » Finish. 

V souboru NED lze pracovat ve dvou režimech, v grafickém nebo kódovém. Mezi nimi 
se lze přepínat v levém dolním rohu volbou Design/Source. Jsou navzájem propojené, pokud 
tedy přidáme prvky sítě z palety, vytvoří se k nim patřičný kód a naopak vložením kódu lze 
vytvářet celou síť. 

Vypracování 1. část - FIFO 
Nejprve musíme importovat do projektu prvky, se kterými se bude pracovat. Do souboru 

Network.ned vložíme následující kód: 

import i n e t . n e t w o r k l a y e r . c o n f i g u r a t o r . i p v 4 . I P v 4 N e t w o r k C o n f i g u r a t o r ; 
import i n e t . n o d e . i n e t . R o u t e r ; 
import i n e t . n o d e . i n e t . S t a n d a r d H o s t ; 
import i n e t . c o m m o n . m i s e . T h r u p u t M e t e r i n g C h a n n e l ; 

Vytvoříme síť pojmenovanou DiffservNetwork, složenou ze čtyř prvků StandardHost, 
které poslouží jako stanice generující provoz v síti. Nazveme je FTP_client, FTP_server a 
VOIP_clientl, VOIP_client2. Budeme tedy sledovat diferencování prostředků služeb pro FTP 
přenos a pro VOIP hovor. Spojení mezi stanicemi je realizováno dvěma směrovací, 
propojenými technologií PPP s nedostačující přenosovou rychlostí. Na PPP portu routeru 1 tedy 
bude docházet k nadměrným požadavkům na zatížení sítě a bude na něm možné sledovat 
vlastnosti různých systému pro řízení kvality služeb. 
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Nyní vytvoříme přenosové kanály a definujeme jejich parametry. Všechny stanice v síti 
jsou připojeny ke směrovačům technologií ethernet s přenosovou rychlostí 10Mbit/s a se 
zpožděním 0,1 us. Pro spojení mezi směrovací vytvoříme kanál PPP s přenosovou rychlostí 
IMbit/s. Pro vytvoření kanálů zvolíme typ ThruputMeteringChannel, který umožňuj e zobrazení 
požadovaného parametru přímo v grafickém režimu simulace. Nastavíme ho na zobrazení 
počtu přenesených paketů. 

network D i f f s e r v N e t w o r k 
{ 

parameters: 
@display("bgb=64 4, 329") ; 

types: 
channel PPP extends T h r u p u t M e t e r i n g C h a n n e l 
{ 

d e l a y = normal(0.004s , 0.0018s); 
d a t a r a t e = 1Mbps; 
t h r u p u t D i s p l a y F o r m a t = "#N"; 

} 

channel e t h e r n e t l i n e extends T h r u p u t M e t e r i n g C h a n n e l 
{ 

d e l a y = 0 . l u s ; 
d a t a r a t e = 10Mbps; 
t h r u p u t D i s p l a y F o r m a t = "#N"; 

} 

submodules: 
F T P _ c l i e n t : S t a n d a r d H o s t { 

Sdisplay("p=552,62"); 
} 

c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 
@display("p=316,42"); 

} 

F T P _ s e r v e r : S t a n d a r d H o s t { 
Sdisplay("p=8 9,62"); 

} 

V O I P _ c l i e n t : S t a n d a r d H o s t { 
Sdisplay("p=89,255"); 

} 

V O I P _ c l i e n t 2 : S t a n d a r d H o s t { 
Sdisplay("p=546,255"); 

} 

r o u t e r l : R o u t e r { 
Sdisplay("p=22 6,163"); 

} 

r o u t e r 2 : R o u t e r { 
Sdisplay("p=421,163"); 

} 

Pro konfiguraci síťové adresace slouží prvek IPv4NetworkConfigurator, pokud necháme 
jeho nastavení na původních parametrech, přiřadí se IP adresy v celé síti automaticky. 
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K dokončení návrhu už zbývá pouze propojit prvky sítě. Jedná se o plně duplexní spojení 
s parametry kanálů z předchozího bodu. 

connections 
r o u t e r 2 ethg++ <--> e t h e r n e t l i n e <--> FTP c l i e n t . e t h g + + ; 
r o u t e r 2 ethg++ <--> e t h e r n e t l i n e <--> VOIP c l i e n t 2 . e t h g + + ; 
r o u t e r l ethg++ <--> e t h e r n e t l i n e <--> VOIP c l i e n t . e t h g + + ; 
r o u t e r l ethg++ <--> e t h e r n e t l i n e <--> FTP server.ethg++; 
r o u t e r 2 pppg++ <--> PPP <—> r o u t e r l .pppg++;} 

Tímto je vámi vytvořená síť kompletně zprovozněna k provádění simulací, nyní tedy 
musíme určit parametry a průběh simulace. Jelikož soubor NED je statický, je vhodné v něm 
definovat pouze základní parametry, které nebudeme dále měnit ani nijak upravovat. Pro 
nastavení průběhu simulace a síťového provozu slouží konfigurační soubor s příponou .ini. 

Do složky s projektem vytvoříme nový soubor, New » Initialízation File (ini) » název 
můžeme ponechat, omnetpp.ini » Next » Empty Ini File » Finish. 

Doplníme název sítě, ke které chceme konfigurační soubor přiřadit (network = 
DiffservNetwork). Pod něj vložíme následující kód: 

d e b u g - o n - e r r o r s = true 
t k e n v - p l u g i n - p a t h = . . / i n e t / e t c / p l u g i n s 
s i m - t i m e - l i m i t = 300s 

Tím povolíme výpis problému při chybně nastavené simulaci, nastavíme cestu 
k potřebným doplňkům a nastavíme maximální trvání simulace na 5 minut. 

Pro potřeby simulace j e možné v j ednom souboru vytvářet několik různých konfigurací, 
k vybrání požadované budeme vyzvání po spuštění simulace. Pro vytvoření nové konfigurace 
se používá syntaxe [Config nazevkonfigurace]. Hlavní částí je sekce [General], která obsahuje 
nastavení společná pro všechny vytvořené konfigurace, jejím nastavením začneme. 
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Nadefinujeme FTP klienta a FTP server: 

FTP s e r v e r numTcpApps = 1 
FTP s e r v e r t c p A p p [ 0 ] . typename = " T C P B a s i c C l i e n t A p p " 
FTP s e r v e r t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "FTP c l i e n t " 
FTP s e r v e r t c p A p p [ 0 ] . c o n n e c t P o r t = 20 
FTP s e r v e r t c p A p p [ 0 ] . t h i n k T i m e = 0.001s 
FTP s e r v e r t c p A p p [ 0 ] . i d l e l n t e r v a l = 0.001s 
FTP s e r v e r t c p A p p [ 0 ] . s t a r t T i m e = 0s 
FTP s e r v e r t c p A p p [ 0 ] . r e q u e s t L e n g t h = 5MiB 
FTP s e r v e r t c p A p p [ 0 ] . n u m RequestsPerSession = 1 
FTP s e r v e r t c p A p p [ 0 ] . r e c o n n e c t l n t e r v a l = I s 

FTP c l i e n t numTcpApps = 1 
FTP c l i e n t t c p A p p [ 0 ] . typename = "TCPGenericSrvApp" 
FTP c l i e n t t c p A p p [ 0 ] . l o c a l P o r t = 20 

Nadefinujeme provedení VOLP hovoru s dobou trvání 100 sekund: 

**.VOIP_client*.numUdpApps = 1 
** . V O I P _ c l i e n t . u d p A p p [ * ] . t y p e n a m e = "SimpleVoIPSender" 
* * . V O I P _ c l i e n t . u d p A p p [ * ] . d e s t A d d r e s s = " V O I P _ c l i e n t 2 " 
* * . V O I P _ c l i e n t . u d p A p p [ 0 ] . d e s t P o r t = 2000 
#**.VOIP_client.udpApp[l].destPort = 2001 
* * . V O I P _ c l i e n t . u d p A p p [ * ] . s t a r t T i m e = Os 
* * . V O I P _ c l i e n t . u d p A p p [ * ] . s t o p T i m e = 100s 
* * . V O I P _ c l i e n t . u d p A p p [ * ] . t a l k P a c k e t S i z e = 500B 
**.VOIP c l i e n t . u d p A p p [ * ] . p a c k e t i z a t i o n l n t e r v a l = 5ms 

**. V O I P _ c l i e n t 2 . u d p A p p [ * ] . t y p e n a m e = " S i m p l e V o I P R e c e i v e r " 
* * . V O I P _ c l i e n t 2 . u d p A p p [ 0 ] . l o c a l P o r t = 2000 
#**.V0IP_client2.udpApp[1].localPort = 2001 

Dále vytvoříme novou konfiguraci - [Config FIFO], ve které nastavíme typ fronty FLFO 
pro směrovače a kapacitu 80 paketů. Při překročení této hranice jsou všechny nově příchozí 
pakety zahazovány. 

[ C o n f i g FIFO] 
**. r o u t e r * . p p p [ 0] .queueType = "DropTailQueue" 
* * . r o u t e r * . p p p [ 0 ] . q u e u e . f r a m e C a p a c i t y = 80 
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Vypracování 2. část - PQ 
Vytvoříme další konfiguraci [Config PQ], ve které nastavíme mechanizmus zacházení 

s pakety pomocí prioritních front. Vložíme do ní následující kód, ve kterém je potřeba upravit 
cestu k odkazovaným souborům (ingressTCType a queueType) podle názvu projektu: 

[ C o n f i g PQ] 
d e s c r i p t i o n = P r i o r i t y queueing 
* * . r o u t e r l . * . i n g r e s s T C T y p e = "název p r o j e k t u . T r a f f i c C o n d i t i o n e r " 
* * . i n g r e s s T C . c l a s s i f i e r . f i l t e r s = x m l d o c ( " f i l t e r s . x m l " ) 
* * . r o u t e r l . * . q u e u e T y p e = "název projektu.PQQueue" 

Tím j sme na vstupní rozhraní routeru 1 nastavili mechanizmus pro značkování provozu 
TrafficConditioner, tento soubor nyní vytvoříme a nastavíme jeho parametry. New » Network 
Description File (NED), soubor pojmenujeme TrafficConditioner.ned » Next» Empty NED 
File » Finish. Do nově vytvořeného vložíme následující kód, který umožní rozdělení datového 
toku do tříd, podle kterých přidělí příchozím paketům odpovídající označení: 

import i n e t . l i n k l a y e r . c o n t r a c t . I T r a f f i c C o n d i t i o n e r ; 
import i n e t . n e t w o r k l a y e r . d i f f s e r v . D S C P M a r k e r ; 
import i n e t . n e t w o r k l a y e r . d i f f s e r v . M u l t i F i e l d C l a s s i f i e r ; 

module T r a f f i c C o n d i t i o n e r l i k e I T r a f f i c C o n d i t i o n e r 
{ parameters: 

S d i s p l a y ( " i = b l o c k / c l a s s i f i e r " ) ; 
gates: 

input i n ; 
output o u t ; 

submodules: 
c l a s s i f i e r : M u l t i F i e l d C l a s s i f i e r { 

Sdisplay("p=61,110"); } 
marker: DSCPMarker { 

dscps = "EF AF11 AF21 AF31 AF41 BE"; 
Sdisplay("p=192, 110") ; } 

connections: 
i n --> c l a s s i f i e r . i n ; 
f o r i = l . . 5 { c l a s s i f i e r . o u t s + + --> marker.in++;} 
c l a s s i f i e r . d e f a u l t O u t --> marker.in++; 
marker.out --> o u t ; 

} 

Nyní vytvoříme soubor, ve kterém definujeme systém prioritní fronty, New » Network 
Description File (NED), soubor pojmenujeme PQQueue.ned » Next » Empty NED File » 
Finish. Prioritní fronta je zapojena na výstupu směrovače, pakety se řadí do jednotlivých front 
podle přiřazené značky a na výstupní port se posílá přednostně fronta s nejvyšší prioritou (EF). 
Mechanizmus je popsán následujícím kódem, který vložíme do souboru PQQueue.ned. 
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import inet.common.queue.DropTailQueue; 
import i n e t . l i n k l a y e r . c o n t r a c t . I T r a f f i c C o n d i t i o n e r ; 
import i n e t . c o m m o n . q u e u e . P r i o r i t y S c h e d u l e r ; 
import i n e t . n e t w o r k l a y e r . d i f f s e r v . B e h a v i o r A g g r e g a t e C l a s s i f i e r ; 
import i n e t . n e t w o r k l a y e r . d i f f s e r v . D S C P M a r k e r ; 
import i n e t . n e t w o r k l a y e r . d i f f s e r v . M u l t i F i e l d C l a s s i f i e r ; 
import inet.common.queue.IOutputQueue; 

module PQQueue l i k e IOutputQueue 
{ parameters: 

i n t f r a m e C a p a c i t y = d e f a u l t ( 2 0 ) ; 
@display("bgb=661, 722") ; 

gates: input i n ; 
output o u t ; 

types: 
submodules: 

efQueue: DropTailQueue { 
f r a m e C a p a c i t y = 50; 
Sdisplay("p=365, 91") ; } 

a f l x Q u e u e : DropTailQueue { 
f r a m e C a p a c i t y = 10; 
Sdisplay("p=365,2 0 0 " ) ; 

af2xQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
@display("p=365,305"); 

af3xQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
@display("p=365, 397") ; 

af4xQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
@display("p=365, 513") ; 

beQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
Sdisplay("p=365,604"); 

p r i o r i t y : P r i o r i t y S c h e d u l e r { 
@display("p=574,337"); 

dscpMarker: DSCPMarker { 
dscps = "EF"; 
Sdisplay("p=216,123"); 

d s c p M a r k e r l : DSCPMarker { 
dscps = "AF11"; 
Sdisplay("p=216,211"); 

dscpMarker2: DSCPMarker { 
dscps = "AF21"; 
Sdisplay("p=216,287"); 

ds c p M a r k e r 3 : DSCPMarker { 
dscps = "AF31"; 
@display("p=217,3 61") ; 

dscpMarker4: DSCPMarker { 
dscps = "AF41"; 
@display("p=217,439"); 

dscp M a r k e r 5 : DSCPMarker { 
dscps = "BE"; 
@display("p=216, 525") ; 

C l a s s i f i e r : B e h a v i o r A g g r e g a t e C l a s s i f i e r { 
dscps = "EF AF11 AF21 AF31 AF41"; 
@display("p=55,326"); } 
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Nakonec ještě vložíme kód popisující propojení vložených prvků: 

connections: 
i n --> C l a s s i f i e r . i n ; 
C l a s s i f i e r . o u t s + + --> dscpMarker.in++; 
C l a s s i f i e r . o u t s + + --> d s c p M a r k e r l . i n + + ; 
C l a s s i f i e r . o u t s + + --> dscpMarker2.in++; 
C l a s s i f i e r . o u t s + + --> dscpMarker3.in++; 
C l a s s i f i e r . o u t s + + --> dscpMarker4.in++; 
C l a s s i f i e r . d e f a u l t O u t --> dscpMarker5.in++; 
d s c p M a r k e r . o u t --> e f Q u e u e . i n ; 
d s c p M a r k e r l . o u t --> a f l x Q u e u e . i n ; 
d s c p M a r k e r 2 . o u t --> a f 2 x Q u e u e . i n ; 
d s c p M a r k e r 3 . o u t --> a f 3 x Q u e u e . i n ; 
d s c p M a r k e r 4 . o u t --> a f 4 x Q u e u e . i n ; 
d s c p M a r k e r 5 . o u t --> beQueue.in; 
efQueue.out --> p r i o r i t y . i n + + ; 
a f l x Q u e u e . o u t --> p r i o r i t y . i n + + ; 
af2xQueue.out --> p r i o r i t y . i n + + ; 
af3xQueue.out --> p r i o r i t y . i n + + ; 
af4xQueue.out --> p r i o r i t y . i n + + ; 
beQueue.out --> p r i o r i t y . i n + + ; 
p r i o r i t y . o u t --> o u t ; 

} 

Vypracování 3. část - WFQ 
Soubor uložíme a přepneme se zpět do konfiguračního souboru omnetpp.ini. Vytvoříme 

další konfiguraci [Config WFQ] a vložíme kód pro zavedení mechanizmu WFQ na routerl: 

[ C o n f i g WFQ] 
d e s c r i p t i o n = Weighted f a i r q u e u eing 
* * . r o u t e r l . * . i n g r e s s T C T y p e = "nazev p r o j e k t u . T r a f f i c C o n d i t i o n e r " 
* * . i n g r e s s T C . c l a s s i f i e r . f i l t e r s = x m l d o c ( " f i l t e r s . x m l " ) 
* * . r o u t e r l . * . q u e u e T y p e = "nazev projektu.WFQueue" 
* * . r o u t e r l . * * . w r r . w e i g h t s = "12~2 0 0 0 1" 

Tím jsme nastavili značkování příchozích paketů na routeru 1, podle přidělené značky 
jsou posílány do odpovídající fronty, pro které se parametrem „weights" nastavuje jejich 
váhový koeficient, který funguje na principu přidělování tokenů jednotlivým třídám v počtu 
odpovídající váhám a jeden token odpovídá jednomu odeslanému paketu. První číslo je pro 
frontu s nejvyšší prioritou (EF), kterou přiřadíme pro přenos hovoru VOIP. Druhé číslo je pro 
frontu s přenosem souboru FTP a poslední číslo je pro základní třídu (BE), do které patří 
neoznačkovaný datový provoz. 
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Vytvoříme nový soubor WFQueue.ned, který reprezentujte systém váhových front na 
výstupním portu směrovače: 

import inet.common.queue.DropTailQueue; 
import inet.common.queue.IOutputQueue; 
import i n e t . c o m m o n . q u e u e . P r i o r i t y S c h e d u l e r ; 
import inet.common.queue.WRRScheduler; 
import i n e t . n e t w o r k l a y e r . d i f f s e r v . B e h a v i o r A g g r e g a t e C l a s s i f i e r ; 

module WFQueue l i k e IOutputQueue 
{ parameters: 

i n t f r a m e C a p a c i t y = d e f a u l t ( 2 0 ) ; 
gates: input i n ; 

output o u t ; 
submodules: 

c l a s s i f i e r : B e h a v i o r A g g r e g a t e C l a s s i f i e r { 
dscps = "EF AF11 AF21 AF31 AF41"; 
Sdisplay("p=41, 2 8 4") ; } 

efQueue: DropTailQueue { 
f r a m e C a p a c i t y = 100; 
Sdisplay("p=195,95"); } 

af l x Q u e u e : DropTailQueue { 
f r a m e C a p a c i t y = 10; 
Sdisplay("p=195,224"); } 

af2xQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
@display("p=195, 329") ; } 

af3xQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
@display("p=195,421"); } 

af4xQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
@display("p=195,537"); } 

beQueue: DropTailQueue { 
f r a m e C a p a c i t y = f r a m e C a p a c i t y ; 
Sdisplay("p=195, 628") ; } 

wrr: WRRScheduler { 
@display("p=384, 368") ; } 

connections: 
i n --> c l a s s i f i e r . i n ; 
c l a s s i f i e r . o u t s + + --> e f Q u e u e . i n ; 
c l a s s i f i e r . o u t s + + --> a f l x Q u e u e . i n ; 
c l a s s i f i e r . o u t s + + --> af 2 x Q u e u e . i n ; 
c l a s s i f i e r . o u t s + + --> af 3 x Q u e u e . i n ; 
c l a s s i f i e r . o u t s + + --> af 4 x Q u e u e . i n ; 
c l a s s i f i e r . d e f a u l t O u t --> beQueue.in; 
efQueue.out --> wrr.in++; 
a f l x Q u e u e . o u t --> wrr.in++; 
af2xQueue.out --> wrr.in++; 
af3xQueue.out --> wrr.in++; 
af4xQueue.out --> wrr.in++; 
beQueue.out --> wrr.in++; 
w r r . o u t --> o u t ; 
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Nyní už zbývá jen rozdělení síťového provozu do požadovaných tříd, vytvoříme nový 
soubor New » File » s názvem filters.xml a vložíme do něj následující podmínky: 

< f i l t e r s > 
< f i l t e r d e s t P o r t = " 2 0 0 0 " gate="0"/> 
< f i l t e r d e s t P o r t = " 2 0 " gate="l"/> 

< / f i l t e r s > 

Rozdělení zapsané v souboru filters.xml je použito pro oba mechanizmy řízení odesílání, 
forma zápisu je jednoduchá, brána 0 označuje data s nej vyšší prioritou. Přiřazení datového toku 
probíhá podle cílového portu (port 2000 využívá VOIP hovor), jako přiřazovací parametr lze 
použít i zdrojový port, zdrojovou nebo cílovou adresu, protokol a podobně. 

3. Simulace projektu 

Před prvním spuštěním simulace ještě musíme sestavit projekt, kliknutím pravým 
tlačítkem myši na vaši složku » Build Configurations » Build Selected... » zaškrtneme gcc-
debug » OK. 

Po dokončení operace je projekt připraven k simulaci, kliknutím pravým tlačítkem myši 
na soubor omnetpp.ini » Run As » OMNeT++ Simulation » z kontextové nabídky vybereme 
požadovanou konfiguraci. 

Stisknutím ikony Run (nebo klávesou F5) se simulace spustí, v s simulačním okně 
probíhá výpis poslaných zpráv, které se zobrazují také v animaci sítě. U každého spoje je po 
spuštění simulace číselná hodnota, která vypisuje počet přenesených paketů. Pro rychlejší 
dokončení lze stisknout ikonu Express (F7). Pro změnu výběru simulovaného scénáře není 
zapotřebí otevírat nové okno simulace, stačí stisknout nabídku File » Set Up a Configuration 
a vybrat požadovaný scénář. 

Po dokončení simulace se zobrazí výpis trvání v sekundách, tato doba odpovídá době 
potřebné k dokončení přenosu souboru pomocí FTP, hodnotu porovnáme pro všechny scénáře. 

Po dokončení všech simulací se přesuneme do složky results, kde se uložili soubory 
s výsledky. Dvoj klikem otevřeme libovolný soubor pro každý scénář a potvrdíme vytvoření 
souboru s příponou .anf, nabízené jméno ponecháme. V souborech s příponou .anf můžeme 
prohlížet výsledky provedených simulací, v záložce Browse Data máme na výběr z výsledků 
zobrazených vektorově v grafu a skalárními hodnotami. 

Zobrazíme si statistiku zpoždění VOIP aplikace. Vectors » v poli statistic name filter 
vybereme endToEndDelayrvector. Zjistíme průměrnou hodnotu zpoždění (sloupec Mean) 
a jitter (StdDev). Kliknutím pravým tlačítkem myši » Plot, můžeme zobrazit průběh zpoždění 
v grafické podobě. Porovnáme tyto parametry pro všechny tři scénáře. 

Dále si zobrazíme statistiku obousměrného zpoždění FTP paketů. Vectors » v poli 
statistic name filter vybereme smoothed RTT. Opět porovnáme pro všechny tři scénáře. 

66 



Zobrazíme počet zahozených paketů. Scalars » v poli statistic name filter vybereme 
dropPkrcount, opět porovnáme. U výsledků PQ a WFQ můžeme vidět, počet zahozených 
paketů jednotlivých front a tím i typ třídy síťového provozu. 

Zkuste měnit nastavení váhových koeficientů WFQ a pozorujte, jak se změní parametry 
přenosu, například nastavením vah na 1 1 1 1 1 1 se nastaví systém FQ se spravedlivou obsluhou 
všech front. 

Zapněte generování druhého VOIP hovoru (nemusíte dopisovat kód, stačí smazat znaky 
komentáře „#" v souboru omnetpp.ini), vytvořte pro něj značkování (v souboru filters.xml pro 
cílový port 2001) a sledujte vliv na kvalitu přenosu. 

Otázky: 
1. Jaký způsob řízení odesílání paketů umožňuje fronta FIFO? 

2. Jaký vliv mají váhová čísla na řízení odesílání paketů mechanizmem WFQ? 

3. Proč docházelo u mechanizmů PQ a WFQ k zahazování paketů? A proč se 
zahazovaly pouze pakety FTP přenosu? 
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C. Laboratorní úloha č.3 - WLAN vs. Ethernet 

Cílem laboratorní úlohy je srovnání v současnosti nejvyužívanějších technologií 
k realizaci počítačových sítí, kabelové spojení technologií ethernet dle standardu IEEE 802.3 a 
spojení bezdrátové, využívající k přenosu radiový signál, dle standardu IEEE 802.11. Úloha 
srovnává parametry přenosu dat v obou technologiích a zaměřuje se také na přenos řídících dat 
potřebných k navázání a udržení spojení. Dále se blíže sledují možnosti bezdrátové sítě, 
například podpora pro řízení kvality služeb a vliv vzdálenosti na chybovost přenášených dat. 
K simulaci je využito jednoduché zapojení dvou navzájem komunikujících klientů pomocí 
přístupového bodu, respektive přepínače. Topologii bezdrátové sítě lze vidět na obrázku 1. 
Zapojení sítě ethernet lze vidět na obrázku 2. 

wirelessHostl accessPoint wirelessHost2 

J Í -

i ' 
radioMediurn configurator 

Obrázek 1: Topologie bezdrátové sítě 

& fiJL— & 
hosti clients witch host2 

i ' 
configurator 

Obrázek 2: Topologie kabelové sítě 
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1. Teoretický úvod 

Síť Ethernet byla vyvinuta v roce 1973 spolčeností Xerox, přenosová rychlost byla 
2,94 Mbit/s a spojení probíhalo pouze pomocí koaxiálního kabelu v poloduplexním módu. 
Ethernet procházel dalším vývojem a byl uveden pod standardem IEEE 802.3, který byl během 
let mnohokrát modifikován a v současnosti existuje celá řada standardů rozvíjející původní 
návrh. Bylo dosaženo podstatných vylepšení, zejména přenosové rychlosti, která dosahuje až 
100 Gbit/s a obousměrné komunikace v plně duplexním módu. Provedení kabelu může být 
pomocí optovláken a přenos je uskutečněn pomocí světelného záření. Nebo metalickými 
kabely, nej používanej šíje nestíněná kroucená dvoulinka s označením UTP, kde jsou jednotlivé 
bity reprezentovány elektrickými signály. Jako konektor se standardně používá osmi-pinový 
typ RJ-45, který poskytuje dvojici vodičů pro vysílání v obou směrech. Standard IEEE 802.3 
kromě fyzické vrstvy popisuje také vrstvu spojovou, která je druhou vrstvou referenčního 
modelu ISO/OSI. Datová jednotka na této vrstvě se nazývá rámec a má pevně definovanou 
strukturu. Minimální velikost rámce je 64B a maximální velikost 1518B a musí obsahovat pole 
s cílovou a zdrojovou fyzickou adresa. Část obsahující přenášená data může mít velikost v 
rozsahu od 46B-1500B, při menší velikost dat musí být použita výplň k doplnění do 46B, aby 
byla dosaženo minimální velikosti rámce. 

Vývoj standardu IEEE 802.11 definující bezdrátové sítě započal v roce 1997, maximální 
přenosová rychlost se rovnala 2 Mbit/s, v této podobě se dnes již nepoužívá. Opět docházelo 
k dalšímu vývoji a bylo vydáno několik dalších standardů, které výrazně vylepšují přenosovou 
rychlost (až 866,7 Mbit/s se standardem 802.1 lac) a zavádí nové technologie, například MPMO, 
tato technologie umožňuje současný přenos několika vysílacích i přijímacích antén na různých 
kanálech a tím je možné ještě několikanásobně zvýšit přenosovou rychlost. Bezdrátové sítě 
nabízí oproti sítím kabelovým výhodu ve snadné tvorbě a modifikaci topologie sítě, lze přidávat 
nebo odpojovat stanice ze sítě bez fyzického zásahu a je umožněno také připojení mobilních 
klientů. Bezdrátové sítě musí nutně obsahovat implementaci metod řízení k přístupovému 
médiu, tou je standardně metoda C S M A / C A , která snižuje riziko kolizí při současném vysílání 
více stanic. Radiový signál je vysílán volně šířen prostorem a zprávy jsou tak přijímány všemi 
stanicemi v dosahu vysílače a stanice, pro které nejsou data určena, je zahazují. Tím dochází ke 
snížení teoretické propustnosti přenosového kanálu. 

2. Vypracování 

Založení nového projektu 
Spustíme program omnetpp.exe. Pokud se objeví nabídka pro vybrání pracovního 

adresáře, tento formulář potvrdíme beze změny (vybraná cesta musí být: omnetpp-4.6\samples), 
jinak vytvořený projekt nebude fungovat. 

K vytvoření nového projektu klikneme na File » New » OMNeT++ Project... Projekt 
pojmenujeme V U T loginem, dále stiskneme Next » Empty project » Finish. V okně Project 
Explorer se vytvořila námi poj menovaná složka, ve které budou uloženy všechny části proj ektu. 
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Nejprve je zapotřebí přiřadit k projektu odkazy na zdrojové soubory, se kterými se bude dále 
pracovat. To provedeme kliknutím pravým tlačítkem na vytvořenou složku » Properties » 
Project References » vybereme položku inet» OK. 

Pro vytvoření projektu jsou zapotřebí dva základní soubory. Network Description File, 
s příponou .ned, který definuje topologii sítě, použité technologie a síťové prvky. Druhým je 
Initialization File, přípona .ini, který určuje průběh a parametry simulace. 

Klikněte pravým tlačítkem myši na vaši složku a vyberte New » Network Description 
File (NED), pojmenujte j i Network.ned » Next » Empty NED File » Finish. 

V souboru NED lze pracovat ve dvou režimech, v grafickém nebo kódovém. Mezi nimi 
se lze přepínat v levém dolním rohu volbou Design/Source. Jsou navzájem propojené, pokud 
tedy přidáme prvky sítě z palety, vytvoří se k nim patřičný kód a naopak vložením kódu lze 
vytvářet celou síť. 

Vypracování 1. část - Zahájení komunikace a řídící data WLAN sítě 
Nejprve musíme importovat do projektu prvky, se kterými se bude pracovat. Do souboru 

Network.ned vložíme následující kód: 

import i n e t . n e t w o r k l a y e r . c o n f i g u r a t o r . i p v 4 . I P v 4 N e t w o r k C o n f i g u r a t o r ; 
import i n e t . n o d e . e t h e r n e t . E t h e r S w i t c h ; 
import i n e t . n o d e . i n e t . S t a n d a r d H o s t ; 
import i n e t . p h y s i c a l l a y e r . c o n t r a c t . p a c k e t l e v e l . I R a d i o M e d i u m ; 
import n e d . D a t a r a t e C h a n n e l ; 
import i n e t . n o d e . i n e t . W i r e l e s s H o s t ; 
import i n e t . n o d e . w i r e l e s s . A c c e s s P o i n t ; 
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Vytvoříme síť pojmenovanou WirelessNetwork, která bude obsahovat dva klienty, 
komunikující pomocí bezdrátového přístupového bodu. 

network W i r e l e s s N e t w o r k 
{ 

parameters: 
gdisplay("bgb=600, 200") ; 
s t r i n g radioMediumType; 

submodules: 
c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 

Sdisplay("p=550,150"); 
} 

radioMedium: <radioMediumType> l i k e IRadioMedium { 
Sdisplay("p=450,150"); 

} 

w i r e l e s s H o s t 2 : W i r e l e s s H o s t { 
Sdisplay("p=4 0 0, 5 0") ; 

} 

a c c e s s P o i n t : A c c e s s P o i n t { 
Sdisplay("p=2 5 0, 50") ; 

} 

w i r e l e s s H o s t l : W i r e l e s s H o s t { 
@display("p=100,50"); 

} 

} 

Pro konfiguraci síťové adresace slouží prvek IPv4NetworkConfigurator, pokud necháme 
jeho nastavení na původních parametrech, přiřadí se IP adresy v celé síti automaticky. Prvek 
radioMedium slouží k definování parametrů bezdrátového spojení, které budeme nastavovat až 
v následujících krocích. 

Tímto je návrh sítě kompletně dokončen, ale k provádění simulací ještě musíme určit 
parametry a průběh simulace. Jelikož soubor NED je statický, je vhodné v něm definovat pouze 
základní parametry, které nebudeme dále měnit ani nijak upravovat. Pro nastavení průběhu 
simulace a síťového provozu slouží konfigurační soubor s příponou .ini, který nyní musíme 
vytvořit. 

Do složky s projektem vložíme nový soubor, New » Initialization File (ini) » název 
můžeme ponechat, omnetpp.ini » Next » Empty Ini File » Finish. 

Přepneme se do textového módu (tlačítko Source v levém dolním rohu). Smažeme 
nabídku (network =). A místo toho vložíme následující kód: 

d e b u g - o n - e r r o r s = true 
t k e n v - p l u g i n - p a t h = . . / i n e t / e t c / p l u g i n s 
s i m - t i m e - l i m i t = 20s 

Tím povolíme výpis chybových hlášení při nesprávně nastavené simulaci, nastavíme 
cestu k potřebným doplňkům a nastavíme maximální trvání simulace na 20 sekund. 

71 



Pro potřeby simulace j e možné v j ednom souboru vytvářet několik různých konfigurací, 
k vybrání požadované budeme vyzvání po spuštění simulace. Pro vytvoření nové konfigurace 
se používá syntaxe [Config nazevkonfigurace]. Hlavní částí je sekce [General], která obsahuje 
nastavení společná pro všechny vytvořené konfigurace, jejím nastavením začneme. 

Nejprve musíme nastavit parametry bezdrátové sítě a nadefinovat přenosové médium. 

# Nastavení WLAN 
**.wlan[*].opMode = "g" 

. w l a n [ * ] . b i t r a t e = 11Mbps 
" . a c c e s s P o i n t . w l a n [ * ] .mac.address = "09:00:OF:00:00:OA" 

. w i r e l e s s H o s t l . w l a n [ * ] . m a c . a d d r e s s = "11:CO:00:00:00:11" 

. w i r e l e s s H o s t 2 . w l a n [ * ] . m a c . a d d r e s s = "22:00:0D:Bl:00:22" 

.wlan[*].mac.maxQueueSize = 50 
* * . w l a n [ * ] . m a c . r t s T h r e s h o l d B y t e s = 2346B 
* * . w l a n [ * ] . r a d i o . t r a n s m i t t e r . p o w e r = 4mW 
* * . w l a n [ * ] . r a d i o . t r a n s m i t t e r . h e a d e r B i t L e n g t h = 100b 
* * . w l a n [ * ] . r a d i o . c a r r i e r F r e q u e n c y = 2.4GHz 
* * . w l a n [ * ] . r a d i o . b a n d w i d t h = 2MHz 
* * . w l a n [ * ] . r a d i o . r e c e i v e r . s e n s i t i v i t y = -85dBm 
* * . w l a n [ * ] . r a d i o . r e c e i v e r . s n i r T h r e s h o l d = 4dB 
* * . w l a n [ * ] . r a d i o . r e c e i v e r . e n e r g y D e t e c t i o n = -85dBm 

. a c c e s s P o i n t . w l a n [ * ] . m g m t . b e a c o n l n t e r v a l = 100ms 

.accessPoint.wlan[*].mgmt.numAuthSteps = 4 
* * . w l a n [ * ] . r a d i o . r e c e i v e r . e r r o r M o d e l T y p e = "APSK E r r o r M o d e l " 
* * . w l a n [ * ] . m g m t . s s i d = "WLAN1" 
* * . w i r e l e s s H o s t * . w l a n [ * ] . a g e n t . d e f a u l t _ s s i d = "" 

# Nastavení přenosového média 
*.radioMediumType = "RadioMedium" 
*.radioMedium.backgroundNoiseType = " I s o t r o p i c S c a l a r B a c k g r o u n d N o i s e " 
*.radioMedium.pathLossType = " F r e e S p a c e P a t h L o s s " 
*.radioMedium.analogModelType = " S c a l a r A n a l o g M o d e l " 
* . r a d i o M e d i u m . p r o p a g a t i o n T y p e = " C o n s t a n t T i m e P r o p a g a t i o n " 
*.radioMedium.backgroundNoise.power = -lOOdBm 

Tímto kódem nastavíme bezdrátové vysílání standardem IEEE 802.lig na frekvenci 
2,4GHz a s přenosovou rychlostí HMbit/s. Také jsme určili parametry vysílače a přijímače, 
vysílací výkon, citlivost a další. A nakonec definujeme parametry přenosu, který bude prováděn 
radiovým signálem. 

Vytvoříme novou konfiguraci s názvem Wirelessnetwork, kterou vložíme na konec 
konfiguračního souboru omnetpp.ini a pouze k ní přiřadíme námi vytvořenou síť. 

[ C o n f i g W i r e l e s s network] 
network = W i r e l e s s N e t w o r k 

Před spuštěním simulace je zapotřebí sestavit projekt, to provedeme kliknutím pravým 
tlačítkem myši na složku s projektem » Build Configurations » Build Selected... » zaškrtneme 
gcc-debug » OK. 

Po dokončení operace je projekt připraven k simulaci, kliknutím pravým tlačítkem myši 
na konfigurační soubor omnetpp.ini » Run As » OMNeT++ Simulation » z kontextové 
nabídky můžeme vybrat požadovanou konfiguraci, v tomto případě Wireless_network. 
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Stisknutím ikony Run (nebo klávesou F5) se simulace spustí, v s simulačním okně 
probíhá výpis poslaných zpráv, které se zobrazují také v animaci sítě. Můžeme vidět, jaké 
zprávy se posílají při navazování bezdrátového spojení, a také řídící rámce pravidelně 
rozesílané přístupovým bodem. 

WirelessNetwork 

wirelessHoE-tl acce^Pomt 

[Associated with A P ] 

wirelesiHost2 

configurator 

Events rne l_Src/Dest l_Name l_Info 

166 0 23S432170S22 accessPoint - - > wirelessHost2 Beacon KLAN t e a c c n duration=0 04ims 
|66 ú 23E43S170S22 accessPoint — > wirelessHostl Beacon ívLiN duration= 0 04Éina 
i*3 0 237069103919 wirelessHost2 - > accessPoint ProbeReq JvLAH probe request duration=0 042ms 
= : : Q 237069108919 wirelessHost2 - > wirelessHostl FrcbeReq ALAH probe r e q u e s t duration=0 042ms 
rt?B 0 237641108919 accessPoint - - > wirelessHost2 PrcbeResp WLAN probe response duration=0 249ms 

Q 227641108919 accessPoint - - > wirelessHostl PrcbeResp ivLAN probe response duration==0 24 3x3 
•(110 0 22790010S919 wirelessHost2 - > accessPoint ACK KLAN ack 10-00-00-00 -DD -DD duration=0 304ms 

ú 2S790010S919 wirelessHost2 - > wirelessHostl ACK ívLAN ack 10-00-00-00 -DD -DD duration= 0 304ma 
•1127 0 293763234527 wirelessHostl - > wirelessHostZ ProbeReq WLAN probe request duration=0 042ms 
1121 Q 293763234527 wirelessHostl - > accessPoint ProbeReq WLAN probe request duration^O 042ms 
J142 0 294120234527 accessPoint - - > wirelessHost2 PrcbeResp WLAN probe response duration=0 249ms 

Q 294120234527 accessPoint - - > wirelessHostl PrcbeResp WLAN probe response duration=0 243x3 
•(134 0 294379234527 wirelessHostl - > wirelessHost2 ACK WLAN ack 10-QQ-QQ-QQ -00 -00 duration=0 304ms 

0 294379234527 wirelessHostl - > accessPoint JiCK KLAN ack 10-00-00-00 -00 -DD duratiDn=0 304ms 
•(177 D 33S433170S22 accessPoint — > wirelessHost2 Beacon WLAN duration= 0 04Éina 
------ Q 33S433170S22 accessPoint - - > wirelessHostl Beacon WLAN beacon duration^O 04£ms 
ŕtl?5 0 43S43S170S22 accessPoint - - > wirelessHost2 Beacon WLAN beacon duration=0 04£ms 
= : : E Q 43S43S170S22 a c c e s s P o á n t - - > wirelessHostl Beacon WLAN beacon duration=0 04£ms 
=(213 • 53S432170222 accessPoint - - > wirelessHost2 Beacon WLAN beacon duration=0 04€ms 

0 538432170S22 accessPoint - - > wirelessHostl Beacon KLAN t e a c c n duratiDn=0 04ims 
=(234 0 5S706910S919 wirelessHost2 - > accessPoint Auth WLAN cijth duraniDn=0 217ma 

ú 5S706910S919 wirelessHost2 - > wirelessHcstl Auth WLAN cuth duration= 0 217ma 
ä»247 0 537296103919 accessPoint - - > wirelessHost2 ACK WLAN ack OA-AA-OO-OO -DO -05 duration^O 304ms 
1241 Q 5S729610S919 a c c e s s P o á n t - - > wirelessHostl ACK WLAN ack OA-AA-00-00 -00 -DE duration=0 304ms 
=(2E2 0 528010105919 accessPoint - - > wirelessHost2 Auth WLAN auth duration=0 217ms 
= _:_ •:• 52201010S919 accessPoint - - > wirelessHostl Auth WLAN auth duration=0 217ms 
=(275 0 52S23710S919 wirelessHost2 - > accessPoint JiCK KLAN ack 10-00-00-00 -00 -DD duratiDn=0 304ms 
=;- = o 5SS23710S919 wirelessHost2 - > wirelessHostl ACK WLAN ack 10-00-00-00 -DD -DD duration= 0 304ma 
=(2 90 0 538651103919 wirelessHost2 - > accessPoint Auth WLAN i u t h duration^O 217ms 
=:.-: Q 538651108919 wirelessHost2 - > wirelessHostl Auth WLAN i u t h duration^O 217ms 

0 52SS7210S919 accessPoint - - > wirelessHost2 JiCK WLAN ack OA-AA-OO-OO -00 -DE duration=0 304ms 
•:• 52287210S919 accessPoint - - > wirelessHostl JiCK WLAN ack QA-AA-QQ-QQ -00 -05 duration=0 304ms 

i*31-ž 0 529572108919 accessPoint - - > wirelessHost2 Auth-OK WLAN auth duration=0 217ms 
0 52957210S919 accessPoint - - > wirelessHostl Jiuth-OK KLAN auth duratiDn=0 217ms 

= 1 3 3 5 D 5S979910S919 wirelessHost2 - > accessPoint ACK WLAN ack 10-00-00-00 -DD -DD duration= 0 304ma 
Q 539799108919 wirelessHost2 - > wirelessHostl ACK WLAN ack 10-00-QQ-QQ -00 -00 duration^O 304ms 
0 590533103919 wirelessHost2 - > accessPoint Assoc WLAN a s s c c req duration=0 224x3 

= : E : 590533103919 wirelessHost2 - > wirelessHostl Assoc WLAN a s s c c r e q duration=0 224x3 
;»3£3 • 590767108919 accessPoint - - > wirelessHost2 ACK WLAN ack 0A-AA-00-00 -00 -05 duration=0 304ms 
= J - ; Í 0 59076710S919 accessPoint - - > wirelessHostl ACK KLAN ack OA-AA-00-00 -DD -05 duratiDn=0 304ms 
•(375 D 59150110S919 accessPoint — > wirelessH^st2 AssccResp-O^ WLAN aasoc reap duration= 0 232ma 

Q 59150110S919 accessPoint - - > wirelessHostl AssccResp-OK WLAN aasoc reap duration=0 232ms 

Obrázek 3: Navázání komunikace s prístupovým bodem 
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Vypracování 2. část - Ethernet vs. WLAN, porovnání parametrů 
Nyní přidáme do naší bezdrátové sítě datový provoz, následující kód vložíme do sekce 

[Config Wireless_network]: 

n umU dpAp p s = 1 
w i r e l e s s H o s t 2 .udpApp[0] .typename = "UDPVideoStreamSvr" 
w i r e l e s s H o s t 2 .udpApp[0] . v i d e o S i z e = 10MÍB 
w i r e l e s s H o s t 2 .udpApp[0] . l o c a l P o r t = 1000 
w i r e l e s s H o s t 2 .udpApp[0] . s e n d l n t e r v a l = lms 
w i r e l e s s H o s t 2 .udpApp[0] .packetLen = 1200B 

w i r e l e s s H o s t l .udpApp[0] .typename = " U D P V i d e o S t r e a m C l i " 
w i r e l e s s H o s t l .udpApp[0] . s e r v e r A d d r e s s = " w i r e l e s s H o s t 2 " 
w i r e l e s s H o s t l .udpApp[0] . l o c a l P o r t = 2000 
w i r e l e s s H o s t l .udpApp[0] . s e r v e r P o r t = 1000 
w i r e l e s s H o s t l .udpApp[0] . s t a r t T i m e = 1 

Tímto nastavíme streamování videa o velikosti 10MB mezi klienty, stejně tak jej 
nastavíme i pro síť s ethernetem, kterou nyní vytvoříme. 

Novou síť pojmenujeme WiredNetwork, bude mít stejnou topologií jako síť bezdrátová 
z předchozí části, nyní však budou klienti připojeni technologií ethernet, s přenosovou rychlostí 
10Mbit/s. Na konec souboru Network.ned přidáme následující kód: 

network WiredNetwork 
{ parameters: 

gdisplay("bgb=600, 200") ; 

types: 
channel LAN10 extends D a t a r a t e C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 10Mbps; 
be r = 1E-8; 

} 

submodules: 
c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 

Sdisplay("p=550, 150") ; 
} 

h o s t l : S t a n d a r d H o s t { 
@display("p=100, 50") ; 

} 

h o s t 2 : S t a n d a r d H o s t { 
@display("p=4 0 0, 5 0") ; 

} 

s w i t c h : E t h e r S w i t c h { 
@display("p=2 5 0, 5 0 " ) ; 

} 

connections: 
h o s t l . e t h g + + <—> LAN10 <—> c l i e n t S w i t c h . e t h g + + ; 
c l i e n t S w i t c h . e t h g + + <—> LAN10 <—> host2.ethg++; 

} 
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V souboru omnetpp.ini vytvoříme novou konfiguraci s názvem Wired_network, 
vložíme do ní odkaz na nově vytvořenou síť a nadefinujeme datový provoz se stejnými 
parametry jako v síti bezdrátové: 

[ C o n f i g W i r e d network] 
network = WiredNetwork 

. h o s t * .numUdpApps = 1 

.host2 .udpApp[0]. typename = "UDPVideoStreamSvr" 

.host2 .udpApp[0]. v i d e o S i z e = lOMiB 

.host2 .udpApp[0]. l o c a l P o r t = 1000 

.host2 .udpApp[0]. s e n d l n t e r v a l = lms 

.host2 .udpApp[0]. p a c k e t L e n = 1200B 

. h o s t i .udpApp[0]. typename = " U D P V i d e o S t r e a m C l i " 

. h o s t i .udpApp[0]. s e r v e r A d d r e s s = " h o s t 2 " 

. h o s t i .udpApp[0]. l o c a l P o r t = 2000 

. h o s t i .udpApp[0]. s e r v e r P o r t = 1000 

. h o s t i .udpApp[0]. s t a r t T i m e = l s 

Nyní můžeme provést simulaci, spustíme postupně oba nově vytvořené scénáře 
(Wireless_network, Wired_network). Urychlení simulace lze provést ikonou FAST (klávesa 
F6) nebo EXPRESS (F7). Pro změnu výběru simulovaného scénáře není zapotřebí otevírat 
nové okno simulace, stačí stisknout nabídku File » Set Up a Configuration a vybrat 
požadovaný scénář. 

Po úspěšném dokončení simulací obou scénářů můžeme okno simulátoru zavřít a 
přesunout se k souborům s výsledky simulací. Ty jsou uloženy ve složce results, umístěné 
v našem projektu a pojmenované dle názvu scénáře. Dvoj klikem otevřeme libovolný soubor 
pro každý scénář a potvrdíme vytvoření souboru s příponou .anf, nabízené jméno ponecháme. 
V souborech s příponou .anf můžeme prohlížet výsledky provedených simulací, v záložce 
Browse Data máme na výběr z výsledků zobrazených vektorově v grafu a skalárními 
hodnotami. 

K porovnání vybereme například statistiku zpoždění přenosu streamovaného videa. 
Vybereme záložku Vectors » v poli statistic name filter vybereme endToEndDelayrvector. 
Zde můžeme vidět průměrnou hodnotu zpoždění (sloupec Mean) a jitter (sloupec StdDev). 
Porovnáme tyto hodnoty mezi oběma scénáři. 

M Wired_network.anf 23 X . 

Browse Data 

Here you can see all data that come from the files specified in the Inputs page, 

All (215 / 216)1 Vectors [1 / 34) Scalars (181 / 181] | Histograms [1 / 1]| 

"BID 
Module Name 

WíredNetwork,hostl.udpApp[0] endToEndDelsyiv 

Count Mean StdDev 

8734 0.05793994737806274 0.03228938768601785 

£ Wireless_network.anf £3 \ ^ 

Browse Data 

Here you can see all data that cc e from the files specified in the Inputs page, 

All (2m 1289]] Vedors [1 / 52) | Scalars (221 J 221] | Histograms [16 / 16)| 

- module filter - endToEndDelayivector ' [ % \ [V] 

Module Name Count Mean StdDev 

WirelessNetwork.wirelessHostl.udpApp[0] endToEndDelay:vedor 6502 0.09593070325821594 0.018910972901358496 

Obrázek 4: Okno s výslednými hodnotami parametru zpoždění 
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Vypracování 3. část - Parametry přenosu v závislosti na vzdálenosti 

V konfiguračním souboru omnetpp.ini vytvoříme další scénář s názvem [Config 
Wireless_Mobility]. Do kterého nastavíme rostoucí vzdálenost klienta (wirelessHost2) od 
přístupového bodu s krokem po padesáti metrech, od 150m do 300m. A budeme sledovat vliv 
vzdálenosti na chybovost přenášených dat. 

[ C o n f i g W i r e l e s s M o b i l i t y ] 
e xtends = W i r e l e s s network 
* * . c o n s t r a i n t A r e a M i n X = Om 
* * . c o n s t r a i n t A r e a M i n Y = Om 
* * . c o n s t r a i n t A r e a M i n Z = Om 
* * . c o n s t r a i n t A r e a M a x X = 800m 
* * . c o n s t r a i n t A r e a M a x Y = 600m 
* * . c o n s t r a i n t A r e a M a x Z = Om 

* * . m o b i l i t y T y p e = " S t a t i o n a r y M o b i l i t y " 
* * . m o b i l i t y . i n i t F r o m D i s p l a y S t r i n g = f a l s e 
* * . w i r e l e s s H o s t l . m o b i l i t y . i n i t i a l X = 100m 
* * . w i r e l e s s H o s t l . m o b i l i t y . i n i t i a l Y = 50m 
* * . w i r e l e s s H o s t 2 . m o b i l i t y . i n i t i a l X = ${distance=400..550 s t e p 50}m 
* * . w i r e l e s s H o s t 2 . m o b i l i t y . i n i t i a l Y = 50m 
* * . a c c e s s P o i n t . m o b i l i t y . i n i t i a l X = 250m 
* * . a c c e s s P o i n t . m o b i l i t y . i n i t i a l Y = 50m 
* * . m o b i l i t y . i n i t i a l Z = 0m 

Před spuštěním simulace budeme nově vyzvání také k výběru pořadového čísla simulace, 
viz obrázek 3. Každé z nich reprezentuje jinou hodnotu nastavovaného parametru, tedy v tomto 
případě měnící se vzdálenost mezi klientem a přístupovým bodem. Vybereme tedy scénář 
Wireless_mobility a postupně provedeme simulaci pro všechna pořadová čísla (0 až 3). 
K urychlení průběhu simulace můžeme využít ikonu Express (F7). 

[ 3 Set LP p Inifile Config J rati o n 

Set up one of the configurations defined in omnetpp.ini, 

Run number: 

Wireless_Mobility 

0 

Obrázek 5: Výběr pořadového čísla simulace 
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Po dokončení simulací se přesuneme do složky results, kde se vytvořili nové soubory 
s výsledky pojmenované Wireless_Mobility, dvojklikem na jeden z nich otevřeme okno 
s výsledky. Přepneme se na záložku Browse Data » Scalars. V poli module filter zadáme 
WirelessNetwork.wirelessHost2.wlan[0] .rádio, v poli statistic name filter vybereme 
bitErrorRate:histogram:sum. Zobrazí se nám hodnoty bitové chybovosti přenášených dat a 
porovnáme závislost na vzdálenosti. Všechny čtyři položky označíme a kliknutím pravým 
tlačítkem myši » Plot zobrazíme grafické znázornění chybovosti. Legendu pro popis položek 
lze zobrazit ikonou v pravém horním rohu grafu. 

Chart: bitErrorRate: histogram: s JITI WirelessNetwork.wirelessHost2.wlan[C}].radio 

Obrázek 6: Bitová chybovost v závislosti na vzdálenosti bezdrátové komunikace 

Dále si zobrazíme počet úspěšně doručených paketů pro jednotlivé vzdálenosti. Přepneme 
se zpět na záložku Browse Data » Scalars. Do pole module filter zadáme 
WirelessNetwork.wirelessHostl.wlan[0].mac a v poli statistic name filter vybereme 
passedUpPkrcount, zobrazí se nám hodnoty úspěšně doručených paketů, které můžeme opět 
zobrazit do grafu jako v předchozím případě. Ve scénáři s největší vzdáleností od přístupového 
se již nepodařilo ani navázat spojení k bezdrátové komunikaci a můžeme vidět, že počet 
přenesených paketů je výrazně nižší a jedná se pouze o řídící data bezdrátové sítě (beacon rámce 
a pokusy o navázání spojení). 
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Nyní vytvoříme nový scénář v souboru omnetpp.ini s názvem [Config Wired_Mobility], 
ve kterém zjistíme vliv vzdálenosti na parametry přenosu dat kabelovým spojením a porovnáme 
s výsledky v síti bezdrátové. Nastavíme dvě různé vzdálenosti od přepínače, 150 a 300m, druhá 
jmenovaná již neumožnila kvůli vysoké chybovosti navázání spojení v bezdrátové síti. 

[ C o n f i g W i r e d M o b i l i t y ] 
e x tends = W i r e d network 
* * . c o n s t r a i n t A r e a M i n X = Om 

. c o n s t r a i n t A r e a M i n Y = Om 

. c o n s t r a i n t A r e a M i n Z = Om 

. c o n s t r a i n t A r e a M a x X = 8 0 0m 

. c o n s t r a i n t A r e a M a x Y = 600m 

. c o n s t r a i n t A r e a M a x Z = Om 

. m o b i l i t y T y p e = " S t a t i o n a r y M o b i l i t y " 

. m o b i l i t y . i n i t F r o m D i s p l a y S t r i n g = f a l s e 
* * . h o s t i . m o b i l i t y . i n i t i a l X = 100m 
* * . h o s t i . m o b i l i t y . i n i t i a l Y = 50m 
* * . h o s t 2 . m o b i l i t y . i n i t i a l X = ${distance=400..550 s t e p 150}m 
* * . h o s t 2 . m o b i l i t y . i n i t i a l Y = 50m 

. m o b i l i t y . i n i t i a l Z = Om 

Spustíme simulaci a vybereme scénář Wiredmobility, který provedeme pro dvě různé 
vzdálenosti (Run number 0 a 1). Opět můžeme simulaci urychlit ikonou Express (F7). Po 
dokončení otevřeme soubor s výsledky a zobrazíme si stejnou statistiku přenesených paketů, 
jako v předchozím bodě a hodnoty porovnáme. Záložka Browse Data » Scalars. Do pole 
module filter zadáme WiredNetwork.hostl.udp a v poli statistic name filter vybereme 
passedUpPkrcount, můžeme vidět, že hodnoty se s rostoucí vzdáleností prakticky nemění. 
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Vypracování 4. část - Srovnání parametrů při vysoké zátěži sítě 

V této části zvýšíme datový tok v síti a porovnáme vliv na zpoždění přenosu v obou 
sítích. Vložením následujícího kódu na konec konfiguračního souboru omnetpp.ini vytvoříme 
dvě shodné konfigurace pro obě naše sítě, do kterých tímto přidáme druhý videostream s 
obdobnými parametry jako ten původní. 

[ C o n f i g W i r e d network H i g h l o a d ] 
extends = W i r e d network 

**.hostl.numUdpApps = 2 
**.hostl.udpApp[1].typename = "UDPBasicApp" 
* * . h o s t l . u d p A p p [ 1 ] . d e s t A d d r e s s e s = " h o s t 2 " 
**.hostl.udpApp[1].packetName = "VideoStream_2" 
* * . h o s t l . u d p A p p [ 1 ] . d e s t P o r t = 4000 
* * . h o s t l . u d p A p p [ 1 ] . s t a r t T i m e = 1.01s 
* * . h o s t l . u d p A p p [ 1 ] . s t o p T i m e = 10.0s 
** . h o s t l . u d p A p p [ 1 ] . m e s s a g e L e n g t h = 1200B 
* * . h o s t l . u d p A p p [ 1 ] . s e n d l n t e r v a l = 0.001s 
**.host2.numUdpApps = 2 
**.host2.udpApp[1].typename = "UDPSink" 
* * . h o s t 2 . u d p A p p [ 1 ] . l o c a l P o r t = 4000 

[ C o n f i g W i r e l e s s network H i g h l o a d ] 
extends = W i r e l e s s network 

** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 
** . wi 

r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 
r e l e s 

s H o s t l . 
s H o s t l . 
s H o s t l . 
s H o s t l . 
s H o s t l . 
s H o s t l . 
s H o s t l . 
s H o s t l . 
s H o s t l . 
sHost2. 
sHost2. 
sHost2. 

numUdpApps = 2 
udpApp[1].typename 
udpApp[1]. 
udpApp[1]. 
udpApp[1]. 
udpApp[1]. 
udpApp[1]. 
udpApp[1]. 
udpApp[1]. 
numUdpApps 
udpApp[1] 
udpApp[1] 

"UDPBasicApp" 
d e s t A d d r e s s e s = " w i r e l e s s H o s t 2 " 
packetName = "V i d e o S t r e a m 2" 
d e s t P o r t = 4000 
s t a r t T i m e = 1.01s 
stopTime = 10.0s 
messageLength = 1200B 
s e n d l n t e r v a l = 0.001s 
= 2 

typename = 
l o c a l P o r t 

"UDPSink" 
= 4000 

Spustíme simulaci pro oba nově vytvořené scénáře (Wireless_network_High_load a 
Wired_network_High_load), opět j i můžeme urychlit ikonou Express (F7). Po dokončení 
otevřeme soubory s výsledky a přepneme se na záložku Browse Data » Vectors » v poli 
statistic name filter vybereme endToEndDelayrvector. Porovnáme hodnoty pro obě sítě, ve 
sloupci Mean je zobrazena průměrná hodnota zpoždění v sekundách, můžeme vidět, že 
v bezdrátové síti došlo vlivem vysokého zatížení k výraznému zhoršení zpoždění oproti síti 
propojené ethernetem. 
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Vypracování 5. část - EDCA 

Nyní vyzkoušíme použití mechanizmu pro řízení kvality služeb v bezdrátových sítích 
EDCA, která umožňuje rozdělení datového provozu do tříd podle čísla portu a zajistit 
kvalitativní zvýhodnění služeb ve třídách s vyšší prioritou. Pro každou třídu jsou definovány 
různé parametry při soutěžení o přístupu k přenosovému kanálu, pravděpodobnost přistupuje 
nejvyšší pro třídy vysokou prioritou. 

V konfiguračním souboru omnetpp.ini vytvoříme novou konfiguraci s názvem [Config 
Wireless_network_EDCA], která bude obsahovat následující kód: 

[ C o n f i g W ireless_network_EDCA] 
extends = W i r e l e s s network H i g h l o a d 

**.wlan[*].mac.EDCA = true 
* * . w l a n [ * ] . c l a s s i f i e r T y p e = " E x a m p l e Q o S C l a s s i f i e r " 
**.wlan[*].mac.cwMinData = 15 

.wlan[*].mac.cwMaxData = 1023 

V síti jsou dva shodné videostreamy z předchozí části, které plně vytěžují přenosový 
kanál bezdrátové sítě a oba dosahují velkého zpoždění. Zavedením mechanizmu E D C A 
zvýhodníme jeden stream posílající video na portu 5000 a budeme sledovat, jak se změní 
výsledné hodnoty zpoždění. 

Provedeme simulaci scénáře Wireless_network_EDCA. Otevřeme soubor s výsledky a 
přepneme se na záložku Browse Data » Vectors » v poli statistic name filter vybereme 
endToEndDelayrvector. Ve sloupci Mean je zobrazena průměrná hodnota zpoždění obou 
videostreamů. Můžeme porovnat tyto hodnoty s těmi předchozími ze scénáře bez řízení kvality 
(Wireless_network_High_load). 

Otázky: 
1. Jak j sou pojmenovány řídící rámce W L A N sítí? 

2. Na základě čeho lze v bezdrátových sítích rozlišit data do tříd v systému EDCA? 
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D. Laboratorní úloha č.4 - Aktivní síťové prvky 

Cílem laboratorní úlohy je srovnání nej používanějších aktivních síťových prvků, které 
slouží k vytváření počítačových sítí a umožňují komunikaci mezi koncovými stanicemi. 
V úloze jsou k propojení sítě použity rozbočovače, přepínače a směrovače, každý z těchto 
prvků pracuje na jiné vrstvě referenčního modelu ISO/OSI. Tím jsou dány hlavní rozdíly 
v jejich funkci při zpracování a přeposílání příchozích dat, které lze sledovat ve vytvořené 
simulaci. Ke srovnání síťových prvků je sledován parametr zpoždění přenosu souborů službou 
FTP a množství rozesílaných dat na jednotlivých linkách. Pro simulaci poslouží jednoduchá síť 
se čtyřmi klienty. Topologii sítě propojené přepínači lze vidět na obrázku 1, ostatní sítě jsou 
obdobné, pouze je k propojení koncových stanic využito rozbočovaču, respektive směrovačů. 

H2 switch 

iwitchl 

m 

switchí 

H4 switch 

configurator 

Obrázek 1: Topologie sítě propojené přepínači 
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1. Teoretický úvod 

Způsob funkce a principy, které jsou aplikovány při zpracování a přenosu zpráv v rámci 
počítačových sítí vychází z rozdělení jednotlivých úkonů do skupin definovaných v 
referenčním modelu ISO/OSI, případně ve zjednodušeném modelu TCP/IP. Složení obou 
modelů lze vidět v tabulce 1. Pro úspěšné provedení a zpracování přenosu informace, dochází 
k postupnému zpracování datové jednotky danou vrstvou a předání její sousední vrstvě. Pro 
samotný přenos dat jsou nej důležitější tři nej nižší vrstvy, fyzická, spojová a síťová. Zbylé čtyři 
vrstvy, respektive aplikační vrstva modelu TCP/IP mají za úkol především práci s datovým 
obsahem zpráv ajsou obvykle záležitostí uživatelských aplikací. 

Na třech nej nižších vrstvách operují aktivní síťové prvky, které zprostředkovávají přenos 
informace skrze komunikační síť. Podle typu zařízení mohou vykonávat i mnoho dalších 
funkcí, jako řízení přístupu ke sdílenému médiu, zajištění kvality služeb nebo směrování 
datového toků sítí s nalezením nejlepší cesty. Množina operací, které jsou schopny dané prvky 
provádět, vychází právě z principu rozdělení komunikačního modelu na jednotlivé vrstvy. 
Základním uzlem síťové vrstvy je směrovač, který poskytuje nej rozsáhlejší možnosti při 
zpracování přijatých nebo odesílaných zpráv, jelikož musí také zvládat operace obou nižších 
vrstev. Na druhé vrstvě operuje přepínač, který nabízí menší možnosti nastavení a řízení 
provozu, ale výhodou jsou nižší výpočetní nároky. Rozbočovač pracuje pouze na nej nižší 
fyzické vrstvě a jejich možnosti jsou tedy velmi omezené, výhodou je však jednoduchost 
nastavení, minimální výpočetní nároky a minimální zpoždění přenášených dat. 

Tabulka 1: Referenční model ISO/OSI a TCP/IP 

7. Aplikační vrstva 

4. Aplikační vrstva 
6. Prezentační vrstva 

4. Aplikační vrstva 
5. Relační vrstva 

4. Aplikační vrstva 

4. Transportní vrstva 

4. Aplikační vrstva 

3. Síťová vrstva 3. Síťová vrstva 

2. Spojová vrstva 2. Spojová vrstva 

1. Fyzická vrstva 1. Fyzická vrstva 
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2. Vypracování 

Založení nového projektu 
Spustíme program omnetpp.exe. Pokud se objeví nabídka pro vybrání pracovního 

adresáře, tento formulář potvrdíme beze změny (vybraná cesta musí být: omnetpp-4.6\samples), 
jinak vytvořený projekt nebude fungovat. 

K vytvoření nového projektu klikneme na File » New » OMNeT++ Project... Projekt 
pojmenujeme V U T loginem, dále stiskneme Next » Empty project » Finish. V okně Project 
Explorer se vytvořila námi pojmenovaná složka, ve které budou uloženy všechny části projektu. 
Nejprve je zapotřebí přiřadit k projektu odkazy na zdrojové soubory, se kterými se bude dále 
pracovat. To provedeme kliknutím pravým tlačítkem na vytvořenou složku » Properties » 
Project References » vybereme položku inet» OK. 

Pro vytvoření projektu jsou zapotřebí dva základní soubory. Network Description File, 
s příponou .ned, který definuje topologii sítě, použité technologie a síťové prvky. Druhým je 
Initialization File, přípona .ini, který určuje průběh a parametry simulace. 

Klikněte pravým tlačítkem myši na vaši složku a vyberte New » Network Description 
File (NED), pojmenujte j i Network.ned » Next » Empty NED File » Finish. 

V souboru NED lze pracovat ve dvou režimech, v grafickém nebo kódovém. Mezi nimi 
se lze přepínat v levém dolním rohu volbou Design/Source. Jsou navzájem propojené, pokud 
tedy přidáme prvky sítě z palety, vytvoří se k nim patřičný kód a naopak vložením kódu lze 
vytvářet celou síť. 

Vypracování 1. část - Aktivní síťové prvky 
Nejprve musíme importovat do projektu prvky, se kterými se bude pracovat. Do souboru 

Network.ned vložíme následující kód: 

import i n e t . l i n k l a y e r . e t h e r n e t . E t h e r H u b ; 
import i n e t . n e t w o r k l a y e r . c o n f i g u r a t o r . i p v 4 . I P v 4 N e t w o r k C o n f i g u r a t o r ; 
import i n e t . n o d e . e t h e r n e t . E t h e r S w i t c h ; 
import i n e t . n o d e . i n e t . R o u t e r ; 
import i n e t . n o d e . i n e t . S t a n d a r d H o s t ; 
import i n e t . c o m m o n . m i s e . T h r u p u t M e t e r i n g C h a n n e l ; 
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Nejprve vytvoříme síť pojmenovanou Hub, která bude obsahovat čtyři klienty, propojené 
dvěma rozbočovači, nastavíme přenosovou linku typu ethernet s přenosovou rychlostí 10Mbit/s 
pro její realizaci zvolíme model ThruputMeteringChannel, který umožňuje zobrazení počtu 
přenesených paketů jednotlivých linek přímo v simulaci. 

network Hub 
{ parameters: 

@display("bgb=466, 313") ; 
types: 

channel e t h e r n e t extends T h r u p u t M e t e r i n g C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 10Mbps; 
t h r u p u t D i s p l a y F o r m a t = "N"; 

} 

submodules: 
h u b l : EtherHub { 

Sdisplay("p=167,148"); 
gates: e t h g [ 3 ] ; 

} 

hub2: EtherHub { 
Sdisplay("p=292,148"); 
gates: e t h g [ 3 ] ; 

} 

HI hub: St a n d a r d H o s t { 
@display("p=4 0,56"); 
gates: e t h g [ 1 ] ; 

} 

H2 hub: St a n d a r d H o s t { 
@display("p=40,230"); 
gates: e t h g [ 1 ] ; 

} 

H3 hub: St a n d a r d H o s t { 
@display("p=419,56"); 
gates: e t h g [ 1 ] ; 

} 

H4_hub: St a n d a r d H o s t { 
Sdisplay("p=419, 2 3 0") ; 
gates: e t h g [ 1 ] ; 

} 

c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 
Sdisplay("p=228,276"); 

} 

connections: 
H l _ h u b . e t h g [ 0 ] <—> e t h e r n e t <—> h u b l . e t h g [ 0 ] ; 
H2_hub.ethg[0] <—> e t h e r n e t <—> h u b l . e t h g [ 1 ] ; 
H3_hub.ethg[0] <—> e t h e r n e t <—> h u b 2 . e t h g [ 0 ] ; 
H4_hub.ethg[0] <—> e t h e r n e t <—> h u b 2 . e t h g [ 1 ] ; 
h u b l . e t h g [ 2 ] <--> e t h e r n e t <--> h u b 2 . e t h g [ 2 ] ; 

} 

Pro konfiguraci síťové adresace slouží prvek IPv4NetworkConfigurator, jeho nastavení 
ponecháme na původních parametrech, čímž se LP adresy přiřadí pro všechny prvky v síti 
automaticky. 
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Nyní vytvoříme síť, v níž k propojení klientů použijeme přepínače, ta bude mít stejnou 
topologii i parametry, pouze nahradíme huby za switche. 

network S w i t c h 
{ parameters: 

@display("bgb=466, 313") ; 
types: 

channel e t h e r n e t extends T h r u p u t M e t e r i n g C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 10Mbps; 
t h r u p u t D i s p l a y F o r m a t = "N"; 

} 

submodules: 
s w i t c h l : E t h e r S w i t c h { 

Sdisplay("p=168,155"); 
gates: e t h g [ 3 ] ; 

} 

s w i t c h 2 : E t h e r S w i t c h { 
Sdisplay("p=2 93,155"); 
gates: e t h g [ 3 ] ; 

} 

HI s w i t c h : S t a n d a r d H o s t { 
Sdisplay("p=41,62"); 
gates: e t h g [ 1 ] ; 

} 

H2 s w i t c h : S t a n d a r d H o s t { 
Sdisplay("p=41,2 3 6") ; 
gates: e t h g [ 1 ] ; 

} 

H3 s w i t c h : S t a n d a r d H o s t { 
Sdisplay("p=42 0,62"); 
gates: e t h g [ 1 ] ; 

} 

H4 s w i t c h : S t a n d a r d H o s t { 
Sdisplay("p=420,236"); 
gates: e t h g [ 1 ] ; 

} 

c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 
Sdisplay("p=230, 267") ; 

} 

connections: 
HI s w i t c h . e t h g [ 0 ] <--> e t h e r n e t <--> s w i t c h l . e t h g [ 0 ] ; 
H2 s w i t c h . e t h g [ 0 ] <--> e t h e r n e t <--> s w i t c h l . e t h g [ 1 ] ; 
H3 s w i t c h . e t h g [ 0 ] <--> e t h e r n e t <--> s w i t c h 2 . e t h g [ 0 ] ; 
H4 s w i t c h . e t h g [ 0 ] <--> e t h e r n e t <--> s w i t c h 2 . e t h g [ 1 ] ; 
s w i t c h l . e t h g [ 2 ] <--> e t h e r n e t <—> s w i t c h 2 . e t h g [ 2 ] ; 

85 



A nakonec vytvoříme síť se směrovací: 

network R o u t e r 
{ parameters: 

@display("bgb=466, 313") ; 
types: 

channel e t h e r n e t extends T h r u p u t M e t e r i n g C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 10Mbps; 
t h r u p u t D i s p l a y F o r m a t = "N"; 

} 

submodules: 
r o u t e r l : R o u t e r { 

Sdisplay("p=168,156"); 
gates: e t h g [ 3 ] ; 

} 

r o u t e r 2 : R o u t e r { 
Sdisplay("p=2 93,156"); 
gates: e t h g [ 3 ] ; 

} 

HI r o u t e r : S t a n d a r d H o s t { 
Sdisplay("p=4 4, 62") ; 
gates: e t h g [ 1 ] ; 

} 

H2 r o u t e r : S t a n d a r d H o s t { 
Sdisplay("p=4 4 , 2 3 6") ; 
gates: e t h g [ 1 ] ; 

} 

H3 r o u t e r : S t a n d a r d H o s t { 
Sdisplay("p=42 0, 62") ; 
gates: e t h g [ 1 ] ; 

} 

H4 r o u t e r : S t a n d a r d H o s t { 
Sdisplay("p=420,236") ; 
gates: e t h g [ 1 ] ; 

} 

c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r { 
Sdisplay("p=228 , 267" ) ; 

} 

connections: 
HI r o u t e r . e t h g [ 0 ] <--> e t h e r n e t <--> r o u t e r l . e t h g [ 0 ] ; 
H2 r o u t e r . e t h g [ 0 ] <--> e t h e r n e t <--> r o u t e r l . e t h g [ 1 ] ; 
H3 r o u t e r . e t h g [ 0 ] <--> e t h e r n e t <--> r o u t e r 2 . e t h g [ 0 ] ; 
H4 r o u t e r . e t h g [ 0 ] <--> e t h e r n e t <--> r o u t e r 2 . e t h g [ 1 ] ; 
r o u t e r l . e t h g [ 2 ] <--> e t h e r n e t <—> r o u t e r 2 . e t h g [ 2 ] ; 

Tímto je návrh našich sítí zkompletován, ale k provádění simulací ještě musíme určit 
parametry a průběh simulace. Jelikož soubor NED je statický, je vhodné v něm definovat pouze 
základní parametry, které nebudeme dále měnit ani nijak upravovat. Pro nastavení průběhu 
simulace a síťového provozu slouží konfigurační soubor s příponou .ini, který nyní musíme 
vytvořit. 
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Do složky s projektem vložíme nový soubor, New » Initialization File (ini) » název 
můžeme ponechat, omnetpp.ini » Next » Empty Ini File » Finish. 

Přepneme se do textového módu (tlačítko Source v levém dolním rohu). Smažeme 
nabídku (network =). A místo toho vložíme následující kód: 

d e b u g - o n - e r r o r s = true 
t k e n v - p l u g i n - p a t h = . . / i n e t / e t c / p l u g i n s 
s i m - t i m e - l i m i t = 20s 
**.macType = "EtherMAC" 
".mss = 1460 

Tím povolíme výpis chybových hlášení při nesprávně nastavené simulaci, nastavíme 
cestu k potřebným doplňkům a nastavíme maximální trvání simulace na 20 sekund. Také 
nastavíme maximální možnou délku TCP segmentu, 1460B. 

Nyní nadefinujeme datový provoz, kterým bude přenos souborů, pomocí protokolu FTP, 
mezi stanicemi H l a H4 

H l * numTcpApps = 2 
H4* numTcpApps = 2 
H l * t c p A p p [ 0 ] . typename = " T C P B a s i c C l i e n t A p p " 
H l * t c p A p p [ 0 ] . c o n n e c t P o r t = 20 
H l * t c p A p p [ 0 ] . t h i n k T i m e = O.OOls 
H l * t c p A p p [ 0 ] . i d l e l n t e r v a l = O.OOls 
H l * t c p A p p [ 0 ] . s t a r t T i m e = Os 
H l * t c p A p p [ 0 ] . n u m RequestsPerSession = 5 
H l * t c p A p p [ 0 ] . r e q u e s t L e n g t h = 10MÍB 
H l * t c p A p p [ 0 ] . r e c o n n e c t l n t e r v a l = l s 
H4* t c p A p p [ 0 ] . typename = " T C P B a s i c C l i e n t A p p " 
H4* t c p A p p [ 0 ] . c o n n e c t P o r t = 20 
H4* t c p A p p [ 0 ] . t h i n k T i m e = 0.OOls 
H4* t c p A p p [ 0 ] . i d l e l n t e r v a l = O.OOls 
H4* t c p A p p [ 0 ] . s t a r t T i m e = Os 
H4* t c p A p p [ 0 ] . n u m RequestsPerSession = 5 
H4* t c p A p p [ 0 ] . r e q u e s t L e n g t h = 10MÍB 
H4* t c p A p p [ 0 ] . r e c o n n e c t l n t e r v a l = l s 
H4* t c p A p p [ 1 ] . typename = "TCPGenericSrvApp" 
H4* t c p A p p [ 1 ] . l o c a l P o r t = 20 
H l * t c p A p p [ 1 ] . typename = "TCPGenericSrvApp" 
H l * t c p A p p [ 1 ] . l o c a l P o r t = 20 

Pro potřeby simulace j e možné v j ednom souboru vytvářet několik různých konfigurací, 
k vybrání požadované budeme vyzvání po spuštění simulace. Hlavní částí je sekce [General], 
která obsahuje nastavení společná pro všechny vytvořené konfigurace. Pro vytvoření nové 
konfigurace se používá syntaxe [Config nazev_konfigurace]. 
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Vytvoříme tři nové konfigurace, a každé z nich přiřadíme jednu z vytvořených sítí, 
pojmenujeme je dle aktivního síťového prvku, který je v dané síti použit (Hub, Switch, Router): 

[ C o n f i g Hub] 
network = Hub 

**.H1 h u b . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = 
**.H4 h u b . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = 

"H4 
"Hl 

hub" 
hub" 

[ C o n f i g S w i t c h ] 
network = S w i t c h 

**.H1 s w i t c h . t c p A p p [ 0 ] 
**.H4 s w i t c h . t c p A p p [ 0 ] 

.connectAddress 

.connectAddress 
= "H4 s w i t c h " 

" H l s w i t c h " 

[ C o n f i g Router] 
network = Rou t e r 

**.H1 r o u t e r . t c p A p p [ 0 ] 
**.H4 r o u t e r . t c p A p p [ 0 ] 

.connectAddress 

.connectAddress 
= "H4 r o u t e r " 

" H l r o u t e r " 

Nyní můžeme přejít k simulaci, ale nejprve je zapotřebí sestavit projekt, to provedeme 
kliknutím pravým tlačítkem myši na složku s projektem » Build Configurations » Build 
Selected... » zaškrtneme gcc-debug » OK. 

Po dokončení operace je projekt připraven k simulaci, kliknutím pravým tlačítkem myši 
na konfigurační soubor omnetpp.ini » Run As » OMNeT++ Simulation » z kontextové 
nabídky můžeme vybrat požadovanou konfiguraci, postupně spustíme všechny tři. 

Průběh simulace lze ovládat pomocí panelu s ikonami viz Obrázek 2. Ikony 2 až 5 spustí 
simulaci s různou rychlostí, ikonou Until (6) se lze posunout na požadovaný čas v simulaci a 
ikonou Stop (7) se simulace pozastaví. Rychlost zobrazování simulace lze také regulovat 
posuvníkem Animation speed (8). Pro výběr jiného scénáře můžeme použít ikonu 1. 

& eä i s.s* r«*> i . ^ , ť ® j AJ i • i tSL > i [a] m ~* i # \ I I T 
1 2 3 4 5 6 7 8 

Obrázek 2: Ovládací panel simulačního okna 

Spustíme simulaci stisknutím ikony Run (3) a posuvníkem (8) nastavíme takovou 
rychlost, abychom mohli pozorovat posílání zpráv v grafické části simulace, můžeme také vidět 
výpis zpráv v dolní části obrazovky. Budeme sledovat, jakým způsobem probíhá posílání zpráv 
sítí v každém ze tří námi vytvořených sítí. Po přenosu dat se u každého spoje v animaci 
zobrazuje počet přenesených paketů jednotlivými rozhraními, u nevyužitích linek zůstává IP 
adresa a rozhraní. Můžeme sledovat, na kterých linkách a jaké množství paketů se rozesílá 
v jednotlivých sítích, připomeňme si, že přenos dat v naší síti probíhá pouze mezi koncovými 
stanicemi H l a H4. 
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Po kliknutí na síťový prvek můžeme v levém dolním rohu vidět parametry a bližší 
informace, například směrovací tabulky, které si zobrazíme pro jednotlivé prvky a porovnáme 
jejich obsah. Pro zobrazení směrovací tabulky routeru klikneme myší najeden ze směrovačů a 
v okně s obsahem (obvykle v levém dolním rohu) vybereme routingTable » routes. Pro 
zobrazení směrovací tabulky switche vybereme macTable » addressTable. Pokud klikneme 
na rozbočovač, můžeme vidět, že ten neuchovává žádné informace. 

[std:: m a p < i n et:: M AC Ad d ress, i n et:: M AC Ad d ressTa b I e:: Ad d ressEntry>) Switch 

Fields Contents (0) 

FJ- JtbJ a d d ressTa b I e [std:: m a p< i n et:: M AC Ad d ress, i n et:: M AC Ad d ressTa b I e:: Ad d ressEntry>) 
E3-addressTable[2] [struct pa i r<**>) 

[~\0] = OA-AA-00-00-00-07 = = > {V1D=0, port=0. insertionTime=10.1322441} 
L[l] = 0A-AA-00-00-00-0A ==> {VID=0, port=2, i n sertionTi m 6=10.1323018} 

Obrázek 3: Obsah směrovací tabulky přepínače 
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Vypracování 2. část - Zpoždění přenosu 
Pro snadnější zobrazení výsledků vytvoříme novou síť, která bude obsahovat všechny tři 

předchozí, následující kód přidáme do souboru Network.ned. 

network Network 
{ parameters: @display("bgb=1428 , 313" ) ; 

types: channel e t h e r n e t extends T h r u p u t M e t e r i n g C h a n n e l 
{ d e l a y = 0 . l u s ; 

d a t a r a t e = 10Mbps; 
t h r u p u t D i s p l a y F o r m a t = "N"; 

} 

submodules: 
s w i t c h l : E t h e r S w i t c h 
s w i t c h 2 : E t h e r S w i t c h 
h u b l : EtherHub { 
hub2: EtherHub { 
r o u t e r l : R o u t e r { 
r o u t e r 2 : R o u t e r { 
HI s w i t c h : S tandardHost 
H2 s w i t c h : S tandardHost 
H3 s w i t c h : S tandardHost 
H4 s w i t c h : S tandardHost 
HI hub: Sta n d a r d H o s t { 
H2 hub: Stan d a r d H o s t { 
H3 hub: Sta n d a r d H o s t { 
H4_hub: St a n d a r d H o s t { 
HI r o u t e r : S tandardHost 
H2 r o u t e r : S tandardHost 
H3 r o u t e r : S tandardHost 
H4 r o u t e r : S tandardHost 

{Sdisplay("p=650,154"); gates: 
{Sdisplay("p=775,154"); gates: 

Sdisplay("p=167,148"); gates: 
Sdisplay("p=292,148"); gates: 
Sdisplay("p=1134,155"); gates: 
Sdisplay("p=1259,155"); gates: 
{Sdisplay("p=523,61"); gates: 
{Sdisplay("p=523,235");gates: 
{Sdisplay("p=902,61"); gates: 
{Sdisplay("p=902,235");gates: 

Sdisplay("p=4 0, 5 6") ;gates: 
Sdisplay("p=4 0, 2 3 0") ; gates: 
Sdisplay("p=419,5 6") ; gates: 
Sdisplay("p=419, 2 3 0") ;gates: 

{Sdisplay("p=1010,61");gates: 
{Sdisplay("p=l010,2 3 5") ;gates: 
{Sdisplay("p=1386,61"); gates: 
{Sdisplay("p=l3 8 6,2 3 5") ;gates: 

c o n f i g u r a t o r : I P v 4 N e t w o r k C o n f i g u r a t o r {Sdisplay("p=712 

e t h g [ 3 ] ; 
e t h g [ 3 ] ; 
: e t h g [ 3 ] 
e t h g [ 3 ] ; 
e t h g [ 3 ] ; 
e t h g [ 3 ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
e t h g [ l ] ; 
,266"); 

connections: 
H l _ s w i t c h . e t h g [ 0 ] 
H 2 _ s w i t c h . e t h g [ 0 ] 
H 3 _ s w i t c h . e t h g [ 0 ] 
H 4 _ s w i t c h . e t h g [ 0 ] 
H l _ h u b . e t h g [ 0 ] <-• 
H2_hub.ethg[0] <-• 
H3_hub.ethg[0] <-• 
H4_hub.ethg[0] <-• 
HI r o u t e r . e t h g [ 0 ] 
H2 r o u t e r . e t h g [ 0 ] 
H3 r o u t e r . e t h g [ 0 ] 
H 4 _ r o u t e r . e t h g [ 0 ] 
h u b l . e t h g [ 2 ] <—> 
s w i t c h l . e t h g [ 2 ] <• 
r o u t e r l . e t h g [ 2 ] <• 

} 

<--> e t h e r n e t 
<--> e t h e r n e t 
<--> e t h e r n e t 
<--> e t h e r n e t 
> e t h e r n e t <-• 
> e t h e r n e t <-• 
> e t h e r n e t <-• 
> e t h e r n e t <-• 
<--> e t h e r n e t 
<--> e t h e r n e t 
<--> e t h e r n e t 
<--> e t h e r n e t 
e t h e r n e t <--> 
-> e t h e r n e t <• 
-> e t h e r n e t <• 

<--> s w i t c h l 
<--> s w i t c h l 
<--> s w i t c h 2 
<--> s w i t c h 2 
•> h u b l . e t h g [ 
•> h u b l . e t h g [ 
•> hub2 . e t h g [ 
•> hub2 . e t h g [ 
<--> r o u t e r l 
<--> r o u t e r l 
<--> r o u t e r 2 
<--> r o u t e r 2 
hub2.ethg[2] 
•-> s w i t c h 2 . e 
•-> r o u t e r 2 . e 

.ethg[0] 

. e t h g [ l ] 

. e t h g [ 0 ] 

. e t h g [ l ] 
0] ; 
1] ; 
0] ; 
1] ; 
.ethg[0] 
. e t h g [ l ] 
.ethg[0] 
. e t h g [ l ] 

t h g [ 2 ] ; 
t h g [ 2 ] ; 

; ) 
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V souboru omnetpp.ini vytvoříme novou konfiguraci s názvem Network, vložením 
kódu na konec souboru: 

[ C o n f i g Network] 
network = Network 

**.H1 h u b . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "H4 hub" 
**.H4 h u b . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "Hl hub" 
**.H1 s w i t c h . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "H4 s w i t c h " 
**.H4 s w i t c h . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "HI s w i t c h " 
**.H1 r o u t e r . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "H4 r o u t e r " 
**.H4 r o u t e r . t c p A p p [ 0 ] . c o n n e c t A d d r e s s "HI r o u t e r " 

Nyní můžeme provést simulaci, vybereme nově vytvořenou konfiguraci (Network) a 
provedeme simulaci až do jejího ukončení. Pro urychlení můžeme použít ikonu Express (5). 

Po úspěšném dokončení simulace můžeme okno simulátoru zavřít a přesunout se 
k souborům s výsledky simulací. Ty jsou uloženy ve složce results, umístěné v našem projektu 
a pojmenované dle názvu scénáře. Dvoj klikem na jeden ze souborů s názvem Network 
výsledky vytvoříme a potvrdíme vytvoření souboru s příponou .anf, nabízené jméno 
ponecháme. V souborech s příponou .anf můžeme prohlížet výsledky provedených simulací, 
v záložce Browse Data máme na výběr z výsledků zobrazených vektorově v grafu a skalárními 
hodnotami. 

K porovnání vybereme statistiku zpoždění přenosu FTP dat. Vybereme záložku Vectors 
» do pole module filter zadáme Network.Hl*.tcp a v poli statistic name filter vybereme 
measured RTT. Nyní můžeme porovnat průměrnou hodnotu zpoždění (sloupec Mean) 
jednotlivých síťových prvků. 

Výsledky můžeme zobrazit také do grafu, označíme všechny tři položky a klikneme 
pravým tlačítkem myši » Plot. V pravém horním rohu grafu si můžeme zobrazit legendu. Který 
síťový prvek dokončil přenos souborů v nejkratším čase? 

Dále si zobrazíme procento nečinnosti linky ke klientské stanici H2, která nepřijímá ani 
neodesílá žádná data. Přepneme se na záložku Scalars » do pole module filter zadáme 
Network.H2*.eth[0].mac a v poli statistic name filter vybereme rx channel idle (%). Tím 
zobrazíme procentuální hodnotu nečinnosti dané linky, můžeme vidět, že pro hub je procento 
nečinnosti výrazně nižší. 

All (1448 / 1448) Vectors [72 / 260) Scalars [3 /1176] Histograms [12 / 12) 

runlD filter T Network.H2*,eth[0],mac •» rx channel idle (%] 

Module Name Value 

N etwo rk, H2_switch, eth[Q], rn ac rx channel idle [%) 99,998863136911 

Networlí.H2_hub.ethrO].mac rx channel idle [%) 9.3732980051813 

N etwo rk, H2_ro uter.eth [0 ], rn a c rx channel idle [%) 100,0 

Obrázek 4: Zobrazení nečinnosti přenosové linky 
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Chart: measured RTT 

Legend: 
-•-NelwQrK.H1_fiut.lCB  

Network. H 1_ro uter.tcp 
IJŤt.'-.ii ..H1_E .-'vilcli.tep 

Obrázek 5: Grafické zobrazení parametru zpoždění 

Vypracování 3. část - Hub - kolizní doména 
Vytvoříme další tři scénáře s názvem [Config Hub_collisionsX], ve kterých budeme 

sledovat množství kolizí v síti s rozbočovači v závislosti na přibývajícím počtu stanic 
vysílajících data. Kolize vznikají, pokud na síťový prvek dorazí data ve shodnou dobu a v síti 
obsahující rozbočovače může velmi rychle přibývat výskyt kolizí, jelikož j sou jimi veškerá data 
šířena broadcastem. Na konec konfiguračního souboru omnetpp.ini vložíme následující kód: 

[ C o n f i g Hub c o l l i s i o n s 1] 
network = Hub 
* * . H l _ h u b . t c p A p p [ 0 ] . c o n n e c t A d d r e s s = "H4_hub" 

[ C o n f i g Hub c o l l i s i o n s 2] 
extends = Hub c o l l i s i o n s 1 
**.H4_hub.tcpApp[0].connectAddress = "Hl_hub" 

[ C o n f i g Hub c o l l i s i o n s 3] 
extends = Hub c o l l i s i o n s 2 
**.H2_hub.numUdpApps = 1 
**.H3_hub.numUdpApps = 1 
**.H2_hub.udpApp[0].typename = "UDPBasicApp" 

.H2_hub.udpApp[0].destAddresses = "H3_hub" 
**. H 2 * . u d p A p p [ 0 ] . d e s t P o r t = 2233 

.H2*.udpApp[0].startTime = 0.1s 
**.H2*.udpApp[0].stopTime = 10s 
**.H2*.udpApp[0].messageLength = 500B 
* * . H 2 * . u d p A p p [ 0 ] . s e n d l n t e r v a l = 0.1s 
**.H3*.udpApp[0].typename = "UDPSink" 
* * . H 3 * . u d p A p p [ 0 ] . l o c a l P o r t = 2233 
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Spustíme simulace a postupně vybereme všechny tři nově vytvořené konfigurace 
(Hub_collisions_l, Hub_collisions_2, Hub_collisions_3) K urychlení průběhu simulace 
můžeme využít ikonu Express (5). 

Po dokončení simulací se přesuneme do složky results, kde se vytvořili nové soubory 
s výsledky pojmenované dle názvů konfigurací, otevřeme pro každý z nich okno s výsledky 
(dvojklikem najeden ze souborů pro každou konfiguraci). Přepneme se na záložku Browse 
Data » Scalars. Do pole module filter zadáme *.H2_hub.*. V poli statistic name filter 
vybereme statistiku rx channel collision (%), která zobrazuje procentuální poměr dat 
přenesených bez kolizí k celkovému množství přenášených dat (procento kolizí tedy lze získat 
odečtením naměřené hodnoty od sta procent). 

Browse Data 
Here you can see all data that come from the files specified in the Inputs page, 

All [393 /393) Vectors [2 / 102) Scalars [1 / 286) Histograms (5 / 5] 

runID filter • module filter • ra channel col ision (%) T [%} 

Module Name Value 

Hub,H2_hub.eth[ü].mac rx channel collision (%] 69.04S50284Ů983 

Inputs Browse Data Datasets 

Obrázek 6: Zobrazení procentuálního počtu kolizí pro scénář Hub_collisions_3 

Otázky: 
1. Na j aké vrstvě modelu ISO/OSI pracuj e hub, switch a router? 

2. Jaké informace obsahuje směrovací tabulka switche? 

3. Jaké informace obsahuje směrovací tabulka routeru? 
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